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License Agreement

GASWorkS, its options, and supplements are licensed for installation on only one computer per authorized
copy. That is, only one copy of the program is intended to be installed per license. Each purchased copy of
the program represents one license. We are relying on your honesty and integrity to ensure that multiply
copies of the program are not created.

In reference to this paragraph, the following definitions shall apply: Software shall mean the GASWorkS
program, documentation, and any associated options, enhancements, or supplements; User shall mean the
individual or organization purchasing the Software, the individual or organization employing the persons to
be using the Software, the individual or organization otherwise responsible for the administration of the use
of the Software, or any affiliate thereof; Developer shall mean B3PE LLC. By use of the Software, the User
consents to accept full responsibility for the use of the Software including: Determination of fitness for
purpose; Interpretations or decisions based on any results derived from the Software; Any claims resulting
from the use, accidental misuse, or intentional misuse of the Software by the User; And for reimbursement
of the original purchase price to the Developer for each unauthorized copy of the Software generated from
the User’s authorized copy.

By installing the Software, the User consents to the means of copy protection.

It is the User’s obligation to immediately return the Software, without installing it, if
they do not agree, concur and consent to these Licensing requirements.

Trademark Notice

GASWorkS, GASCalc, GASBase, and the “B-Cubed” logo are trademarks of B3PE LLC. dBase is a
trademark of ASHTON TATE a division of Borland International. AutoCAD is a trademark of Autodesk,
Inc. Windows (and it variations and derivations) are trademarks of Microsoft Corporation. MicroStation is
a trademark of Bentley System Inc.

Copyright Warning

The GASWorksS software and User’s Manual are protected under United States and international copyright
laws and treaties. Making unauthorized copies of either the software or the associated documentation is a
violation of United States and international law. Don’t be a criminal, don’t copy.
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Guarantee

If you are not fully satisfied with the performance of GASWorkS, uninstall the software, return the original
distribution materials, security device (if provided), and documentation within thirty (30) days of the date
of receipt. We will promptly refund the original purchase price.

If during the useful lifetime of the software, GASWorkS or its options do not perform as claimed, notify us
of the deficiency and we will promptly address your concern.

About The User’s Manual

This User’s Manual attempts to provide the User with an understanding of the GASWorkS software by
providing extensive descriptions and documentation of its various features. The main body of the User’s
Manual presents descriptions of the various menu items and data screens. Separate sections are provided for
several of the more extensive features. The Appendix section presents a primer on network analysis, along
with technical documentation of the various equations and data files used and supported by GASWorksS.

In addition to the information contained in this manual, examples, how-to tips and instructions are included
in the GASWorkS Help Guide.

A copy of the User’s Manual in Portable Document Format (pdf) is contained in the GASWorksS installation
file. With some versions of GASWorkS, the Demonstration Guide, User’s Manual, and Help Guide are
installed and viewable using the Help menu. Additional information and documentation may be found on
our website www.b3pe.com.
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Introduction

Use the procedures outlined in this section to install GASWorkS and begin using it to model your gas system.
If you are a new User, we suggest working the example model contained in the Demonstration Guide. The
Guide will provide instructions and examples of using the basic features of the GASWorksS software. If you
are a current User, you might want to browse the Release Notes topic in this section to review the new
features contained in this version of the software.

A list of the available commands in the Graphic Data Interface (GDI) is provided in that section of this
manual. The Menu Items section provides some abbreviated instructions on accessing and using many of the
routines found in the software.

GASWorkS is suitable for modeling a variety of distribution, gathering, transmission, and plant piping
systems containing most any compressible, single phase fluid. Many of the examples used in its
documentation refer to distribution type systems. However, please consider that the methods required to
create and solve these examples, are exactly the same as those required to create and solve a model of any
type of system.

If you encounter problems, or have specific questions, refer to the appropriate section of this manual for
detailed instructions, descriptions, and explanations. Or, use the Help Guide to view examples and how-to
tips on performing a specific task.

Feel free to contact us with your questions. Additional support, documents, new and updated Property
Tables, program updates, and frequently asked questions and answers can also be found on our website

www.b3pe.com.

System/Hardware Requirements

GASWorkS will operate on any device configured to run Windows™ 8 thru Windows™ 11.

GASWorkS will operate on any device configured to support and execute the supported operating systems.
Best performance will be achieved when using a device with elevated memory size and processor speed. The
use of a mouse or similar pointing device is recommended. The use of a touch pad or similar point devices
are discouraged.

The GASWorkS software will require a minimum of 37 MB of free hard disk space when installed.

An internet connection is required for the license management and the use of the GeoMap functions.
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Licensing System

GASWorkS uses an internet based licensing system. The software can be installed on any number of devices.
License information is stored on our server. When a User attempts to use the software, the license availability
is checked on the server. If the number of “in-use” licenses is less than the purchased number of licenses (the
User Limit) the User is allowed to continue, otherwise the use of the software is denied until the number of
“in-use” licenses is below the User Limit.

A license can be “checked out” for up to thirty (30) days. Once “checked out”, the license is not available

for use by any other Users until the license is checked back “in”. An internet connection is not required to
use the software during the check out period, for the device and User that checked out the license.

GASWorkS Data Elements

GASWorkS uses an intuitive set of data elements to represent the piping systems that it models. The basic
elements of its data structure include node, pipe, and customer data. Nodes represent the connections,
intersections, and terminations of pipes. Nodes are the points where flow is introduced into the system
(supplies) or taken out-of the system (demands). Nodes can also be used to represent customer connections
and to assign customer loads. Customer features provide an efficient and intuitive way of representing
customer locations and demands.

Pipes connect the nodes and carry flow | Ejow in To System

between them. Flow may be thought of Customer 1 Customer 2

as going in-to or out-of nodes.

However, flow only goes through o Pipe _ o To Node
pipes. GASWorkS supports various FromNode ~>> Flow Through Pipe >>

types of hydraulic features -
compressors, fittings, line pipe,
regulators, valves, and wells.

Flow Out Of System

Both hydraulic data and attribute pipe data may be maintained. The hydraulic pipe data represents the items
which affect the flow and pressure drop through the pipes. For example, pipe diameter, length, connectivity,
etc. The attribute data represents items which do not affect the flow or pressure drop through the pipes.

The customer data contains information about the location and demand of the customers associated with a
model. The customer data can be divided into two types of information - model data which describes the
customer’s location, the supply main identity, the node load application details, and the total customer load -
and a second type of information called attribute information, which can contain a variety of non-model data
associated with the customer.

2
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All of the model files are accessed by way of a single “key” file known as the “Header” file (.hdr). This file
contains some general information about the model and the solution control parameters and serves as the
access point for all of the other files.

A variety of other data is also used to support GASWorkS and its various routines. These include gas

properties, User Text and Graphics, and background images. Each is described in detail in the various
sections of this manual.

Notes On Dimensional Units

When the standard version of GASWorksS first starts, its default dimensional units are set to customary US
values (Feet, Inches, Psi, Fahrenheit).

To change the default dimensional units, select the Set Defaults item from the Utilities menu. The Default
Data Values screen is displayed. Select the Dimensional Units data tab to access the currently selected
dimensional units. Make changes by selecting the desired item from the associated lists. Click the Apply
Dimensional Units Only command button to change the values used in the current model. Note - Do not click
the Apply All Values command button unless you are certain that you want to apply all of the default setting
values, on the various data tabs, to the current model.

As used in GASWorkS, unless otherwise specified, all pressure units represent “gauge” units. Within the
documentation, gauge pressure units are generally shown without a suffix, absolute pressure units are shown

with an “a” or “ (Abs)” suffix. Gas volume values or volumetric flow rates are expressed in “standard” cubic
units, based on (adjusted to) the specified base pressure and temperature.

Notes For International Users

GASWorkS attempts to accommodate the needs of International Users by providing a robust set of
dimensional units. These units can be selected as appropriate for the User’s particular needs.

GASCalc does have a particular weakness when it comes to the various Property Tables that contain
predefined compressor, fitting, pipe, regulator, relief, valve, and well data. These lists are primarily oriented
towards US manufacturers and sizes. The Property Tables can be easily modified by the User to more
specifically meet the particular needs of each User. The Property Tables provided with the software are
intended to provide a starting point to allow the User to create their own custom Property Tables.
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Note... The example models provided with GASWorkS generally use US units of measure. To obtain

valid results, these examples must be worked using the US units. When working these examples,
if the default data values and dimensional units have been changed, they must be reset to their
original US values before working with the example model.

GASWorkS can accommodate either a comma (,) or a dot (.) as the decimal identifier, or a comma (,) or a
dot (.) as the digit grouping identifier depending on the associated Windows setting. For example, ten
thousand and one tenth may be displayed as “10,000.10” or as “10.000,10” depending on the Windows
setting.

Use the Regional and Language options found in the Windows Control Panel to change the digit grouping
and decimal identification settings.

Release Notes

GASWorkS 10 represents a continued evolution of the GASWorkS software - however, as with all
evolutionary processes, things change. Additional GDI Commands and functions were added, and inevitably
some features were discontinued. A partial summary of the many feature changes is provided in the following
tables.

New & Enhanced Features

Some of the new and enhanced features available in the current GASWorkS release are listed (in no
particular order) in the following...

A more efficient Graphic Data Interface.

Support for zoom and pan with the mouse wheel.

Click to edit or view data.

Use of “grips” to move features and data text.

Improved data viewing and editing.

Improved screen layout.

Improved access to the GDI Command List and Tool Palette.

Support for “User” Graphic Images - display icons, pictures, or pdf documents in the model.

Enhanced data text handling - easily move text and automatically include leader lines.

Display User defined tables in the model.
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Display pre-defined User Text in the model - include standard notes, etc.

Supports “associated” User Text - link a User Text feature to a node, pipe, or customer data value.

Add User Text and include a leader line with a single command.

Supports import and export of KML format files - share data with Google Earth or compatible
applications.

Performs coordinate projections to and from world coordinates based on standard “.prj” or “.wkt” files.

LIS

Includes support for “.jpg”, “.pdf”, “.tif”, and “.kml” format files as background images.

Support for 3D coordinates and Isometric display.

Convert a line entity in a vector based background image to a pipe in the model - makes updating a snap.

Supports multi-line User Text.

Support for node “attribute” data - especially useful for updating node loads.

Improved isolation valve handling.

Enhanced tracing - added additional options and color mixing for overlapping trace routes.

Improved multi-edit handling - easily update data or execute a command for a selection set.

Enhanced Facility Type handling - assign pipe flow equation or pressure units by Facility Type.

Enhanced default data handling - use specific default data, or use the data from the last data feature.

Quick Solve routine - single-click solution makes solving and viewing results more efficient

“Favorite” results - allows quick review of results for User specified features.

Speed enhancements for nearly all commands and routines.

Improved data list handling for User defined databases.

“Csv” export - create a selection set and create a spreadsheet compatible file with a couple of clicks.

Quick Solve from a report - solve from a report screen and view updated results without reopening the
report.

Enhanced System Summary Report - more reporting options.

Date and time stamp for model data features so you can tell when an item was last changed.

Edit log to track changes to the model.
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New & Enhanced Features

“Item” Summary Report to find and report item counts and quantities based on a User specified selection
set.

Cut and paste property data (pipe, fitting, etc) to/from the Windows clipboard.

Lock a Property Table to prevent unintentional data changes.

“A to Z” sorting of any item in a Property Table.

Cost and Part Number field included in all Property Tables.

Support for “power” type pipe flow equations - allows use of CUST piping.

Support for “Fixed Pressure Drop” fittings, and fittings with pressure loss based on a pressure drop
equation.

Enhanced regulator handling - calculates droop, handles low inlet pressure and backlog switching.

Enhanced compressor handling - handles high inlet pressure and backlog switching.

Enhanced data text settings - separate settings for each feature type.

Model comparison routine - list the differences between two models.

Copy User Text, User Graphics, and Saved Views from another model - share these items between models.

Connect loose pipe ends - select a group of unconnected pipes and automatically connect them.

Import customer service lines from “dxf” and “SHP” files.

Enhanced all import, merge, and export routines.

Copy and multi-edit User Text and User Graphics.

Copy a customer or pipe feature.

User Text, User Graphics, and pipe features may be associated as a group - think of it as like a CAD block.

Added group handling commands - copy, move, delete, create, dissolve.

Added a “hydraulic status” to the node data - allows nodes to be turned ‘on’ or ‘off” for tracing.

Added a “hydraulic type” to the node data - especially useful for tracing.

Use a “template” file when exporting “dxf” data.

Enhanced feature “snap” handling.

Supports display of a background grid and grid snap.
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“Quick Size” routine - set up a sizing specification and run it with a single-click.

Added a Snap Loose Pipe Ends command - automatically connect pipe ends within a specified tolerance.

Added a Straighten Polyline Pipe command - removes vertices within a specified region.

Improved “unbroken intersection” handling - mark within a specified area, exclude nodes from review.

Improved symbol display handling - specify an on/off limit.

Support for multiple “undo” handling.

Redo handling.

Enhanced shapefile (SHP) import handling.

Enhanced DXF export handling.

Improved overall User Interface.

Added routine to create a load summary table - especially useful for documenting mechanical style
designs.

Enhanced Bill-Of-Material creation.

Added routine to automatically create a legend of User Graphic Symbols.

Symbolize fitting style hydraulic elements.

Discontinued Features

Some features have been discontinued from the current GASWorkS release. Their exclusion was based
on their perceived usefulness with respect to the latest software functionality. These features include...

Relate Features - The various relate features have been discontinued. These features were initially
developed to help support modeling of large multi-pressure tier systems. Modern machines offer enough
power and memory to make these features un-necessary.

Digitizing Tablet Support - The various commands used to support data entry using a digitizing table have
been discontinued.

We hope that you will be pleased with the many improvements and enhancements we have made to
GASWorkS 10. Please let us know if you have any comments, concerns, or questions regarding our latest
release.
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Getting Help - Contact Us

Hours - Our normal business hours are 8:00 A.M. to 5:00 P.M. Mountain Time, Monday through Friday.
However if you have a problem, please try at any time, we may be in.

By Telephone - (719) 578-9391

By Email - help@b3pe.com

By Website - www.b3pe.com

E
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General Information

This section provides a general reference for using the GASWorkS menu bar and the associated menu items.
Grouped by functional topic, procedures are described for using each of the menu items available in the
GASWorkS menu bar. Most of the menu items will launch a data or specifications screen. Further
information describing the use and features of the screens is provided in later sections of this manual.

Certain menu items are not enabled unless a model is open.

File - File Management

The GASWorkS model file management routines are grouped in the File menu. The routines located in this
menu are used to manage the model files only. That is, these routines manipulate the files directly associated
with a model. The contents and use of each of the GASWorksS files are described in the Appendix section.

Access to the GASWorkS support files, such as the Property Tables, is handled by the individual routines
that access or manipulate those specific files. Management routines such as copying and deleting the support
files must be performed manually by the User.

A GASWorkS model consists of a number of files each possessing the same name but varying extensions.
Some of the files represent the header, pipe, node, and customer data associated with each model, while
others represent support or other data files. A full list of the specific file extensions is contained in the
Appendix section. GASWorkS manages the model files based on the name of the header file.

Only one model may be open at a time. The name of the currently open model is displayed at the top of the
main GASWorksS screen. Certain menu items and GDI Commands will prompt for a model name if a function
which affects a model file is executed, and a model has not already been opened. Once a model has been
opened, execution of subsequent model related routines will apply to the open model.

The routines found in the File menu are described in the following sections.

New - Create A New Model

The New routine creates a new set of model files. To create a new GASWorkS model...
® From the File menu, select the New item.

® The Model Selection screen is displayed. Either enter the desired name in the Model Name data
field, or select an existing name from the Models list. Click the Continue command button.

2
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® By default, the GDI Window should automatically open. If the GDI Window does not
automatically open, select the View/Edit item from the Graphics menu.

® Use the appropriate GDI Commands to enter the data associated with the new model. As new pipe
features and nodes are added, the values initially populating the new items are extracted from the
Default Data Values. The Default Data Values and dimensional units may be set by selecting the Set
Defaults item in the Utilities menu.

Notes & Considerations

® [f the name of an existing model is selected or entered, a message will be displayed. To overwrite the
existing model files, click the Yes command button. To return to the Model Selection screen without
overwriting the existing model files, click the No command button. If you choose to overwrite the model
files, the contents of the original files will be sent to the Windows Recycle Bin.

® [f the path name is omitted when entering a new name, the current drive and directory (folder) will be
assigned as the path. If the extension is omitted, the “.hdr” extension will automatically be applied.

® When executed, GASWorkS will create a new header file and a set of empty data and support files. The
contents of the header file will be similar to the last “saved” model.

® See the Model Selection Screen topic in the Data Screens section for a detailed description of its features.

New Project - Create A New Model Project

The New Project routine is similar to the New routine. It creates a new set of model files, but it also allows
various settings to be selected before creating the model. To create a new project...

® From the File menu, select the New Project item.

® The Project Specifications screen is displayed. Either enter the name for the new model or select
aname, then select the desired support file settings. Select attribute files or background image files
to attach as appropriate. Click the Continue command button to create the new model.

® By default, the GDI Window should automatically open. If the GDI Window does not
automatically open, select the View/Edit item from the Graphics menu.

® Use the appropriate GDI Commands to enter the data associated with the new model. As new pipe
features and nodes are added, the values initially populating the new items are extracted from the
Default Data Values. The Default Data Values and dimensional units may be set by selecting the Set
Defaults item in the Utilities menu.
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Notes & Considerations

® [f the name of an existing model is selected or entered, a message will be displayed. To overwrite the
existing model files, click the Yes command button. To return to the Model Selection screen without
overwriting the existing model files, click the No command button. If you choose to overwrite the model
files, the contents of the original files will be sent to the Windows Recycle Bin.

® When executed, GASWorkS will create a new header file and a set of empty data and support files.

® [f a template model is selected, the contents of the header file and the default values and settings will
reflect the values in the selected “template” model. To create a template model, create a new model, change
all settings it the desired template values, save the model to the GASWorkS “.. \support\settings” directory
(folder).

® Sce the Project Specifications Screen topic in the Data Screens section for a detailed description of its
features.

Open - Open An Existing Model

The Open routine opens an existing model for editing, reporting, or solving. To open an existing model...
® From the File menu, select the Open item.
® The Model Selection screen is displayed. Either enter the desired name in the Model Name data
field, or select an existing name from the Models list. If the file cannot be found, a message will be

displayed. When a valid model name has been entered, click the Continue command button.

® By default, the GDI Window should automatically open. If the GDI Window does not
automatically open, select the View/Edit item from the Graphics menu.

Notes & Considerations

® [fa model is already open, a message may be displayed asking whether to save the changes. Click the Yes
command button to save changes to the open model, close the model, and open the selected model. Or, click
the No command button to close the open model without saving changes, and open the selected model. Or,
click the Cancel command button to return to the currently open model.

® [fa model from a previous version of GASWorkS is selected, a message will be displayed asking whether
to import the file - respond appropriately. If the model is imported, a separate (converted) set of model files
will be created with the same name as the original file followed by a “ 10 suffix.
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® When a valid model name has been entered, GASWorkS will open and read the associated model files.
The various Edit, Report, and Solution routines may be used to manipulate the model.

® Sce the Model Selection Screen topic in the Data Screens section for a detailed description of its features.

Close - Close The Currently Open Model

The Close routine “closes” the currently open model. To close the currently open model...
® From the File menu, select the Close item.

Notes & Considerations

® [f changes have been made to the open model, a message will be displayed asking whether to save the
changes - respond appropriately.

® Each time GASWorkS is started it will automatically open the last open model file. This feature may be
disabled by closing the model before exiting GASWorksS.

Save - Save Model Changes

The Save routine saves the changes made to the currently open model. To save changes...
® From the File menu, select the Save item.

Notes & Considerations

® [f the Automatically Save At Timed Increments preference settings option is selected, the model will be
saved at specified increments.

® Each time the model is saved, a backup copy of the previous model files is saved. If an existing set of
backup files already exist, they are moved to the Windows Recycle Bin.

2
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Save As - Save Model To Another Name

The Save As routine saves the changes of the current model to another (different) model name and changes
the name of the currently open model to the specified name. To save the current model changes to another
name...

® From the File menu, select the Save As item.

® The Model Selection screen is displayed. Either enter the desired name in the Mode! Name data
field, or select an existing name from the Models list. Click the Continue command button.

® The currently open model will now be displayed with the new model name.

Notes & Considerations

® [f the name of an existing model is selected or entered, a message will be displayed. To overwrite the
existing model files, click the Yes command button. To return to the Model Selection screen without
overwriting the existing model files, click the No command button. If you choose to overwrite the model
files, the contents of the original files will be sent to the Windows Recycle Bin.

® When a valid model name has been selected or entered, GASWorkS will copy the contents of the currently
open model into the model files associated with the new name.

® The Save As routine saves (copies) the contents of the data stored in memory, not the data stored in the
file on disk. To copy the data stored on the disk to another destination use the Copy routine.

® Sce the Model Selection Screen topic in the Data Screens section for a detailed description of its features.

Rename - Change The Name Of The Currently Open Model

The Rename routine changes the name of the currently open model to another User specified name. The
name of the various files associated with the model will be changed to the specified name. Unsaved changes
to the current model will not be saved. To change the name of the current model...

® From the File menu, select the Rename item.

® The Model Selection screen is displayed. Either enter the desired name in the Mode! Name data
field, or select an existing name from the Files list. Click the Continue command button.

® A message will be displayed when the Rename routine is complete. Click the OK command button
to clear the message.
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® [f the name of an existing model is selected or entered, a message will be displayed. To overwrite the
existing model files, click the Yes command button. To return to the Model Selection screen without
overwriting the existing model files, click the No command button. If you choose to overwrite the model
files, the contents of the original files will be sent to the Windows Recycle Bin.

® When a valid model name has been entered or selected, GASWorkS will change the name of the current
model files to the User specified name.

® The Rename routine changes the name of the data files stored on the disk to a new User specified name,
it does not save the data stored in memory. To save the data stored in memory to another destination use the
Save As routine. The Rename routine does not make a copy of the disk files, it only changes the name of the
files. Use the Copy routine to make a copy of the disk files.

® See the Model Selection Screen topic in the Data Screens section for a detailed description of its features.

Copy - Copy The Model Files

GASWorkS provides a routine for copying the files associated with a model. The Copy routine will
automatically copy the various model files to a User specified destination and model name. To copy the files
associated with the currently open model...

® From the File menu, select the Copy item.

® The Model Selection screen is displayed. Either enter the desired name in the Model Name data
field, or select an existing name from the Files list. Click the Continue command button.

® A message will be displayed when the copy has been completed. Either click the Yes command
button to open the new file, or click the No command button to clear the message.

Notes & Considerations

® [f the name of an existing model is selected or entered, a message will be displayed. To overwrite the
existing model files, click the Yes command button. To return to the Model Selection screen without
overwriting the existing model files, click the No command button. If you choose to overwrite the model
files, the contents of the original files will be sent to the Windows Recycle Bin.

® When a valid model name has been entered or selected, GASWorkS will copy the contents of the current
model’s files into the destination (target) model files.
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® The Copy routine copies the contents of the data stored in the disk file, not the data stored in memory. To
save the data stored in memory to another destination use the Save As routine.

® Sce the Model Selection Screen topic in the Data Screens section for a detailed description of its features.

Delete - Delete The Model Files

The Delete routine deletes all of the files associated with a User selected model, including the backup files.
To delete an existing model’s files...

® From the File menu, select the Delete item.

If A Model Is Currently Open -

® A message will be displayed asking whether to delete the currently open model. Either
click the Yes command button to delete the currently open model, click the No command
button to return to the Model Selection screen, or click the Cancel command button to return
to the currently open model.

® [f the Yes command button is clicked, a message will be displayed asking to confirm the
deletion of the selected model. Either click the Yes command button to delete the selected
model, or click the No command button to cancel the routine. A message may be displayed
when the deletion is complete. Click the OK command button to clear the message.

® [f the No command button is clicked, the Model Selection screen will be re-displayed.
Either enter or select another name, or click the Cancel command button to close the screen.

If No Model Is Currently Open -

® The Model Selection screen is displayed. Either enter the desired name in the Model
Name data field, or select an existing name from the Models list. A message will be
displayed if the file is not found. When a valid model name has been entered, click the
Continue command button.

® A message will be displayed asking to confirm the deletion of the selected model. Either
click the Yes command button to delete the selected model, or click the No command button
to cancel the routine. A message will be displayed when the deletion is complete. Click the
OK command button to clear the message.

® The Model Selection screen is displayed again. Either enter or select another name to
delete, or click the Cancel command button to end the routine.
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Notes & Considerations

® When a valid model name has been selected, GASWorkS will “delete” the contents of each file associated
with the selected model. The files are not actually deleted but sent to the Windows Recycle Bin. The files
may be manually restored using Windows File Explorer.

® See the Model Selection Screen topic in the Data Screens section for a detailed description of its features.

Append - Append The Model Files

The Append routine provides a means for appending (joining) two models together. All model files are
appended except that the header file of the model being appended to, is retained as the header file for the new
combined model. The model to be appended to must be open before attempting to execute the Append
routine. To append another model to the currently open model...

® From the File menu, select the Append item.

® The Model Selection screen is displayed. Either enter the desired name in the Model Name data
field, or select an existing name from the Models list. A message will be displayed if a valid file is
not found. When a valid model name has been entered, click the Continue command button.

® A message will be displayed asking to confirm the appending of the two models. Either click the
Yes command button to append the selected models, or click the No command button to cancel the
routine.

® Additional messages may be displayed - respond appropriately.

® A message will be displayed when the Append routine is complete. Click the OK command button
to clear the message. Note - If the routine failed or the result was not as expected, close the model

without saving the changes.

Notes & Considerations

® Before appending two models, consider renaming or numbering nodes with names that are redundant
between the models, otherwise redundant names found during the Append routine, will automatically be
renamed during a sequential number.

® When coincident node locations are encountered, the node in the current model is retained and the
associated pipes in the appending model are snapped to the existing node.

® Sce the Model Selection Screen topic in the Data Screens section for a detailed description of its features.
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Bundle - Bundle & Unbundle Model Files

GASWorkS provides a set of routines for bundling (zipping) and unbundling (unzipping) a model’s file set.
These routines are described in the following sections.

Bundle A Model - Zip A Model

The Bundle routine bundles all of a model’s files into a single “zip” format file. This is useful for archiving,
backing up, or sharing models with others. The model must be open before it may be bundled. To bundle the
files associated with the currently open model...

® From the Bundle submenu of the File menu, select the Bundle A Model item.

® The Bundle Specifications screen is displayed. Select the desired options, then click the Continue
command button.

® [f changes to the model have not been saved, a message will be displayed asking whether to save
the model changes before bundling - respond appropriately.

® A message will be displayed stating how many model files were bundled. Click the OK command
button to clear the message.

Notes & Considerations

® The file created by the Bundle routine will be named the same as the model, except that it will have a
“.zip” extension. The bundled (zipped) file’s format is PKZip 2.04g compatible. The file may be unbundled
using the GASWorkS Unbundle routine, or it may be unzipped (extracted) using any compatible file
compression program.

® Some firewall and security systems will not allow a zip file containing files with a double extension. The
backup files created by GASWorkS contain double extensions. Select the Exclude Backup Files bundle
option to exclude these files from the bundled file.

® Sce the Bundle Specifications Screen topic in the Data Screens section for a detailed description of its
features.
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Unbundle A Model - Unzip A Model

The Unbundle routine unbundles a set of files contained in a single “zip” format file. The zip file may be
created either by the GASWorkS Bundle routine or by another zip or compression application. To unbundle
a zip file of a model...

® From the Bundle submenu of the File menu, select the Unbundle A Model item.

® The File Selection screen is displayed. Either enter the desired name in the Filename data field,
or select an existing name from the Files list. If the name is manually entered, include the “.zip”
extension. A message will be displayed if a valid file is not found. When a valid model name has
been entered, click the Continue command button.

® [f one or more of the model files already exist, a message will be displayed asking whether to
overwrite the existing model files. Either click the Yes command button to overwrite the file and
continue, click the No command button to not overwrite the files and continue, or click the Cancel
command button to cancel the routine.

® When complete, a message will be displayed stating how many model files were unbundled. If
unbundled files represent a valid GASWorkS model file set, a message will be displayed asking
whether to open the selected model. Either click the Yes command button to open the unbundled
model, or click the No command button to clear the message.

Notes & Considerations

® Sce the File Selection Screen topic in the Data Screens section for a detailed description of its features.

Purge - Remove Unrequired Model Files

The Purge routine will automatically remove any unrequired model files, such as zero length files and backup
files. This process is referred to as “purging” and is useful for cleaning up a model before archiving, backing
up, or sharing it with others. The model must be open before it may be purged. To purge the currently open
model...

® From the File menu, select the Purge item.
® A message will be displayed asking to confirm whether to proceed with the Purge routine. Either
click the Yes command button to purge (delete) the unneeded files from the selected model, or click

the No command button to cancel the routine.

® [f the Yes command button is clicked, a message may be displayed stating how many files were
deleted. Click the OK command button to clear the message.
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Preferences

GASWorkS allows the User to specify certain User interface behaviors. The available settings are described
in the following sections.

Paths - Set The Default File Locations

The Paths item allows the User to specify the default location of the various model files, initialization files,
Property Tables, and support files. These locations specify where to save and retrieve the various files from.
The default location is the directory (folder) that GASWorkS uses first when dealing with the various file
operations. In most cases, the User may specify other locations when saving or retrieving a file. To specify
the preferred locations...

® From the Preferences submenu of the File menu, select the Paths item.

® The Path Settings screen is displayed. Double-click in the associated data field to display the Path
Selection screen and change the path location. Click the Close command button to save changes.

Notes & Considerations

® Sce the Path Settings Screen topic in the Data Screens section for a detailed description of its features.

Property Tables - Set The Default Property Tables

The Property Tables item allows the User to specify which Property Tables (contained in the current
Property Table path) to use with the current model. To specify the desired Property Tables...

® From the Preferences submenu of the File menu, select the Property Tables item.
® The Property Table Selection screen is displayed. To change the Property Table path, click the
Change Path Setting command button. Select the desired location, then select the desired Property

Table names. Click the Close command button to save changes.

Notes & Considerations

® Sce the Property Table Selection Screen topic in the Data Screens section for a detailed description of its
features.
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Settings - Set User Interface Options

The Settings item allows the User to specify several settings which affect various behaviors of the
GASWorkS User interface. For example, one of these settings causes the GDI Window to automatically open
when GASWorkS is first started. To change the preference settings...

® From the Preferences submenu of the File menu, select the Settings item.

® The Preference Settings screen is displayed. Select the desired options. Click the Close command
button to save changes.

Notes & Considerations

® Sce the Preference Settings Screen topic in the Data Screens section for a detailed description of its
features.

Save Current Settings

The Save Current Settings item allows the current paths and preference settings to be saved for future use.
To save the current settings...

® From the Preferences submenu of the File menu, select the Save Current Settings item.

® The File Selection screen is displayed. Either enter the desired name in the Filename data field,
or select an existing name from the Files list. Click the Continue command button.

® A message may be displayed once the settings have been saved. Click the OK command button
to clear the message.

Notes & Considerations

® Sce the File Selection Screen topic in the Data Screens section for a detailed description of its features.

Open Saved Settings

The Open Saved Settings item allows a previously saved preferences file (.pfs) to be opened and applied. To
open a saved preferences file...

® From the Preferences submenu of the File menu, select the Open Saved Settings item.
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® The File Selection screen is displayed. Either enter the desired name in the Filename data field,
or select an existing name from the Files list. Click the Continue command button.

® A message will be displayed once the settings have been opened and set. Click the OK command
button to clear the message.

Notes & Considerations

® Sce the File Selection Screen topic in the Data Screens section for a detailed description of its features.

Restore A Model - Restore Model Files

The Restore A Model item provides a routine for restoring the backup copies of a model’s data files.
GASWorkS automatically creates a backup copy of the various model files each time the Save routine is
used. To restore the backup version of the currently open model...

® From the File menu, select the Restore A Model item.

® A message will be displayed once the restoration is complete. Click the OK command button to
clear the message.

Notes & Considerations

® GASWorkS exchanges the contents of the original model files and the backup model files. If a model is
erroneously restored, immediately reexecute the Restore routine to return the original data. Unless instructed
by the User, the current changes will not be saved before the Restore routine is executed.

Restore Samples - Restore The Sample Files

When GASWorkS is initially installed, several sample (example) files and models are copied to the
destination disk. As the various examples are worked, these files will change. To restore the original
(unchanged) example model files...

® From the File menu, select the Restore Samples item.

® A message will be displayed when the sample models have been restored. Click the OK command
button to clear the message.
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Quick Export

GASWorkS provides a set of routines for saving the contents of the currently open model to a set of data files
to various other formats. These routines are contained in the Quick Export submenu of the File menu. The
Quick Export routines provide a simplified duplication of the functionality of the Export routines.

® To export the model data to a selected file format, select the desired format item from the Quick
Export submenu of the File menu.

Notes & Considerations

® More information on the files that are created using the Quick Export routine may be found in the Export
Routines section.

Exit GASWorkS - Closing GASWorkS

When the Continue command button is clicked on the GASWorkS StartUp screen to enter the software, a
license of the GASWorkS software will be “checked out”.

When exiting the GASWorkS software, there are two options - an option to “return” the checked out license
or to keep the license “checked out”.

® To return the “checked out” license, from the Exit GASWorkS menu, click the And Return License
item. In order to return the “checked out™ license, the device must be connected to the internet so that
the User Count can be updated.

® To keep the license “checked out,” from the Exit GASWorkS menu, click the Without Returning
License item. The User Count will not be updated, and the license will remain “checked out” until
the license is “returned”. This option allows for the software to be used without having access to an
internet connection for up to 30 days. Select the And Return License item from the Exit GASWorkS
menu to return a “checked out” license.

Notes & Considerations

® [f a model is open when GASWorkS is closed, that model will automatically be reopened the next time
GASWorksS is started.
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Edit - Enter & Edit Data

The majority of the model data editing features are handled in the GDI Window or in the various Data
Reports. A few special Edit routines are handled outside of those functions. These routines are accessed
through the Edit menu. The routines found in the Edif menu are described in the following sections.

Model Notes - View/Edit The Model Notes

To access the Model Notes associated with an existing model...
® From the Edit menu, select the Model Notes item.

® The Model Notes will be displayed. Edit the Model Notes using standard text editing techniques.
Click the Close command button to close the screen and save changes.

Notes & Considerations

® The Model Notes can also be viewed from the Header Data Report and on the Model Notes data tab on the
Solution Data screen.

® Sce the Model Notes Screen topic in the Data Screens section for a detailed description of its features.

Mass Update - Update The Model Data

The Mass Update routine allows changes en masse to be made to the customer, node, pipe, and associated
attribute data based on User specified criteria. For example, the Mass Update routine could be used to set
the Pipe Efficiency value to 0.92 for all of the pipe features where the Pipe Flow Equation is set to Spitzglass-
Low Pressure. To make a mass data change...

® From the Edit menu, select the Mass Update item.

® The Mass Update Specifications screen is displayed. Either enter or select the desired values as
appropriate. Click the Update command button to perform the update.

Notes & Considerations

® [fthe Allow Undo Of Data/Graphic Changes preference settings option is selected, the original data values
may be restored if an erroneous update is performed. To restore the original data values, immediately click
the Restore command button on the Mass Update Specifications screen.
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® Sece the Mass Update Specifications Screen topic in the Data Screens section for a detailed description of
its features.

Property Tables - View/Edit The Property Table Report

GASWorkS uses several Property Tables to maintain common information associated with the various
hydraulic feature types. An extensive set of “standard” Property Tables are supplied with GASWorkS. The
contents of the standard Property Tables are described in the Appendix section. To view or edit the standard
Property Tables...

® From the Edit menu, select the Property Tables item.
® The Property Table Report is displayed. Select the desired data tab (Property Table). View or edit
the desired data values by clicking in the associated data cells. Click the appropriate icon to add,

delete, or insert a record into the Property Table. Click the Close command button.

® [f changes have been made, a message will be displayed asking whether to save the changes -
respond appropriately.

Notes & Considerations

® Sce the Property Table Editor topic in the Property Tables section for a detailed description of its features.

Facility Settings - View/Edit The Facility Settings

The Facility Settings item provides access to the Facility Settings screen. To view or edit the Facility
Settings...

® From the Edit menu, select the Facility Settings item.

® The Facility Settings screen is displayed. Browse or edit the displayed settings as appropriate.
Click the Apply command button to close the screen and apply changes.

Notes & Considerations

® The Save As Default command button may be used to save the current settings as the default settings to
be used when creating a new model.

® See the Facility Settings Screen topic in the Data Screens section for a detailed description of its features.
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Data List Definition - View/Edit The Data List Definition

The Data List Definition item provides access to the Data List Definition screen. To view or edit a Data
List...

® From the Edit menu, select the Data List Definition item.

® The File Selection screen is displayed. Either enter the desired name in the Filename data field,
or select an existing name from the Files list. If a valid file name has not been found, a message will
be displayed asking to create the file - respond appropriately. When a valid file name has been

entered, click the Continue command button.

® The Data List Definition screen is displayed. Make required changes, then click the Save icon to
save the changes. When finished, click the Close command button to close the screen.

Notes & Considerations

® Sce the File Selection Screen topic in the Data Screens section for a detailed description of its features.

® Sce the Data List Definition Screen topic in the Data Screens section for a detailed description of its
features.

Quick Size Specification - View/Edit A Quick Pipe Sizing Specification

The Quick Size Specification item provides access to the Quick Pipe Sizing Specification screen. To view
or edit a Quick Pipe Sizing Specification...

® From the Edit menu, select the Quick Size Specification item.

® The File Selection screen is displayed. Either enter the desired name in the Filename data field,
or select an existing name from the Files list. If a valid file name has not been found, a message will
be displayed asking to create the file - respond appropriately. When a valid file name has been

entered, click the Continue command button.

® The Quick Pipe Sizing Specification screen is displayed. Make required changes, then click the
Save icon to save the changes. When finished, click the Close command button to close the screen.

Notes & Considerations

® Sce the File Selection Screen topic in the Data Screens section for a detailed description of its features.
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® Sce the Quick Pipe Sizing Specification Screen topic in the Data Screens section for a detailed description
of its features.
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Analysis - Calculating Values

The GASWorkS Calculation routines are grouped in the Analysis menu. The routines located in this menu
are used to solve a model, or calculate gas properties based on a gas composition. The routines found in the
Analysis menu are described in the following sections.

Solve Single Model

Solving a model involves calculating the unknown Pressure and Flow Rate values. To solve a GASWorkS
model...

® From the Analysis menu, select the Solve Single Model item.

® The Solution Data screen is displayed. Enter or change the desired data values and options. Click
the Solve command button to proceed with the solution.

® During the Solution routine, the Solution Log will be displayed. When the Solution routine is
complete, browse the contents of the log. Click the Close command button to close the log.

Notes & Considerations

® During the solution, a log of the solution activity is written to a file known as a “Solution Log” file. The
contents of the log file may be viewed or printed by selecting the Solution Log item in the Report menu.

® Sce the Solution Data Screen topic in the Data Screens section for a detailed description of its features.

Calculate Gas Properties

GASWorkS provides a routine for calculating the gas properties (Specific Gravity, Viscosity, Heating Value,
and Specific Heat Ratio) from a gas composition. To use the routine...

® From the Analysis menu, select the Calculate Gas Properties item.
® The Gas Properties Calculator screen is displayed. Click the Clear command button to set all of

the data items to blank (null) values. Enter or select the appropriate values, then click the Calculate
command button to calculate the gas properties values.
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Notes & Considerations

® Some of the solution options require that a gas properties file be created and saved with the same name
as the model. The Gas Properties routine may be used to create the required file.

® The Gas Properties Calculator screen can also be accessed from the Default Data Values screen.

® Sce the Gas Properties Calculator Screen topic in the Data Screens section for a detailed description of
its features.

GASCalc

If the GASCalc software is installed on the User’s machine, in its normal location, it may be accessed using
the GASCalc item from the Analysis menu. If GASCalc is not installed, or is installed in a non-standard
location, the item will be disabled. To open the GASCalc software from within the GASWorkS software...

® From the Analysis menu, select the GASCalc item.
® If executing the latest version of the GASCalc software, the GASCalc Welcome screen is
displayed. Click the Continue command button to enter the software. The GASCalc main interface

screen is displayed. When finished, exit the GASCalc software.

® [f executing GASCalc 5.0 version of the software, the program will be started and its main
interface screen is displayed. When finished, exit or minimize the GASCalc software.
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Report - View & Print Data

The GASWorkS Report routines are grouped in the Report menu. The routines located in this menu are used
to view and print the data contained in the model and support files. The routines found in the Report menu
are described in the following sections.

Pipe Data - View & Edit Pipe Data

To view the Pipe Data Report, select the Pipe Data item from the Report menu. The Pipe Data Report will
be displayed. Browse the contents of the report. When finished, click the Close command button.

Notes & Considerations

® Sce the Pipe Data Report topic in the Data Screens section for a detailed description of its features.

Node Data - View & Edit Node Data

To view the Node Data Report, select the Node Data item from the Report menu. The Node Data Report will
be displayed. Browse the contents of the report. When finished, click the Close command button.

Notes & Considerations

® Sce the Node Data Report topic in the Data Screens section for a detailed description of its features.

Customer Data - View & Edit Customer Data

To view the Customer Data Report, select the Customer Data item from the Report menu. The Customer
Data Report will be displayed. Browse the contents of the report. When finished, click the Close command
button.

Notes & Considerations

® See the Customer Data Report topic in the Data Screens section for a detailed description of its features.
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Header Data - View & Edit Header Data

To view the Header Data Report, select the Header Data item from the Report menu. The Header Data
Report will be displayed. Browse the contents of the report. When finished, click the Close command button.

Notes & Considerations

® Sce the Header Data Report topic in the Data Screens section for a detailed description of its features.

System Summary - Create A System Summary Report

The System Summary routine provides a choice of certain predefined data and result summaries. To create
a System Summary Report...

® From the Report menu, select the System Summary item.

® The System Summary Options screen is displayed. Select the desired options to include in the
System Summary Report, then click the Continue command button.

® The System Summary Report will be displayed. Browse the report using the scroll bars. When
finished, click the Close command button.

Notes & Considerations

® See the System Summary Options Screen topic in the Data Screens section for a detailed description of its
features.

® Sce the System Summary Report topic in the Data Screens section for a detailed description of its features.

Data Check - View The Data Check Report

The Data Check item allows the results of a previously performed Data Check to be viewed. To view the
results of a Data Check...

® From the Report menu, select the Data Check item.

® The Data Check Report will be displayed. Browse the report using the scroll bars. When finished,
click the Close command button.
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Notes & Considerations

® [f the GDI is open, double-click on an error to flag and zoom to the feature associated with the error.

® Sce the Data Check Specifications Screen topic in the Data Screens section for a detailed description of
its features.

® Sce the Data Check Report topic in the Data Screens section for a detailed description of its features.

Solution Log - View The Solution Log Report

During execution of the solution, a log file is created which contains the activity of the Solution routine. This
item is only enabled once the Solution routine has been executed. To view the contents of the Solution Log
Report...

® From the Report menu, select the Solution Log item.

® The Solution Log Report will be displayed. Browse the report using the scroll bars. When
finished, click the Close command button.

Notes & Considerations

® [f the Include Exceptions In Solution Log option is selected, any discovered exceptions will be included
in the Solution Log. If the GDI is open, clicking on a listed exception to flag and zoom to the associated
feature.

® Sece the Solution Log Report topic in the Data Screens section for a detailed description of its features.

Report Options - Set The Report Format Options

GASWorkS allows the User to specify various report format options, including the number of decimal places
that are used when displaying the data and analysis results. These settings are referred to as the Report
Options. To set the Report Options...

® From the Report menu, select the Report Options item.

® The Report Options screen is displayed. Enter or select the desired settings. Click the Close
command button to save changes and close the screen.
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Notes & Considerations

® Sce the Report Options Screen topic in the Data Screens section for a detailed description of its features.
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Graphics - The Graphic Data Interface (GDI) Settings

The Graphic Data Interface (GDI) allows graphical entry and editing of the various data associated with a
model. The GDI provides a map style (schematic) display of the model and allows point-and-click access to
the associated model data. The features associated with the GDI are fully described in the Graphic Data
Interface (GDI) section.

Various GDI functions are located in the Graphics menu. The routines found in the Graphics menu are
described in the following sections.

View/Edit - Display The GDI Window & Edit Model Data

GASWorkS provides graphical access to the model data and schematic through the GDI Window. If the
model data was entered graphically, or the nodes have otherwise been assigned coordinates, a schematic of
the model will be displayed in the GDI Window. To display the GDI Window...

® From the Graphics menu, select the View/Edit item.
® The GDI Window will be displayed. Use the Scroll icon to pan the view of the model schematic,
or click one of the various “Zoom” icons to enlarge or reduce the view of the schematic. Execute one

of the GDI Commands to edit and view the model data. To close the GDI Window, click the “X”
icon in the upper-right corner of the GDI Window.

Settings - View/Edit The Settings For The GDI Window

Several of the settings that control the behavior of the GDI Window are set using the Graphic Settings screen.
To access the Graphic Settings screen...

® From the Graphics menu, select the Settings item.

® The Graphic Settings screen is displayed. Enter or select the desired settings and options. Click
the Close command button to save changes and close the screen.

Notes & Considerations

® See the Graphic Settings Screen topic in the Data Screens section for a detailed description of its features.
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Background Settings - Attach/Edit A Background Image

Various image formats may be used as a background to a model’s schematic. The assignment and control
of the background images are performed using the Background Image Settings routine. To attach, remove,
or modify the display of a background image...

® From the Graphics menu, select the Background Settings item. The Background Image Settings
screen is displayed.

To Attach A Background Image -
® Click the Attach New Image command button. For the Attachment File Type, select the
desired file type, then click the Continue command button. The File Selection screen is
displayed. Either enter the desired name in the Filename data field, or select an existing
Filename from the Files list. Click the Continue command button.

To Remove A Background Image -

® Select (highlight) the Filename of the background image to be removed from the Attached
Background Image Files list, then click the Remove Selected Image command button.

® Click the Apply command button to immediately apply the current settings to the GDI Display.

Notes & Considerations

® Sce the Background Image Settings Screen topic in the Data Screens section for a detailed description of
its features.

® Sce the Attachment File Type Screen topic in the Data Screens section for a detailed description of its
features.

Save GDI Image As BMP - Save The Displayed Image

The currently displayed GDI Image may be saved to a bitmap (BMP) file for use with other applications. To
save the GDI Image to a BMP file...

® From the Graphics menu, select the Save GDI Image As BMP item.

® The File Selection screen is displayed. Either enter the desired name in the Filename data field,
or select an existing Filename from the Files list. Click the Continue command button.
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® A message will be displayed once the GDI Image has been saved. Click the OK command button
to clear the message.

Notes & Considerations

® Sce the File Selection Screen topic in the Data Screens section for a detailed description of its features.

Copy GDI Image To Clipboard - Copy The Current GDI Image

The current GDI Image may be copied to the Windows Clipboard. This allows the GDI Image to be “pasted”
into another graphic application. To copy the GDI Image to the clipboard...

® From the Graphics menu, select the Copy GDI Image To Clipboard item.

® A message will be displayed indicating the result of the Copy routine. Click the OK command
button to clear the message.

Notes & Considerations

® Use the Windows “paste” command to insert the GDI Image into another application.

® The application into which you are intending to paste the image, must support display of graphic images.
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Utilities - Use The Utility Routines

GASWorkS provides routines for performing various model support functions. These features are referred
to as the Utility routines. They include routines for setting default data values and performing various Import,
Merge, and Export routines. The Utility routines are grouped in the Utilities menu. These routines are
described in the following sections.

Set Defaults - Specify The Default Data Values

The initial data and unit values used to populate the various data fields are referred to as the “default data”.
The Set Defaults routine allows the User to set the values for certain data items which are automatically
populated when a new feature is created in the model. To specify the default data values...

® From the Utilities menu, select the Set Defaults item.
® The Default Data Values screen is displayed. Select the desired data tab, and enter or select the
appropriate default data or options. Click the Close command button to close the screen and save

changes.

Notes & Considerations

® The Set Defaults routine is most commonly used to set default data values and dimensional units before
entering data. The default data values will be used when a new feature is added. However, the routine can
also be used to change the data values for existing features by clicking the appropriate “Apply...Only”
command button. Be careful using the various “Apply”” command buttons when features already exist in the
model - all of the associated values will be changed to the specified default data values.

® Ifthe Use Last Record For Default Values preference settings option is selected, the “hydraulic” default
date values will only used when the first pipe or node feature is entered.

® Sce the Default Data Values Screen topic in the Data Screens section for a detailed description of its
features.
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Customer Data

The Customer Data submenu contains several Customer Data Management routines. These routines include
the ability to attach an attribute (non-model) database file, update external loads, and to manipulate an
attached attribute file (database) using Standard Query Language (SQL) commands. These routines are
grouped in the Customer Data submenu and are described in the following section.

Attribute File - Attach A Customer Attribute File

GASWorkS maintains various model related customer data as part of its model files. It allows non-model
data (referred to as attribute data) to be contained in a separate database (attribute file) to be attached or
connected to the model. The required connection information is specified using the Customer Attribute File
Settings screen. To attach (or unattach) a customer attribute file...

® From the Customer Data submenu of the Utilities menu, select the Attribute File item.

® The Customer Attribute File Settings screen is displayed. Enter or select the appropriate data.
Click the Close command button to save changes and close the screen.

Notes & Considerations

® Sce the Attribute File Settings Screen topic in the Attribute Data section for a detailed description of its
features.

Update External Loads - Assign & Update The External Node Loads

Customer loads are assigned to node loads through the external node load parameter. Sometimes, especially
after new data has been imported or changed using the SQL Statement routine, these assignments need to
be updated. The Update External Loads routine provides two functions, first if an attribute file is attached,
the routine will update the Total Load value for each of the customers, and second it will reassign the Total
Load value for each of the customers to the appropriate node’s external load value. To update the load
assignments...

® From the Customer Data submenu of the Utilities menu, select the Update External Loads item.

® A message may be displayed when the update is complete. Click the OK command button to clear
the message.
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Execute SQL Statement - Update Attribute Values

If an appropriate format customer attribute file is attached, values in the attribute file may be changed using
an SQL Statement. SQL is an acronym for Standard Query Language which is a special “query” language
for manipulating and modifying data in a SQL compatible database. This feature is useful for changing
customer load values contained in the attribute file, based on a special relationship or calculation method.
To update values in a customer attribute file...

® From the Customer Data submenu of the Utilities menu, select the Execute SQL Statement item.

® The SQL Update Specifications screen is displayed. Enter the desired SQL Statement or select a
previously Saved SQL Statement, then click the Execute command button.

® A message will be displayed when the statement processing is complete. Click the OK command
button to clear the message.

Notes & Considerations

® Sce the SOL Update Specifications Screen topic in the Attribute Data section for a detailed description of
its features.

Node Data

The Node Data submenu contains several Node Data Management routines. These routines include the
ability to attach an attribute (non-model) database file, and to manipulate an attached attribute file (database)
using Standard Query Language (SQL) commands. These routines are grouped in the Node Data submenu
and are described in the following section.

Attribute File - Attach A Node Attribute File

GASWorkS maintains various model related node data as part of its model files. It allows non-model data
(referred to as attribute data), to be contained in a separate database (attribute file) to be attached or
connected to the model. The required connection information is specified using the Node Attribute File
Settings screen. To attach (or unattach) a node attribute file...

® From the Node Data submenu of the Utilities menu, select the Attribute File item.

® The Node Attribute File Settings screen is displayed. Enter or select the appropriate data. Click
the Close command button to save changes and close the screen.
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Notes & Considerations

® Sce the Attribute File Settings Screen topic in the Attribute Data section for a detailed description of its
features.

Execute SQL Statement - Update Attribute Values

If an appropriate format node attribute file is attached, values in the attribute file may be changed using an
SQL Statement. SQL is an acronym for Standard Query Language which is a special query language for
manipulating and modifying data in a SQL compatible database. This feature is useful for changing node load
values contained in the attribute file, based on a special relationship or calculation method. To update values
in a node attribute file...

® From the Node Data submenu of the Utilities menu, select the Execute SQL Statement item.

® The SQL Update Specifications screen is displayed. Enter the desired SQL Statement or select a
previously Saved SQL Statement, then click the Execute command button.

® A message will be displayed when the statement processing is complete. Click the OK command
button to clear the message.

Notes & Considerations

® See the SOQL Update Specifications Screen topic in the Attribute Data section for a detailed description of
its features.
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Pipe Data

The Pipe Data submenu contains several Pipe Data Management routines. These routines include the ability
to attach an attribute (non-model) database file, and to manipulate an attached attribute file (database) using
Standard Query Language commands. These routines are grouped in the Pipe Data submenu and are
described in the following section.

Attribute File - Attach A Pipe Attribute File

GASWorkS maintains various model related pipe data as part of its model files. It allows non-model data
(referred to as attribute data), to be contained in a separate database (attribute file) to be attached or
connected to the model. The required connection information is specified using the Pipe Attribute File
Settings routine. To attach (or unattach) a pipe attribute file...

® From the Pipe Data submenu of the Utilities menu, select the Attribute File item.

® The Pipe Attribute File Settings screen is displayed. Enter or select the appropriate data. Click the
Close command button to save changes and close the screen.

Notes & Considerations

® Sce the Attribute File Settings Screen topic in the Attribute Data section for a detailed description of its
features.

Execute SQL Statement - Update Attribute Values

If an appropriate format pipe attribute file is attached, values in the attribute file may be changed using an
SQL statement. SQL is an acronym for Standard Query Language which is a special query language for
manipulating and modifying data in an SQL compatible database. To update values in a pipe attribute file...

® From the Pipe Data submenu of the Utilities menu, select the Execute SOL Statement item.

® The SQL Update Specifications screen is displayed. Enter the desired SQL Statement or select a
previously Saved SQL Statement, then click the Execute command button.

® A message will be displayed when the statement processing is complete. Click the OK command
button to clear the message.
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Notes & Considerations

® Sce the SOL Update Specifications Screen topic in the Attribute Data section for a detailed description of
its features.

Import - Import Data

GASWorkS provides support for creating a new model from data saved in a variety of file formats. These
routines are controlled through the Import screen. To import a file...

® From the Utilities menu, select the Import item.

® The Model Selection screen is displayed. Enter the desired name in the Model Name data field,
then click the Continue command button.

® The Import screen is displayed. Select the desired file format from the File Type list, then click
the Import command button.

® The File Selection screen is displayed. Select the desired file to import, then click the Continue
command button.

® Depending on the specified File Type, additional data screens may be displayed to further define
the Import Specifications - respond appropriately.

® The Import Log on the Import screen will display the status of the Import routine. When finished,
click the Close command button to exit the screen.

Notes & Considerations

® When a valid model name has been entered, a new model will be created to input the data into.

® [f the name of an existing model is selected or entered, a message will be displayed. To overwrite the
existing model files, click the Yes command button. To return to the Model Selection screen without
overwriting the existing model files, click the No command button. If you choose to overwrite the model
files, the contents of the original files will be sent to the Windows Recycle Bin.

® Sce the Model Selection Screen topic in the Data Screens section for a detailed description of its features.

® Sece the Import topic in the Import & Merge Routines section for a detailed description of its features.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.
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Export - Export Data

GASWorkS provides various Export routines for sharing its data with other applications through a variety
of file formats. These routines are controlled through the Export screen. To export data from the currently
open model...

® From the Utilities menu, select the Export item.

® The Export screen is displayed. Select the desired file format from the File Type list, then click
the Export command button.

® The File Selection screen is displayed. Enter the desired name in the Filename data field, then
click the Continue command button.

® Depending on the specified File Type, additional data screens may be displayed to further define
the Export Specifications - respond appropriately.

® The Export Log on the Export screen will display the status of the Export routine. When finished,
click the Close command button to exit the screen.

Notes & Considerations

® The model from which the data is to be exported from, must be open before selecting the routine.

® [fthe name of an existing file is selected or entered, a message will be displayed. To overwrite the existing
file, click the Yes command button. To return to the File Selection screen without overwriting the existing
file, click the No command button. If you choose to overwrite the file, the contents of the original file will
be deleted.

® Sce the Export Screen topic in the Export Routines section for a detailed description of its features.

® Sce the File Selection Screen topic in the Data Screens section for a detailed description of its features.

Merge - Merge Data

GASWorkS provides a routine for adding data to or updating data in an existing model from data saved in
a variety of file formats. These routines are controlled through the Merge screen. To merge data into the
currently open model...

® From the Utilities menu, select the Merge item.
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® The Merge screen is displayed. Select the desired file format from the File Type list, then click
the Merge command button.

® The File Selection screen is displayed. Select the desired file to merge, then click the Continue
command button.

® A message will be displayed asking whether to merge the file with the currently open model -
respond appropriately.

® [f the Yes command button is clicked, depending on the specified File Type, additional data
screens may be displayed to further define the Merge Specifications - respond appropriately.

® The Merge Log on the Merge screen will display the status of the Merge routine. When finished,
click the Close command button to exit the screen.

Notes & Considerations

® The model into which the data is to be merged into (added to), must be open before selecting the routine.

® See the Merge Screen topic in the Import & Merge Routines section for a detailed description of its
features.

® Sce the File Selection Screen topic in the Data Screens section for a detailed description of its features.

Purge - Remove Features

GASWorkS provides a routine for removing features from an existing model based on a feature list saved
in a variety file formats. These routines are controlled through the Purge screen. To purge data from the
currently open model...

® From the Utilities menu, select the Purge item.

® The Purge screen is displayed. Select the desired file format from the File Type list, then click the
Purge command button.

® The File Selection screen is displayed. Select the file that contains the purge (delete) list, then
click the Continue command button.

® A message will be displayed asking whether to continue with the Purge routine - respond
appropriately.
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® [f the Yes command button is clicked, depending on the specified File Type, additional data
screens may be displayed to further define the Purge Specifications - respond appropriately.

® The Purge Log on the Purge screen will display the status of the Purge routine. When finished,
click the Close command button to exit the screen.

Notes & Considerations

® The model into which the data is to be merged into (added to), must be open before selecting the routine.

® Sece the Purge Screen topic in the Import & Merge Routines section for a detailed description of its
features.

® Sce the File Selection Screen topic in the Data Screens section for a detailed description of its features.

Data Check - Check The Model Data

GASWorkS provides an extensive Data Check routine. The routine checks for out-of-bounds conditions as
well as general data entry and connectivity errors. The Data Check routine is controlled through the Data
Check Specifications screen. To perform a check of the model’s data...

® From the Utilities menu, select the Data Check item.

® The Data Check Specifications screen is displayed. Enter or select the desired settings, then click
the Check command button to proceed with the Data Check.

® When the Data Check is complete, a message will be displayed indicating whether errors were
encountered. If errors were found, click the Yes command button to view the Data Check Report, or

click the No command button to close the screen without viewing the Data Check Report.

Notes & Considerations

® Once created and closed, the Data Check Report may be viewed at other times by selecting the Data Check
item from the Report menu.

® Sece the Data Check Specifications Screen topic in the Data Screens section for a detailed description of
its features.
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Miscellaneous

Several routines are provided to perform miscellaneous utility functions. These routines are contained in the
Miscellaneous submenu of the Utilities menu. These routines are described in the following sections.

Sort Model

GASWorkS provides a variety of sorting options for reordering the pipes and nodes in the model data files.
The sort feature is controlled through the Sort Specification screen. To sort the currently open model’s data
records...

® From the Miscellaneous submenu of the Utilities menu, select the Sort Model item.

® The Sort Specification screen is displayed. Select the desired sort method from the Method list,
then click the Sort command button.

® A message will be displayed when the sort is complete. Click the OK command button to clear the
message.

Notes & Considerations

® See the Sort Specification Screen topic in the Data Screens section for a detailed description of its features.
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Window - Window (Screen) Access Utilities

Several utilities are provided for arranging and accessing open windows (screens). These routines are
grouped in the Window menu. These routines are described in the following sections.

Window List - Access Open Screens

A list of open screens is displayed in the Window menu. When several screens are open and overlapping, it
is sometimes difficult to access a specific screen. A screen may be easily and quickly accessed by selecting
its name from the Window List. When a screen name is selected, it is moved on top (or in front) of the other
screens.

2
,3 B3PE LLC Engineering & Software Services
50 Revision - 004, Copyright 2021, All Rights Reserved.




GASWorkS~ 10.1 Menu Items

Table Of Contents

Help - View The Help Resources

Access to various information and documents are provided in the Help menu. These routines are described
in the following sections.

An internet connection is required to display and view the various GASWorkS help and support documents.

Once a document is opened, it can be saved locally if you wish. If the document is saved locally, we suggest
storing the documents in the “\app\docs” subfolder of the root (main) GASWorkS 10 program folder.

View Help Guide - Examples

GASWorkS provides a Help Guide which has various examples and how-to tips. The Help Guide is designed
to compliment the documentation contained in this manual - not replace it. To view the Help Guide, while
connected to the internet, click the View Help Guide item from the Help menu.

Technical Support - How To Contact Us

Several support options are contained in the Technical Support submenu. These items are described in the
following sections.

Contact Information

To view our contact information, select the Contact Information item from the Technical Support submenu
of the Help menu. Our Contact Information will be displayed. Click the OK command button to close the
screen.

Send Help Request

To send a help request to us, select the Send Help Request item from the Technical Support submenu of the
Help menu. If a model is currently open, a message will be displayed asking whether to bundle the current
model - respond appropriately. An email will be generated and displayed. Describe the nature of your
problem or issue in the email. After completing the problem description and attaching the bundled model,
“send” the email. We will reply to the help request at our earliest convenience.

The help request will automatically attach a file containing the About GASWorkS information to the email.
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Go To Website

To directly view our website, select the Go To Website item from the Technical Support submenu of the Help
menu. An internet connection is required for the link to work.

View Getting Started Guide

GASWorkS provides a Getting Started Guide to help with the installation and execution of the GASWorkS
software. To view the Getting Started Guide, while connected to the internet, click the View Getting Started
Guide item from the Help menu.

View Demonstration Guide

The information contained in the Demonstration Guide is intended to provide an overview of the GASWorkS
software by demonstrating a portion of its extensive feature set. The example is for a simple distribution style
piping system, however please remember that the tasks used to create, solve, and edit this model are
applicable to any type of gas piping system. Although the GASWorkS feature set is not fully demonstrated,
we hope that the features that are used during the exercises will provide a good appreciation for how
GASWorkS may be able to satisfy your network modeling needs.

To view the Demonstration Guide, while connected to the internet, click the View Demonstrated Guide item
from the Help menu.

View User’s Manual

The User’s Manual attempts to provide the User with an understanding of the GASWorkS software by
providing extensive descriptions and documentation of its various features. The main body of the User’s
Manual presents descriptions of the various menu items and data screens. Separate sections are provided for
several of the more extensive features. The Appendix section presents a primer on network analysis, along
with technical documentation of the various equations and data files used and supported by GASWorkS.

To view the User’s Manual, while connected to the internet, click the View User’s Manual item from the
Help menu.
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Third Party Terms & Conditions

The GeoMapping functions are supported by services provided by “third parties”. Generally these parties
require that the User agree to certain terms and conditions. Select the Third Party Terms & Conditions item
to display the terms and conditions associated with any third party services being used in the current
GASWorkS session.

About GASWorkS - Software Information

Select the About GASWorksS item to display the version and setup information about the current GASWorkS
software installation. The GASWorkS Information screen is displayed. Once reviewed, click the OK
command button to close the screen.
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The previous section described the function of the GASWorkS menu items. In that section, numerous data
and specifications screens were introduced. This section provides a detailed description of many of those
screens. Separate sections are also provided for the more extensive routines and functional groups. The
descriptions are listed in alphabetical order based on the screen name.

Attachment File Type Screen

The Attachment File Type screen is accessed by clicking the Attach New Image command button from the
Background Image Settings screen. The features associated with the screen are described as follows.

Attachment File Type...

Select A File Type._.

Cancel Continue. _.

Data Items

Select A File Type - Specifies the image file type.

Command Buttons

Cancel - Closes the screen without saving changes.

Continue - Save the selected image file type and displays the File Selection screen.

Notes & Considerations

® The following image types may be attached as background images to a model:

.bmp - Windows bitmap style raster or image file

.dxf - Drawing Exchange File vector style CAD file

.jpg - Joint Photographic Experts Group (JPEG) style raster or image file
.kml - Keyhole Markup Language style GIS file

.pdf - Portable Document Format style document or image file

.shp - Shapefile style GIS file
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tif - Tagged Image File Format (TIFF) style raster or image file
® PDF files are handled the same as raster style files when displayed in the GDI.
]
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Background Image Settings Screen

The settings that control the display of the attached background images are accessed through the Background
Image Settings screen. The screen is accessed by either selecting the Background Settings item from the
Graphics menu, or selecting the Background Settings item from the Data Panel. The features associated with
the screen are described as follows and varies depending on the type of image file attached.

Background Image Settings...
Attached Background Image Files...

MIC:-\Program Files [xBBIAGASWorkS 10VFilesh\demobase dxf

Attach Hew Image | Select All Images ‘ Unselect All Images Bemove Selected Image |

Settingz For C:\Program Files [xB61\GASWork5 10vFiles\demobasze_dxf__.

Scale Factor: |1 [Drawing Unit-T o-Coordinate Ratio) [~ Project To Model Coordinates
Origin Shift [Model Coordinate Units]: ¥: |0 ¥: |0 Select In The Model
v/ 0 GWHNODETX GWPIPETX

GWCUST GWPATT GWSERY
GWCUSTTX GWPIPE_25 GWUSRTXT
GWHATT GWPIPE_35 m|RIYER
GWNODE GWPIPE_45 v ROW

Line Weight: |1 Convert Colors To Gray: [V Turn All Layers On/OFf ‘

[~ Use The Model Path Location For The Background Image File Location

Change Path For Selected File ‘

Cancel Apply Cloze ‘

Data Items

Attached Background Image Files - Displays the names of the currently attached background image files.
Select (highlight) a Filename to make changes to its display properties. The display of a background image
file may be controlled by either selecting or unselecting the box adjacent to the Filename in the list.
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Command Buttons

Note - Not all command buttons are available for all file types.
Apply - Closes the screen and applies changes.

Attach New Image - Displays the Attachment File Type screen to select a new background image file type
to attach to the model.

Calculate Scale Factor - Allows the Scale Factor to be calculated for a raster style image. When clicked,
the Scale Factor Calculation screen is displayed.

Cancel - Closes the screen without saving changes.

Change Path For Selected File - Displays the File Selection screen to change the path for the currently
selected (highlighted) background image file. This item is useful when the either the model or background
image file or both have been moved.

Close - Closes the screen and saves changes without applying the settings.

Remove Selected Image - Removes the currently selected (highlighted) background image file from the
model.

Select All Images - Selects (highlights) all of the Attached Background Image Files.
Select In The Model - Graphically sets the image insertion or origin point.
Turn All Layers On/Off - Allows the display of layers in a DXF style image to be turned on or off.

Unselect All Images - Unselects all of the Attached Background Image Files.
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BMP, JPG, & TIF Files
Settings For C:\Program Filez [xB6]\GASWorkS 104Filez\zample bmp...
Scale Factor: (10 [Coordinate-T o-Fixel Ratio) Calculate Scale Factor |
Insertion Point [Upper-Left Coordinates): X- |0 ¥: |0 Select In The Model |

Owerlap Style: |Cnmhine Images ﬂ

| Use The Model Path Location For The Background Image File Location

Data Items

Insertion Point - Specifies the position of the upper-left (northwest) corner of the background image. The
X-value represents the horizontal coordinate value of the upper-left corner, and the Y-value represents the
vertical coordinate value of the upper-left corner. The values are expressed in the Coordinates units.

Overlap Style - Specifies the overlap style used when multiple images are attached. When Combine Images
is selected, the images will be fused (combined) together to make one image. When Replace Previous Image
is selected, the current image will lay on top (replace) overlapping portions of the previous image.

Scale Factor - Specifies the number of coordinate units in the model, represented by one pixel in the image.
This value sets the scale for the background image. The image size is multiplied by the Scale Factor when
the image is processed. The original image data is not changed - the changes are only made to the displayed
image. To calculate the value, click the Calculate Scale Factor command button. See the following Notes
& Considerations section for instructions on calculating this value.

Use The Model Path Location For The Background Image File Location - When selected, the
background image file is located in the same directory (folder) as the associated model. This item is useful
when models are frequently shared or moved, eliminating the need to reset the image file location each time
the model is moved.

Command Buttons

Calculate Scale Factor - Displays the Scale Factor Calculation screen.
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DXF Files
Settings For C:\Program Filez [xB6]\GASWorkS 104Filez\demobase.dxf. ..
Scale Factor: |1 [Drawing Unit-To-Coordinate Ratio) [ Project To Model Coordinates
Origin Shift (Model Coordinate Units): ®- |0 Y- |0 Select In The Model
v D GWMODETX GWPIPETX
GWCUST GWPATT GWSERY
GWCUSTTX GWPIPE_25 GWUSRTXT
GWHMHATT GWPIPE_35 M|RIYER
GWHNODE GWPIPE_45 v ROw
Line Weight: |1 Convert Colors To Gray: |v Tumn All Layers On/0Ff ‘
| Use The Model Path Location For The Background Image File Location

Data Items

Convert Colors To Gray - When selected, the background image will be displayed using a light gray color.

DXF Layer List - Displays the names of the layers found in the selected DXF background image file. All
layers will be listed regardless of their status in the original drawing file. To turn “on” a DXF layer, select
the associated layer name. To turn “off” a DXF layer, unselect the associated layer name.

Line Weight - Specifies the width of the lines used to display the background image. The value is expressed
in screen pixels.

Origin Shift - Specifies the amount to shift the background image origin. The X-value specifies the amount
to move the background image in the east-west (horizontal) direction, and the Y-value specifies the amount
to move the background image in the north-south (vertical) direction. The values are expressed in the
Coordinates units.

Project To Model Coordinates - When selected, the background image will be projected into the associated
plane coordinate system.

Scale Factor - Specifies the number of coordinate units in the model, represented by one coordinate unit in
the drawing. This value sets the scale for the background image. The drawing coordinates are multiplied by
the Scale Factor when the image is processed. The original image data is not changed - the changes are only
made to the displayed image. See the following Notes & Considerations section for instructions on
calculating this value.
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Use The Model Path Location For The Background Image File Location - When selected, the
background image file is located in the same directory (folder) as the associated model. This item is useful
when models are frequently shared or moved, eliminating the need to reset the image file location each time
the model is moved.

Command Buttons

Turn All Layers On/Off - Turns all of the layers “on” or “off” for the selected (highlighted) DXF
background image file. Once all of the layers are turned “on” or “off”, the settings for the individual layers
may be set as desired.
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Geographic Mapping Service

Settings For Geographic Mapping Service. ..
Map Service: |Enngle Map j
Image Resolution: |Beller j
Map Type: |Cnmhinatinn Road Map & Satellite Image ﬂ
Data Items

Image Resolution - Specifies the resolution of the background image. The options will vary depending on
the selected Map Service.

Map Service - Specifies the internet based service which provides the background image.

Map Type - Specifies the type of map to be used for the background image. The options will vary depending
on the selected Map Service.
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KML & SHP Files
Settings For C:\Program Filez [xB6]\GASWorkS 104Filezshdistribution demo_ftg.kml. ..
Scale Factor [Drawing Unit-To-Coordinate Ratio): |1
Origin Shift (Model Coordinate Units): % |0 ¥: |0 Select In The Model
Line Weight: |1 j [~ Project To Model Coordinates
Line Style: |Solid |
Point Symbol Size [Default Length Units): |1|] j
Point Symbol Style: |Eircle - Hollow j
Convert Colors To Gray: [ Dizplay Color:
| Use The Model Path Location For The Background Image File Location

Data Items

Allow Attribute File Access - For shapefiles (SHP) files, when selected, the data contained in the attribute
portion of the shapefile may be displayed in the GDI Image.

Convert Colors To Gray - When selected, the background image will be displayed using a light gray color
and not the original colors.

Display Color - Specifies the color used to display the graphic features associated with the image when the
Convert Colors To Gray option is not selected.

Line Style - Specifies the style to be used to display the lines in the background image. Only used for line
(arc) style shapefiles.

Line Weight - Specifies the width of the lines used to display the background image. The value is expressed
in screen pixels. Only used for line (arc) style shapefiles.

Origin Shift - Specifies the amount to shift the background image origin. The X-value specifies the amount
to move the background image in the east-west (horizontal) direction, and the Y-value specifies the amount
to move the background image in the north-south (vertical) direction. The values are expressed in the
Coordinates units.

Point Symbol Size - Specifies the size used to display the symbols in the background image. The value is
expressed in the Coordinates units. Only used for point style shapefiles.

Point Symbol Style - Specifies the style of the symbol used to display the point locations in the background
image. Only used for point style shapefiles.
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Project To Model Coordinates - When selected, the background image will be projected into the associated
plane coordinate system.

Scale Factor - Specifies the number of coordinate units in the model, represented by one coordinate unit in
the image file. This value sets the scale for the background image. The image coordinates are multiplied by
the Scale Factor when the image is processed. The original image data is not changed - the changes are only
made to the displayed image. See the following Notes & Considerations section for instructions on
calculating this value.

Use The Model Path Location For The Background Image File Location - When selected, the
background image file is located in the same directory (folder) as the associated model. This item is useful
when models are frequently shared or moved, eliminating the need to reset the image file location each time
the model is moved.
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PDF Files
{* Scale Ratio -1: |1
i~ Scale Factor: [Coordinate-T o-Pixel R atio] |
Inzertion Point [Upper-Left Coordinates): X: |l] ¥: |l] Select In The Model |

Resolution: 150

Overlap Style: |Eumhine Images j

[ Usze The Model Path Location For The Background Image File Location

Data Items

Insertion Point - Specifies the position of the upper-left (northwest) corner of the background image. The
X-value represents the horizontal coordinate value of the upper-left corner, and the Y-value represents the
vertical coordinate value of the upper-left corner. The values are expressed in the Coordinates units.

Overlap Style - Specifies the overlap style used when multiple images are attached. When Combine Images
is selected, the images will be fused (combined) together to make one image. When Replace Previous Image
is selected, the current image will lay on top (replace) overlapping portions of the previous image.

Resolution - Specifies the resolution of the background image in dots per inch.

Scale Factor - Specifies the number of coordinate units in the model, represented by one pixel in the
converted PDF image. This value sets the scale for the background image. The image size is multiplied by
the Scale Factor when the image is processed. The original image data is not changed - the changes are only
made to the displayed image. To calculate the value, click the Calculate Scale Factor command button (if
displayed). See the following Notes & Considerations section for instructions on calculating this value.

Scale Ratio - Specifies the scale ratio used to increase (value greater than 1) or decrease (value less than 1)
the size of the image when it is displayed. A “1:1” Scale Ratio means that one dot (pixel) in the image is
equal to one pixel in the display. This is an alternative method of “scaling” the image.

Use The Model Path Location For The Background Image File Location - When selected, the
background image file is located in the same directory (folder) as the associated model. This item is useful
when models are frequently shared or moved, eliminating the need to reset the image file location each time
the model is moved.
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Command Buttons

Calculate Scale Factor - Displays the Scale Factor Calculation screen.

Notes & Considerations

® A bitmap (BMP) style image may be used as a background image to a model. The image file must adhere
to the standard Windows Bitmap (BMP) file specification. A BMP file can contain a scanned image or the
raster output of a graphic application which supports the BMP format.

® A drawing exchange format (DXF) style image may be used as a background image to a model. The image
file must adhere to the standard drawing exchange format (DXF) file specification. The file can contain the
output of a CAD, GIS, or vector based drawing application that supports the DXF format.

® A joint photographic experts group (JPG/JPEG) style image may be used as a background image to a
model. A JPG file is similar to a BMP file in content and application.

® A keyhole markup language (KML) style image may be used as a background image to a model. The image
file must adhere to the official KML schema. A KML file can contain graphic (not image) output from
Google Earth or another application that supports the KML file format. GASWorkS can only read in KML
point or line features.

® A portable document format (PDF) style image may be used as a background image to a model. PDF files
may be created by either saving an image or printing to the file with a PDF application. When using a PDF
file, it is first converted to a raster type file in memory, then it is displayed by the GDI. A PDF is not a raster
type file, however since it is displayed as a raster type file, the Scale Factor and other parameters associated
with raster type files are also associated with the PDF file type.

® A shapefile (SHP) style image may be used as a background image to a model. The image file must adhere
to the standard shapefile specifications. A SHP file can contain output from a GIS or other application that
supports the SHP file format. SHP files contain only one graphic type per file. For example, a SHP file can
contain only point type features or only line type features.

® A tagged image file format (TIF) style image may be used as a background image to a model. A TIF file
is similar to a BMP file in context and application.

® A file of another format can potentially be used as a background image by first converting the file to a
format supported by GASWorkS.

® Multiple files of varying types may be a attached to a model.
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® When using a raster style image (BMP, JPG, TIF, PDF), the Scale Factor (Coordinate-To-Pixel Ratio)
establishes the “scale” for the images. Raster images are made up of small “dots” called pixels. The scale
tells the GDI how many coordinates are represented by one pixel in the file. For example, the number of feet
per pixel. To determine this value, divide the original drawing or map scale by the image resolution in dots
per inch [dots per centimetre]. For example, the Coordinate-To-Pixel Ratio for a 1 Inch = 2000 Feet map
scanned at 400 dots per inch would be, 2000 + 400 = 5 Feet/pixel. The Scale Factor may be automatically
calculated by clicking the Calculate Scale Factor command button for BMP, JPG, and TIF background
image files.

® Before attaching a raster type file, ensure that the Coordinates units are set to match the Coordinate-To-
Pixel Ratio. For example, if the Coordinate-To-Pixel Ratio is calculated as Feet-per-pixel, the Coordinates
units should be set to Feet, or the Coordinate-To-Pixel Ratio should be recalculated to accommodate the
current Coordinates units.

® Before attaching a DXF file, ensure that the Coordinates units are set to match the coordinate values found
in the DXF file, or use an appropriate Scale Factor to accommodate the Coordinates units.

® For SHP, KML, and DXF background image files, the Line Weight and Line Style only apply to files
containing line type features - the Point Symbol Size and Point Symbol Style only apply to files containing
point type features.

® A shapefile (SHP) file that is in geographic coordinates (1ongitude/1atitude) may be projected into the
plane coordinates for display in the GDI. If the SHP file is already in plane coordinates, GASWorksS will first
project the SHP file back into longitude/latitude using the associated PRJ file. GASWorkS will then re-
project the SHP file using the PRI file associated with the model. GASWorkS will carry out this projection
even if the model is not in projected coordinates, as long as a projection file with the same name as the model
exists in the model directory (folder).

® KML files are always in geographic (latitude/longitude) coordinates. If the model is in a projected
coordinate system, GASWorkS can project the background KML file to model coordinates if a projection
file (.prj) is provided.

® When attaching multiple files the Scale Factor may need to be used to display all of the files in the model
Coordinate units.

® When the Project Coordinates option is selected, the background image coordinates are first projected into
world coordinates (longitude and latitude) based on the values in the associated projection file (.prj). The
image is then projected into the appropriate coordinates based on the values in the projection file (.prj)
associated with the model.

® Sce the Working With The GeoMap Functions topic in the Miscellaneous section, for more information
on the GeoMap functions. Examples for using the GeoMap commands are found in the GeoMap Examples
section of the GASWorkS Help Guide.
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Bundle Specifications Screen

A routine is provided that allows the various files associated with a model to be “bundled” (zipped) into a
single file. The Bundle routine is controlled by the Bundle Specifications screen. The screen is accessed by
selecting the Bundle A Model item from the Bundle submenu of the File menu. The features associated with
the screen are described as follows.

Bundle Specifications...

Bundled Fil

Include Assigned Attribute Field Lists
Include Assigned Property Tables
Include Attached Background Image Files
Include Model Files

Include User Graphic Image Files

Cancel LContinue._

Data Items

Note - The available data items change depending on the options used within the model.
Exclude Backup Files - When selected, the backup files will be excluded in the bundled file.

Include Assigned Attribute Field Lists - When selected, the assigned attribute field lists will be included
in the bundled file.

Include Assigned Property Tables - When selected, the currently assigned Property Tables will be included
in the bundled file.

Include Attached Attribute Files - When selected, the attached attribute files will be included in the
bundled file. This option will only be displayed if a customer, node, or pipe attribute file is attached.

Include Attached Background Image Files - When selected, the attached background image files will be
included in the bundled file.

Include Model Files - When selected, the model files will be included in the bundled file.

Include User Graphic Image Files - When selected, the User Graphic Image files will be included in the
bundled file.
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Command Buttons

Continue - Proceeds with the Bundle routine and creates the bundled file.

Cancel - Closes the screen without creating a bundled file.

Notes & Considerations

® The file created by the Bundle routine will be located in the same directory (folder) as the model, will have
the same name as the model, and will end in a “.zip” extension. The bundled file’s format is PKZip 2.04g
compatible. The file may be unbundled (unzipped) using the Unbundle A Model item from the Bundle
submenu of the File menu, or it may be unzipped using any compatible file compression program.
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Columns Screen

The User may select the data items (columns) that are displayed in many of the various Reports.
The Columns specification screen is used to make these selections. The Columns specification @
screen is accessed by selecting the Set Columns icon from the associated report screen. The
features associated with the screen are described as follows.

SET

Columns...

v| From Mode ~
v| To Hode

v| Internal 1D Humber

v Facility Type

v| Hpdraulic Type

v| Status

v Flow Equation

v Size/Type Code

v| Inside Diameter

v| Roughness W

Cancel Apply

Data Items

Columns - When selected, the associated data item (column) will be displayed in the associated report. The
contents of the Columns list will vary by report.

Command Buttons

Apply - Closes the screen and applies changes.

Cancel - Closes the screen without applying changes.

Notes & Considerations

® The Set Columns routine may be used to adjust the report width when printing. Normally, the report will
contain more information than will fit on a single page. Use the Columns specification screen to eliminate
some of the undesired columns from the report by unselecting the unwanted data items (columns).

® To display a specific column, select the column name. To display all of the columns, click the Restore
Columns icon.
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Customer Data Report

The Customer Data Report is accessed by selecting the Customer Data item from the Report menu. The
“report” displays both entered and calculated data values. Entered data values may be changed directly in
the report by the User. The features associated with the report are described as follows.

Model Data Tab

=] Customer Data Report... EI = @
=] - = a l i l = . | [w
slsiSlEEIE=EEEIENE = b |E: AT
Model Data | Attribute Data
Record |Internal ID | Supply Main Link ID Hode Load Unit . ; Adjust | Load =
Humber | Humber Humber HNumber Application Count Per Unit Load | Load Units Load |Status
il 1 2 Both Nodes 1 -600.000 | Ccffmo Yes On
i 2 2 Both Nodes 1 -600.000 Ceffmo Yes On
3 3 2 Both Nodes 1 -600.000 | Ccffmo Yes On
4= 4 2 Both Nodes 1 -600.000 Ccffmo Yes On
L5 L] 2 Both Nodes 1 -600.000  Ccffmo Yes On
b= 6 5 Both Nodes 1 -600.000 | Ccffmo Yes On ﬂ
<] | 3
LCloze ‘
Displayed Items

Internal ID Number - Displays the customer’s unique (to GASWorkS) internal identification number. This
value is automatically assigned and cannot be changed by the User.

Link ID Number - Displays the identification number used to link the customer records in the model to the
records in the attribute file or as an identifier for the customer. When no or a “linked” style database is
attached, the number may be automatically assigned and cannot be changed by the User. When a “non-
linked” style database is attached, the number is assigned by the User. The number should generally represent
a value that is unique in the attribute file (database). The value may be a combination of up to forty (40)
alphanumeric characters.

Pipe Facility Type - Displays the assigned Facility Type of the pipe (main) that the customer is attached to.
The customer inherits the same Facility Type as the assigned pipe (main).

=
,5 B3PE LLC Engineering & Software Services
Revision - 004, Copyright 2021, All Rights Reserved. 7




GASWorkS~ 10.1 Data Screens

Table Of Contents

Record Number - Refers to the position of the current record in the customer data file. An asterisk (“*”)
next to the Record Number denotes that changes have been made to the record since the last execution of the
Solve routine. This value is automatically assigned and cannot be changed by the User.

Supply Main Number - Displays the Link ID Number of the pipe (main) that supplies the customer (the pipe
that the customer is assigned to). The customer’s load will be assigned to the external load of the pipe’s From
Node or To Node as specified by the Node Load Application item. This value cannot be changed directly by
the User. Note - If the assigned pipe does not have an assigned Link ID Number, the Record Number of the
associated pipe will be displayed.

Data Items

Adjust Load - Indicates whether the customer’s Per Unit Load value is multiplied by the Design Factor
when the load is applied to the associated node(s). The Base Load value is not changed by this setting.

Load Status - Indicates whether the Per Unit Load value is (“on’) or is not (‘“off”) applied to the associated
nodes.

Load Units - Specifies the dimensional units for the Per Unit Load value.

Node Load Application - Specifies how to apply the customer’s per unit load.

Per Unit Load - Specifies the load value for each customer “unit”. If no attribute file (database) is attached,
the item may be manually entered by the User. Otherwise, the item may be automatically assigned depending
on how the database is configured. A negative value indicates a demand (flow leaving the system), and a

positive value indicates a supply (flow entering the system). The value is expressed in the Load Units.

Unit Count - Specifies the total number of units (meters or customers) that the selected individual customer
represents. The value must be in the range of 1 to 32,000.

X-Coordinate - Specifies the customer’s horizontal location (east-west coordinate).

Y-Coordinate - Specifies the customer’s vertical location (north-south coordinate).

Calculated Values

Branch ID - If the selected customer is a “trunk” customer, displays the Internal ID Number of the branch
customer assigned to it.

Branch Type - If the selected customer is part of a branch customer, displays which section the customer
is associated with either “branch” or “trunk”.
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Edit Date - Displays the date that the customer data was last changed.

Per Unit Adjusted Load - If the Adjust Load item is set to “Yes”, displays the Per Unit Load value times
the Design Factor. Otherwise, displays the Per Unit Load value.

Tap X-Coordinate - Displays the horizontal location (east-west coordinate) of the service tap on the main
(pipe) that the associated customer is assigned to. This value cannot be changed directly by the User.

Tap Y-Coordinate - Displays the vertical location (north-south coordinate) of the service tap on the main
(pipe) that the associated customer is assigned to. This value cannot be changed directly by the User.

Total Adjusted Load - If the Unit Count is greater than one (1), displays the Unit Count value times the Per
Unit Adjusted Load value.
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Attribute Data Tab

If a customer attribute file is attached to the model, the Attribute Data tab of the Customer Data Report
displays the data contained in the attribute file. If a database is attached, this data tab will display the values
associated with the data fields contained in the associated attribute file (database) and will vary by file. If
a “linked” style database is attached, the values may be changed by the User. If a “non-linked” style database
is attached, the values are view-only and cannot be changed by the User. The displayed items (columns) will
vary depending on the content of the attached file.

=l Customer Data Report... EI = @
=] = = A = ; L4
==lSEEESEEREERC S Csv
Model Data T
Record |Link ID Link To : =
Humber | Number Databaze St bl il
i 1 Yes
2= 2 Yes 125 Main 5t Brook's Cafe
3 3 Yes 127 Main 5t Leah's Bookstore
4= 4 Yesz 129 Main 5t Cheryl's Laundry
L L Yes 122-128 Main 5t
b= b Yes 130 Main 5t J
-
el . = ’
Cloze |
Displayed Items

Link ID Number - Specifies the identification number used to link the customer records in the model to the
records in an attached attribute file, or as an identifier for the customer when no attribute file is attached.
When a “linked” style attribute file is attached, the number is automatically assigned and cannot be changed
by the User. When a “non-linked” style attribute file is attached, the number may be assigned by the User.
In this case, the number should generally represent a value that is unique in the attribute file. When no
attribute file is attached, item may be used to maintain any User desired alphanumeric value. The value may
be a combination of up to forty (40) alphanumeric characters.

Record Number - Refers to the position of the current record in the customer data file. An asterisk (“*”)
next to the Record Number denotes that changes have been made to the record since the last execution of the
Solve routine. This value is automatically assigned and cannot be changed by the User.
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Data Items

Link To Database - Indicates whether the customer should be linked to the attribute file (database). If “Yes”
is selected, the customer will be linked to the database by matching the Link ID Number assigned in the
model to the associated value in the attribute file.

IR lg=igv oy g P il -

Assign Customer - Allows the currently selected (highlighted) customer to a location in the GDI
Display. When clicked, GDI prompts will appear to select the customer’s location and supply
main in the GDI Display. This icon only works if the GDI Window is open before the Customer
Data Report is opened.

Delete Current Selection - Deletes the current selection set of customer features.

Delete Customer - Deletes the currently selected (highlighted) customer record.

Edit Selection Set Values - Changes data values en masse for the current selection set of
customer features. When clicked, the Multiple Edit Specifications screen is displayed.

Find Customer - Finds and flags the currently selected (highlighted) customer record in the GDI
Display. The icon only works if the GDI Window is open before the Customer Data Report is
opened.

Find Record - Finds a customer record in the current selection set by Link ID Number. When

clicked, the Find Record specification screen displayed.

Go To Record - Displays the customer record associated with a specified Record Number at the
top of the current data tab. When clicked, the Go To Record specification screen is displayed.

Make Selection Set - Creates a selection set of customers which meet a User specified selection
criteria. When clicked, the Query Specifications screen is displayed.
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Maximize Screen Size - Increases the Customer Data Report’s size to fill the GASWorkS
display.

Print - Prints the contents of the currently displayed data tab. When clicked, the Print Settings
screen is displayed.

g

Quick Solve - Solves the model using the currently set solution options.

Reset Screen Size - Sets the Customer Data Report’s size to its “normal” dimensions and
position.

Reset Selection Set - Resets (clears) the current selection set. When clicked, all of the reportable
customer records will be displayed on the associated data tab.

Restore Columns - Restores the display of all of the data items (columns). When clicked, all of
the columns associated with the current data tab will be displayed.

f i@ @ [ b

Save To CSV File - Saves the data associated with the current data tab to a comma separated
values file (.csv). When clicked, the file will be created and a message will be displayed stating
the location of the saved file.

oo
]
=7

Set Columns - Used to specify which columns (data items) are displayed in the Customer Data
Report. When clicked, the Columns specification screen is displayed.

H

o
m
—

Sort Ascending - Sorts the records in ascending order (A to Z or lowest to highest value) based
on the Link ID Number.

Sort Descending - Sorts the records in descending order (Z to A or highest to lowest value) based
on the Link ID Number.

Undo - Restores the most recent data change.
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Command Buttons

Close - Closes the Customer Data Report.

Notes & Considerations

® Normally the report will contain more information than will fit on a single page. If this condition occurs
when trying to print, a message will be displayed. When the message is displayed, respond appropriately.
To print a report that is too wide for the printer, either eliminate some of the undesired columns using the
Set Columns routine or by manually collapsing the undesired columns, set the printer to use Landscape
Orientation, or reduce the printer font size.

® When a “.csv” file is created, it contains the data and calculated values for records in the current selection
set and only for the currently displayed columns. The file may be opened by any application which supports
the “.csv” file format.

® Only data items associated with customers attached to pipes that are assigned Facility Types that are
“Active” may be edited in the Customer Data Report. The Facility Settings may be viewed and changed using
the Facility Settings item from the Edit menu.

® [f an attribute file is attached, the contents of the file will be displayed on the Attribute Data tab of the
Customer Data Report. Depending on the type of file attached, the attribute data values may or may not be
allowed to be edited by the User.

® The Node Load Application options are described as follows:

Both Nodes - Indicates that one-half of the load will be applied to the External Load value of the
assigned pipe’s From Node and To Node.

Div... - Indicates that the load will be applied using the selected diversity load calculation method.

From Node - Indicates that the entire load will be applied to the External Load value of the assigned
pipe’s From Node.

None - Indicates that the load is not applied to either node.

To Node - Indicates that the entire load will be applied to the External Load value of the assigned
pipe’s To Node.
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® A cell with a “grey” background contains a fixed value. A cell with a “white” background contains a User
entered or selected value. A cell with a “yellow” background contains a calculated value. A cell with a
“cyan” background represents an unused or not applicable item. Only values in cells with a “white”
background may be changed by the User.
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Data Check Report

Errors encountered during the Data Check routine are written to a file known as the “Data Check” file (.dck)
or the Data Check Report. The file contains a log of the errors which were encountered during the Data
Check routine. The Data Check Report is accessed by selecting the Data Check item from the Report menu.
The features associated with the report are described as follows.

=] Data Check Report - C:\Program Files (x86)\GASWorkS 10\Files\demo419_ll.d... | = | =

(== ,@»
[ | TXT

Error Report For C:\Program Files [(xB6]\GASWorkS 100Fileshdemod19 |1,

Pipe Data...
Mo Ermrors Found

Mode Data___
Mo Errors Found

Connechivity. _.
Mo Errors Found

Large Flow Balance Errors....

Customer Data. ..

Customer: Record 1, Has Empty Link ID Humber

Customer: Record 2, Has Empty Link ID Humber

Customer: Record 3, Has Empty Link ID Humber j

Close

Displayed Items

Error Report - Displays the contents of the Data Check file. To browse the display, adjust the vertical scroll
bar adjacent to the display area.

Icons

Once copied, the contents may be pasted into another application.

r@‘ Copy To Clipboard - Copies the contents of the Data Check Report to the Windows Clipboard.
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Maximize Screen Size - Increases the Data Check Report ’s size to fill the GASWorksS display.

=] Print - Prints the contents of the Data Check Report. When clicked, the Print Settings screen is

[~ }| displayed.

1

Reset Screen Size - Sets the Data Check Report’s size to its “normal” dimensions and position.
Save To Text File - Saves the data of the Data Check Report contents to a text file (.txt). When

o p

THT clicked, the File Selection screen is displayed.

Command Buttons

Close - Closes the Data Check Report.

Notes & Considerations

® [f the GDI Window is open, double-click on an error to mark it as reviewed and to flag and zoom to the
associated feature in the GDI. Marked records become unmarked when the Data Check Report is closed.

® To perform a data check and create a report, select the Data Check item from the Utilities menu.
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Data Check Specifications Screen

The Data Check routine is controlled by the Data Check Specifications screen. The screen is accessed by
selecting the Data Check item from the Utilities menu. The features associated with the screen are described
as follows.

Pipe Tab

Data Check Specifications... x

Pipe T MHode T Cuztomer T Other

v Pipe Data Minimum M aximum
Diameter: |01 19999999
Length: lo.m 19999999
Efficiency: lo.m |9999999

¥ Pipe Property Table

[+ Connectivity

Cloze Clear Check

Data Items

Connectivity - When selected, the model connectivity errors will be included in the Data Check Report.
Diameter - Specifies the minimum and maximum pipe diameter check values.

Efficiency - Specifies the minimum and maximum pipe efficiency check values.

Length - Specifies the minimum and maximum pipe length check values.

Maximum - Specifies the maximum check values for the associated data items.

Minimum - Specifies the minimum check values for the associated data items.
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Pipe Data - When selected, the pipe data values will checked and errors found included in the Data Check
Report.

Pipe Property Table - When selected, a data check will be performed to ensure that each Size/Type Code
found in the pipe data exists in the current Pipe Property Table.
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Node Tab

Data Check Specifications... -
Pipe Hode T Customer T Other
[+ Mode Data Minimum Maximum
Pressure: |0.01 |9999999
Total Load: [} |9999999
Temperature: 0.1 |9999994
Elevation: 0 [15000
[+ Check For Large Flow Balance Emors

Close Clear Check

Data Items

Check For Large Flow Balance Errors - When selected, large flow balance errors will be included in the
Data Check Report.

Elevation - Specifies the minimum and maximum node elevation check values.
Maximum - Specifies the maximum check values for the associated data items.
Minimum - Specifies the minimum check values for the associated data items.

Node Data - When selected, the node data values will be checked and any found errors included in the Data
Check Report.

Pressure - Specifies the minimum and maximum node pressure check values.
Temperature - Specifies the minimum and maximum node (gas flowing) temperature check values.

Total Load - Specifies the minimum and maximum node total load check values. Use only absolute
(positive) values. This item refers to the sum of the base and external load values.
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Customer Tab

Data Check Specifications... -
Pipe T Hode T Customer Other
[+ Customer Data Minimum Maximum
Unit Count: 1 |30000
Per Unit Load: |0 |9999999

¥ Check For Redundant Link ID Numbers
[+ Check For Bedundant Customer Locations

Close Clear Check

Data Items

Check For Redundant Link ID Numbers - When selected, redundant Link ID Numbers will be included
in the Data Check Report.

Check For Redundant Customer Locations - When selected, redundant customer locations will be
included in the Data Check Report.

Customer Data - When selected, the customer data values will be checked and any errors found included
in the Data Check Report.

Maximum - Specifies the maximum check values for the associated data items.
Minimum - Specifies the minimum check values for the associated data items.

Per Unit Load - Specifies the minimum and maximum load check values for each customer “unit”. Use only
absolute (positive) values.

Unit Count - Specifies the minimum and maximum total number of units (customers or meters) that each
customer feature represents. The Unit Count values must be in the range of 1 to 32,000.
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Other Tab

Data Check Specifications... -

Pipe T Hode T Customer T iOther

Mizcellaneous Options. ..

Compare Customer Azzignment To Clozest Main

Compare Hydraulic And Graphical Pipe Length
Graphically Flag Items With Errors

Ignore Dead End Modes With Mo Load

Ignore Large Diameter To Length Ratio Pipes
Only Include Facility Types Set To Report

Close Clear Check

Displayed Items

Status Bar - During processing, displays the status of the Data Check routine.

Data Items

Compare Customer Assignment To Closest Main - When selected, the supply main assigned to the
customer will be checked to see if it is the pipe (main) closet to the customer location.

Compare Hydraulic And Graphical Pipe Length - When selected, the “hydraulic” (entered) length of the
pipe will be compared to its graphical length.

Graphically Flag Items With Errors - When selected, flags will be placed on the features that contain
errors in the GDI Display.

Ignore Dead End Nodes With No Load - When selected, the “Dead End Nodes With No Load” check will
be disabled during the Data Check routine.

Ignore Large Diameter To Length Ratio Pipes - When selected, the “Large Diameter To Length Ratio”
check will be disabled during the Data Check routine.
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Only Include Facility Types Set To Report - When selected, only the features associated with Facility
Types that are set for reporting will be included in the Data Check Report. To change whether a Facility Type
is set to “Report”, select the Facility Settings item from the Edit menu.

Command Buttons

Check - Executes the Data Check routine.
Clear - Sets all of the data items to blank (null) values.

Close - Closes the screen without executing the Data Check routine.

Notes & Considerations

® When the Pipe Property Table option is selected, the Data Check routine will search the current Pipe
Property Table for each Size/Type Code (diameter) found in the pipe data file. If the Size/Type Code is not
found, an error will be generated. If the Size/Type Code is found, the Data Check routine will check the
Inside Diameter value to see if it falls within the specified diameter minimum and maximum value limits.
If actual Inside Diameter values are entered for the Size/Type Code instead of Size/Type Codes, leave the
Pipe Property Table option unselected.

® The Data Check routine allows the model data to be screened for out-of-bounds, connectivity, and general
errors. The routine does not perform corrections of the data, it only identifies the errors it encounters and
creates a report of its findings. Some of the checks performed are described in the following table:

Connectivity - Reported Errors

Error Message Reported Condition

Pipes with bad node Record Numbers. Reports pipes where the assigned node record
number is beyond the number of nodes included in
the associated node data file. Generally occurs
when a model has become corrupt during the save
Or COpy process.

Node connected to more than four (4) pipes or Reports nodes where the number of pipes
more than (6) pipes. connected to it is unusually high. Nodes may be
connected to from one to up to six pipes. The model
will not be able to solve if a node is connected to
more than six pipes.
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Connectivity - Reported Errors

Error Message

Reported Condition

Node not connected to a pipe.

Reports a node that is not connected to any pipe.
Generally occurs when a model has become corrupt
during the save or copy process.

Node connected to itself.

Reports a node where the pipe From node and To
node are the same. Sometimes occurs during the
Import routine when a pipe length is shorter than
the specified Fuzzy Tolerance. Can also occur
where a pipe is represented by a circle or closed
“loop” for example on a cull-de-sac end.

Redundant pipes.

Reports two or more pipes which have redundant
From and Two nodes. Can occur when pipes are
parallel to each other with the same start and end
points. Can also occur when duplicate pipes have
been entered into the model. Often occurs as a
result of an Import or Merge routine.

Dead end node with zero (0) load value.

Reports a node which is only connected to one pipe
and the node has load value assigned to it.

Customer Data - Reported Errors

Error Message

Reported Condition

Missing attribute file (if assigned).

If a customer attribute file is assigned, and the file
is not found, an error is reported.

Corrupt supply main assignment.

Reports a customer where the record number of the
assigned supply main/pipe is larger than the number
of pipes contained in the pipe data file. Generally
occurs when a model has become corrupt during the
save Or copy process.

Invalid dimensional units.

Reports a customer where the assigned dimensional
units for one of the data items does not match the
supported dimensional units for that item.
Generally occurs when an invalid value is assigned
during the Import or Merge routine.
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Customer Data - Reported Errors

Error Message

Reported Condition

Positive per unit load value.

Reports a customer where the assigned load value
is a positive number. Generally customer load
values are assigned a negative number to indicate
that the associated value is a demand or gas leaving
the system. A positive value would indicate a
supply or gas coming into the system.

Out-of-bounds values - Values that either exceed
the specified maximum value or are less than the
specified minimum value.

Reports a customer where one of the assigned
values is outside the bounds or limits specified in
the check data.

Warning if the load status is set to “off”.

Reports a customer where the load status is set to
“off”. Not necessarily and error just a reminder.

Multiple customers at the same location.

Reports two or more customers located at the same
coordinate location. This may indicate redundant
customer features caused by an erroneous entry. Or
it may occur at locations with multiple meters,
which is acceptable.

Invalid Link ID Number.

When a customer attribute file is attached, reports
a customer where the value of the assigned Link ID
is not found in the customer attribute file.

Assigned main is not the closest to the customer
location.

Reports a customer where the assigned supply
main/pipe is not the geographically closest to the
customer. This could indicate an incorrect
assignment.

Node Data - Reported Errors

Error Message

Reported Condition

Missing or empty node data file.

Reports when the associated node data file is empty
of missing. This can occur when a model has

become corrupt during the save or copy process -

especially when the model is manually copied from

one location to another.
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Node Data - Reported Errors

Error Message

Reported Condition

Duplicate node names.

Reports two or more nodes with identical names or
numbers. Although not required, generally node
names should be unique to the model.

Out-of-bounds values - Values that either exceed
the specified maximum value or are less than the
specified minimum value.

Reports a node where one of the assigned values is
outside the bounds or limits specified in the check
data.

Both the pressure and loads are either “known” or
“unknown”.

Reports a node where the “known” settings for both
the pressure and load values are the same. With the
exception of nodes associated with regulators and
compressors, generally either the pressure or load
must be known and the other unknown. The case
where both the pressure and load are unknown is
not supported.

Invalid dimensional units.

Reports a node where the assigned dimensional
units for one of the data items does not match the
supported dimensional units for that item.
Generally occurs when an invalid value is assigned
during the Import or Merge routine.

Multiple nodes at the same location.

Reports two or more nodes located at the same
coordinate location. This may indicate a
connectivity or configuration error.

Warning if the status is set to “off” for the base
load or external load.

Reports a node where the status of either the base
or external load is set to “off”. Not necessarily and
error just a reminder.

Pipe Data - Reported Errors

Error Message

Reported Condition

Missing or empty pipe data file.

Reports when the associated pipe data file is empty|
of missing. This can occur when a model has

become corrupt during the save or copy process -

especially when the model is manually copied from

one location to another.
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Pipe Data - Reported Errors

Error Message

Reported Condition

Missing Property Tables.

Reports when one of the assigned Property Tables
is not found.

Invalid From Node or To Node Record Numbers.

Reports a pipe where either or both of the record
numbers associated with the From and To Node are
beyond the number of nodes contained in the node
data file. Generally occurs when a model has
become corrupt during the save or copy process.
May also be reported in the Connectivity check.

Size/Type Code not found in the Pipe Property
Table.

Reports a pipe where the assigned Size/Type Code
is not found in assigned Property Table.

Multiple Size/Type Code matches in the Property
Tables.

Reports a pipe where the assigned Size/Type Code
is not found multiple times in assigned Property
Table.

Out-of-bounds values - Values that either exceed
the specified maximum value or are less than the
specified minimum value.

Reports a pipe where one of the assigned values is
outside the bounds or limits specified in the check
data.

Invalid pipe flow equation.

Reports a pipe where the assigned value for the
pipe flow equation is not supported. Can occur
when an invalid value has been imported or merged
into model.

Warning if the status set to “off”.

Reports a pipe where the hydraulic status is set to
“off”. Not necessarily and error just a reminder.

Invalid dimensional units.

Reports a pipe where the assigned dimensional
units for one of the data items does not match the
supported dimensional units for that item.
Generally occurs when an invalid value is assigned
during the Import or Merge routine.

Large diameter to length ratio.

Reports a pipe where the ratio of the diameter to the
length isunusually large. This may indicate an error
in the diameter or length values. This condition
may prevent the solution from becoming complete.
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Pipe Data - Reported Errors

Error Message

Reported Condition

Elevation difference greater than length value.

Reports a pipe where the difference in elevation
between the From and To Nodes is greater than the
length of the pipe. This condition represents and
error in the elevation or length values. The model
will not be able to solve with this condition.

Invalid equivalent length value.

Reports a pipe where the equivalent length of the
attached fittings is less than zero. This may occur
when an error has occurred while attaching or
deleting a fitting from a pipe segment. Can also
occur if an invalid equivalent length value is
entered into the Fitting Property Table.

Invalid regulator or compressor set pressures
values.

Reports a regulator or compressor style pipe where
the set pressure is less than zero.

Unusual “known” or “unknown” settings at the
outlet side of regulators and compressors.

Reports a regulator or compressor style pipe where
status of the “known” and “unknown” settings for
the outlet node are unequal. Generally both the
pressure and load should be set to “known” for the
outlet node of a regulator, and for the “control”
node of a compressor.

Invalid compressor efficiency values.

Reports a compressor style pipe where the value of
the efficiency data item is unusually small or large.
Generally indicates an entry error.

Invalid or zero valve opening setting.

Reports a valve style pipe where the value of the
percent open data item is unusually small or large.
Generally indicates an entry error. To indicate that
valve is shut off, set the hydraulic status to “off”.

Invalid well count, well coefficient, or exponent
value.

Reports a well style pipe where the value of the one
of the reported data items is unusually small or
large. Generally indicates an entry error.

Unsupported Hydraulic Type.

Reports a pipe where the assigned hydraulic type is
not supported. Generally occurs when an invalid
value is assigned during the Import or Merge
routine.
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Pipe Data - Reported Errors

Error Message

Reported Condition

Invalid or redundant Link ID Numbers.

When a pipe attribute file is attached, reports a pipe
where the value of the Link ID Number is not found
in the assigned attribute file, or the value is found
to be assigned to multiple pipes in the model.

Difference in graphic and hydraulic length.

Reports a pipe where the assigned hydraulic length
is different than the calculated graphic length. This
can occur when a pipes have been created by
importing or merging data, and the length value is
assigned to a value from the imported file. Not
necessarily and error, just a reminder to check it.
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Data List Definition Screen

The Attribute Data and Sizing Group are examples of items that are supported by data lists. The data lists
may be modified by the User using the Data List Definition screen. To create or modify a data list, select the
Data List Definition item from the Edit menu. The features associated with the screen are described as
follows.

Data List Definition - CAProgram Files (x86)\GASWorkS 100 SupportDatalists\class_location.lst..,
- =] =l
= ol e d e =
Item # | ltem Descrption ||tem Index |Item Yalue
1 1 1 1
2 2 2 2
3 3 3 3
4 4 4 4
5 Unknown 0 0
< | »
Cloze
Displayed Items

Item # - Displays the position that the “item” will be displayed in the data list. This is internally assigned
and cannot be changed by the User.

Data Items

Item Description - Specifies the description for the “item” that will be displayed in the data list.

Item Index - Specifies an index value associated with the list item. If the data list is assigned to an integer
type field in the Attribute Database Definition, the index value may be used to indicate the assigned “list”
item. The use of an index value is optional, however if used, the value should generally be unique to the
associated data list. The index value must be an integer value. If “Remark” is selected as the value, the ltem
Description will not be listed when the Data List is displayed.

Item Value - If displayed, specifies a numeric value to be associated with the “list” item. The value may be
an integer or floating point number.
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Add Item - Adds a new item to the end of the definition.

Delete Item - Deletes the currently selected (highlighted) item.

Insert Item - Inserts a new item just before the currently selected (highlighted) item.

Maximize Screen Size - Increases the Data List Definition screen’s size to fill the GASWorkS
display.

Move Item - Moves the currently selected (highlighted) item to a new location in the Data List
Definition. When clicked, a message will be displayed to select the new location. Click the OK
command button to clear the message, then select the desired location.

Open - Opens a previously saved Data List Definition file (.1st). When clicked, the File Selection

screen is displayed.

Print - Prints the contents of the Data List Definition. When clicked, the Print Settings screen is
displayed.

Reset Screen Size - Sets the Data List Definition screen’s size to its “normal” dimensions and
position.

Save - Saves the contents of the currently displayed Data List Definition. When clicked, the File
Selection screen is displayed. Once saved, the file may be opened and used with other models.

Command Buttons

Close - Closes the screen. A message will be displayed if changes have been made without saving - respond
appropriately.
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Notes & Considerations

® The Item Index value must an integer value between -32000 and 32000, including 0 (zero).

® The ltem Value item may or may not be displayed. The value is used by certain calculation routines. If the
item is displayed, its value may be any double precision numeric value.

® Several predefined data lists are included when the software is installed. The data lists are normally
installed in the GASWorkS Support directory (folder) (...\support\datalists).
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Default Data Values Screen

The default data values are used to initially populate the pipe and node data values when creating a new
model or adding new features to an existing model. These values are set using the Default Data Values
screen. The screen may be accessed by selecting the Set Defaults item from the Utilities menu, or by clicking
the Set Default Data Values command button on either the Import or Merge screen. The features associated
with the screen are described as follows.

Dimensional Units Tab

Default Data Values...

T Hydraulic Data T Gas Properties T Miscellaneous

Default Dimensional Units_

Coordinates: lm Node Load: m
Customer Load: m Pipe Flow Rate: m
Diameter: Inches - Pressure: Psi -

Efficiency: lm Temperature: ’m‘
Elevation: m Yelocity: ’m
Heating ¥alue: lm Yiscosity: ’m
Length: Feet -

Apply Dimensional Units Only | Apply All Yalues |

Save Settings Open Settings | Cancel Cloze |

Data Items

Note - Some dimensional units are common throughout the model, some may be set individually. Units that
may be set individually are noted as “default” in the following.

Coordinates - Specifies the dimensional units to use for the model coordinate values.
Customer Load - Specifies the “default” dimensional units to use for the customer load values.

Diameter - Specifies the “default” dimensional units to use for the diameter values.
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Efficiency - Specifies the dimensional units to use for the efficiency values.

Elevation - Specifies the dimensional units to use for the elevation values.

Heating Value - Specifies the dimensional units to use for the heating values.

Length - Specifies the default dimensional units to use for the length values.

Node Load - Specifies the default dimensional units to use for the node (base) load values.

Pipe Flow Rate - Specifies the default dimensional units to use for the flow rate and capacity values.

Pressure - Specifies the default dimensional units to use for the node pressures and pipe pressure (drop)
values.

Temperature - Specifies the dimensional units to use for the temperature values.
Velocity - Specifies the dimensional units to use for the velocity values.

Viscosity - Specifies the dimensional units to use for the absolute or dynamic viscosity values.
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Hydraulic Data Tab

Default Data Values...

Dimenzional Units T Hydraulic Data T Gas Properties T Mizcellaneous

Default Data ¥alues._ .

Pipe Size/Type: |2P j Inches
Pipe Equation: |IET-Impruved j
Pipe Efficiency: 0.95 Decimal [ Allow Pipe Sizing

Mode Pressure: 1] Pszi v Yalue Iz Unknown
Mode Basze Load: 0 Mcrh [~ ¥Walue Iz Unknown
Mode Elevation: 6200 Feet

Hode Temperature: |60 F ahrenheit [ Walue Iz Unknown
Apply Hydraulic Data Yalues Only | Apply All ¥alues |
Save Settings Open Settings | Cancel Cloze |

Data Items

Allow Pipe Sizing - Specifies, the default setting for the A/low Pipe Sizing option.

Node Base Load - Specifies the default node base load value. A negative value indicates a demand (flow
leaving the system), and a positive value indicates a supply (flow entering the system). If customer features
will be used with the model, in general set the default Node Base Load value to zero (0).

Node Elevation - Specifies the default node elevation value.

Node Pressure - Specifies the default node pressure value. In general, this value should be set to zero (0).
Node Temperature - Specifies the default node temperature (gas flowing temperature) value.

Pipe Efficiency - Specifies the default pipe efficiency (hydraulic efficiency) value.

Pipe Equation - Specifies the default pipe flow equation.

Pipe Size/Type - Specifies the default pipe Size/Type Code (Diameter value).
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Value Is Unknown - Specifies the default “known” or “unknown” setting for the associated data value.
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Table Of Contents

Default Data Values...

Dimenszional Units T Hydraulic Data T Gas Properties T

Mizcellaneous

Default Gas Property Yalues. .

Specific Gravity: 0.6
Vizcosity: 0.000007 Lbm/Ft-zec

Heating ¥alue: 1000 Btulcf

Specific Heat Ratio: |1.3

[ Walues Are Unknown

Calculate Gas Properties From Composzition

Apply Gas Property ¥alues Only | Apply All ¥alues |

Save Settings Open Settings | Cancel

Cloze |

Data Items

Heating Value - Specifies the default heating value (energy content).
Specific Gravity - Specifies the default specific gravity value.
Specific Heat Ratio - Specifies the default specific heat ratio value.

Viscosity - Specifies the default viscosity value.

Value Is Unknown - Specifies the default “known” or “unknown” setting for the gas property values.
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Miscellaneous Tab

Default Data Values...

Dimenszional Units T Hydraulic Data T Gas Properties T

Mizcellaneous Data Values. ..

Pipe Facility Type: |UnSpecified -]

Mode Increment: L -

Pipe Sizing Group: |Any j
Apply Miscellaneousz D ata Yaluez Only | Apply All ¥alues |
Save Settings Open Settings | Cancel Cloze |

Data Items

Node Increment - Specifies the default node increment value.

Pipe Facility Type - Specifies the default pipe Facility Type.

Pipe Sizing Group - Specifies the default pipe Sizing Group.

Command Buttons

Apply...Only - Applies the default data values associated with the currently displayed data tab, to all of the
pipes and nodes in the currently open model. This routine is useful when only a specific set of the default
data values need to be changed (for example, to reset the dimensional units).

Apply All Values - Applies all of the default data values and settings to all of the pipes and nodes in the
currently open model. This routine is useful when a new model is created using the wrong default data values
and settings.
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Calculate Gas Properties From Composition - Calculates the gas properties from a known composition.
The command button is displayed on the Gas Properties data tab.

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.
Open Settings - Opens a previously saved default settings file (.dfs).

Save Settings - Saves the current default data values and settings to a file.

Notes & Considerations

® Depending on the value of the Use Last Record For Default Values preference settings option, the default
data values are used to initially populate the pipe and node data items when a new feature is added to the
model. These include selected default data values that are most commonly used for the system being
modeled. These values and settings may need to be changed from time to time depending on the nature of
the current model.

® When the Use Last Record For Default Values preference settings option is selected the default pipe and
node values are only used for the first record, and thereafter the data from the last record in the model will
then be used.

® Any of the default data values may be overridden as the new features are entered (if the Al/low Data Entry
During New Feature Entry graphic settings option is selected), or after the data has been entered using the
data editing routines.
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Design Factor Calculation Screen

The Design Factor Calculation screen may be accessed by clicking the Calculate command button on the
Solution Data tab of the Solution Data screen or by selecting the Calculate Design Factor item from the
Analysis menu. The features associated with the screen are described as follows.

Design Factor Calculation...

Current Deszign Factor: 2.0000

Desired Total System Flow: ||] |I'-'I-::fh j

Current Total System Flow: Mcfh
Calculated Design Factor:

Calculate |

Cancel | |

Data Items

Desired Total System Flow - Specifies the desired total system flow value.

Calculated Items

Calculated Design Factor - Displays the calculated Design Factor value which when used, would cause the
total system flow to equal the entered value.

Current Design Factor - Displays the current value of the Design Factor. The item is automatically
populated and cannot be directly changed by the User.

Current Total System Flow - Displays the current value of the total system flow. The item is automatically
populated and cannot be directly changed by the User.

Command Buttons

Apply - Closes the calculation screen and applies the calculated Design Factor value to the Solution Data
screen.
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Calculate - Calculates the associated Design Factor.

Cancel - Closes the calculation screen without applying the calculated Design Factor.

Notes & Considerations

® The Design Factor is used to adjust the node and customer load values during the Solution routine. The
value may be used to raise or lower the total demand on the model.

® The Total System Flow is the summation of all of the flows into the model.
® Adjustment to individual node or customer features may be controlled using either the Adjust Base Load
or Adjust External Load options associated with a node and/or the Adjust Load option associated with a

customer.

® For node features, only the loads for nodes that are associated with a pipe Facility Type set to “solve”, are
adjusted.
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Facility Settings Screen

The Facility Settings associated with a model are managed using the Facility Settings screen. The Facility
Settings screen may be accessed by selecting the Facility Settings item from the Edit menu. The features
associated with the screen are described as follows.

I3 Facility Settings... >
[ ] = =] =
= e o e d e =
Record Humber | Index No |Facility Type | Display | [
1 0 UnSpecihied X —
2 L Main - Low Pressure X
3 b Main - Medium Preszure X
4 ¥ Main - Intermediate Pressure X
Li] 8 Main - High Prezssure X
(3] 9 Main - Propozed X 2
| | 3
Cancel Save As Default Apply |

Displayed Items

Record Number - Refers to the position of the current Facility Type in the facility settings file. This value
is automatically assigned and cannot be changed by the User.

Data Items

Active - Indicates whether the data features with the associated Facility Type may be changed using the
various Edit routines. Generally, all features associated with an “inactive” Facility Type, are excluded from
the Edit routines. The exception is that if the Ignore Facility Settings On Mass Update preference settings
option is selected, all records will be included in changes made by the Mass Update routine.

Display - Indicates whether the data features with the associated Facility Type will be displayed in the GDI
Display.

Facility Type - Specifies the name of the facility.
Index No (Number) - Specifies the value of the “index” of the associated Facility Type. Facility Types are

actually stored as a number value - the index number represents that value. This value must be unique to the
model.
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Pipe Flow Equation - Specifies which pipe flow equation to use when a pipe associated with the Facility
Type has the Flow Equation in the Pipe Data set to “Facility Table”.

Pipe Line Color - Specifies which color to use when a pipe associated with the Facility Type has the Pipe
Line Color in the Pipe Data set to “Facility Table”.

Pipe Line Style - Specifies which line style to use when a pipe associated with the Facility Type has the Pipe
Line Style in the Pipe Data set to “Facility Table”.

Pipe Line Thickness - Specifies which line thickness to use when a pipe associated with the Facility Type
has the Pipe Line Thickness in the Pipe Data set to “Facility Table”.

Pressure Units - Specifies the pressure units to use when a pipe associated with the Facility Type has the
Pressure Units in the Pipe Data set to “Facility Table”. This parameter is included for future implementation,
it is not currently used.

Report - Indicates whether the data features associated with the Facility Type will be included in the various
Report routines.

Solve - Indicates whether the data features associated the Facility Type are included in the Solution routine.

Note - Be careful when excluding features from the Solution routine, as a non-solvable configuration may
result when excluding portions of the piping system.

Icons

Add Record - Adds a new record to the end of the Facility Settings table.

Delete Record - Deletes the currently selected (highlighted) record.

Insert Record - Inserts a new record just before the currently selected (highlighted) record.

Maximize Screen Size - Increases the Facility Settings screen’s size to fill the GASWorkS
display.

[ [ [
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Move Record - Moves the currently selected (highlighted) record to a new location in the Facility
Settings. When clicked, a message will be displayed to select the new location. Click the OK
command button to clear the message, then select the desired location.

Open - Opens a previously saved Facility Settings file (.fac). When clicked, the File Selection
screen is displayed.

Print - Prints the contents of the Facility Settings table. When clicked, the Print Settings screen
is displayed.

Reset Screen Size - Sets the Facility Settings screen’s size to its “normal” dimensions and
position.

Save - Saves the contents of the currently displayed Facility Settings. When clicked, the File
Selection screen is displayed. Once saved, the file may be opened and used with other models.

A [E (b |t |im

Command Buttons

Apply - Closes the screen and applies changes.
Cancel - Closes the screen without saving changes.
Save As Default - Saves the current facility settings as the default settings to be used when creating a new

model.

Notes & Considerations

® The Facility Settings screen lists the Facility Types associated with the currently open model or currently
opened Facility Settings file, and the associated settings. The settings control how the data features
associated with a specific Facility Type are handled by the various Report, Display, Edit, and Solution
routines.

® Facility Types are primarily assigned to pipe data features. The node and customer features inherit the
Facility Type of the pipe that they are associated with or assigned to.
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® Nodes may be associated with several pipe features, and each pipe potentially could possess different
Facility Types and settings. In these cases, the node handling will vary according to the routine. If at least
one associated pipe possesses a Facility Type that allows a process, then the node is allowed in any
associated activities. For example, if at least one pipe is set to “Display”, the node is displayed - if at least
one pipe is set to “Report”, the node is reported, etc.

® When a Facility Type is assigned to a feature, the Index No for the Facility Type is saved with the feature’s
data. There are several “special” Facility Types that have pre-assigned Index No’s, these begin at 30000. (For
example, there is a special Facility Type for the Color Legend.) The Index No for all other Facility Types
may be entered by the User. When manually entering an Index No, ensure that the number is unique and
between 1 an 29999.
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File Selection Screen

The File Selection screen is used for accessing various support and other files. The File Selection screen is
displayed by various routines. The features associated with the screen are described as follows.

bmp - Background Image Filename...

Filename: |E:\nglam Files [x86)\GASWorkS 10VFiles\ . bmp

L] L

Drives: | = c: [TI10695800D]

Directories: [ )

=5 Program Files [xBE]
£ GASWork5 10

Files: ! : p
sample.bmp

Cancel LContinue._.

Data Items

Directories - Specifies the directory (folder) on the selected disk drive to use. When a directory has been
selected, any files matching the specified extension or search pattern will be displayed in the Files panel.

Drives - Specifies the disk drive to use. When a drive is selected, the directories contained on that drive will
be listed in the Directories panel.

Filename - Specifies the name of the file to be used. A list of the most previously used files may be accessed
from the drop-down list. The Filename may be entered by various means. If the Filename is manually

entered, include the path. Extension values will vary according to the file type.

Files - Specifies the matching files found in the selected directory on the selected disk drive.

Command Buttons

Cancel - Closes the screen without saving changes, and without preceding without the routine that invoked
the screen.

Continue - Accepts the displayed Filename and proceeds with the associated routine.
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Notes & Considerations

® Depending on the routine that invoked the File Selection screen, the response to errors which may occur
while selecting a file will vary. If the routine requires a new Filename and an existing Filename is selected,
the screen will prompt whether the file should be overwritten - respond appropriately. If an existing file is
chosen to be “overwritten”, the file is not actually destroyed, it is sent to the Windows Recycle Bin. If the
routine requires the name of an existing file and the name of a non-existent file is specified, the screen will
respond with either a message that the file does not exist or will prompt whether the file should be created
depending on the nature of the calling routine - respond appropriately.

® Wild card characters may be entered in the Filename data field to alter the contents of the Files panel.
Valid characters are “*” for multi-character replacement, and “?” for single character replacement.

® Drives, Directories, and Filename values must correspond to the standard “DOS” format. That is, drive
letters must be followed by a colon “:”, directories must be separated by a back slash “\”, and extensions must

9

be proceeded by a dot “.”.

® When manually entering a value in the Filename data field, include the drive, full path name, Filename,
and extension values.
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Find Record Screen

searching for a specified data value. The search criteria is entered using the Find Record
specification screen. The Find Record specification screen is accessed by clicking the Find
Record icon from the associated report screen. The features associated with the screen are
described as follows.

The Find Record routine is used by many of the report screens. It allows records to be located by @

Find Record...
From Node Or To Hode Name.

Cancel Find Next Search

Data Items

Search Value - Specifies the data value to search for. The title of the data field and the meaning of the value
will vary depending on which report was used to open the screen.

Command Buttons

Cancel - Closes the screen without performing the search.
Find Next - If enabled, searches for another occurrence of the most previously specified search value.

Search - Initiates the search.

Notes & Considerations

® The Search Value will vary depending on the report which invoked the Find Record routine. For pipe data,
both the From Node and To Node Names are searched. The node Name values are searched for node data.
The Link ID Number values are searched for customer data.

® When executed the first time, searching begins from the start of the file or current selection set for a record
matching the search criteria. If a match is found, the matching record is made current. To find other
occurrences, re-execute the Find Record routine and click the Find Next command button. If no match is
found, a message will be displayed.
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® When the Find Next command button is clicked, the search begins at the last matching record, then
searches to the end of the file or selection set. If no match is found, the search begins again at the beginning
of the file or selection set and continues until a match is found, or the entire file or selection set has been
searched.
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The Fitting Data screen is accessed by clicking in an Attached Fittings cell on the Hydraulic Data tab of the

Pipe Data Report. The features associated with the screen are described as follows.

Fitting Data - Rec Mumber: 1, ID Number: 1, Nodes: Reg_Out to 10

Fitting Data...

Available Fittings: 1/2 L-45 Thd

Attached Fittings:

Total Equivalent Length: Feet

Becalculate Length | Clear Attached Fittings List

Cancel | Close

Data Items

Attached Fittings - Displays the attached fittings for the associated pipe segment.

Available Fittings - Specifies the fittings available to attach to the associated pipe segment.

Calculated Values

Total Equivalent Length - Displays the total equivalent length of the attached fittings listed in the Attached
Fittings list. This value is added to the pipe hydraulic length during the Solution routine.

Command Buttons

Cancel - Closes the screen without saving changes.

Clear Attached Fittings List - Removes all of the fittings from the Attached Fittings list.

Close - Closes the screen and save changes.
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Recalculate Length - Recalculates the Total Equivalent Length value when another fitting is attached.

Notes & Considerations

® To attach (add) a fitting, select an item from the Available Fittings list.
® To remove a fitting, double-click on the associated item in the Attached Fittings list.

® The equivalent length of any attached fitting is added to the pipe hydraulic length when performing
hydraulic calculations during the Solution routine.

® The Available Fittings list is populated with the values from the currently assigned Fitting Property Table.

® The total equivalent length of the attached fittings is calculated based on the inside Diameter value of the
associated pipe.
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Gas Properties Calculator Screen

GASWorkS provides a routine for calculating the Heating Value, Specific Gravity, Specific Heat Ratio, and
Viscosity values based on an entered gas composition. The routine may be accessed by either selecting the
Calculate Gas Properties item from the Analysis menu, or by clicking the Calculate Gas Properties From
Composition command button from the Default Data Values screen. The features associated with the screen
are described as follows.

Gas Properties Calculator...

Enter Gaz Composition [%]...

Methane [CH4): Air [N2+02]:
Ethylene [C2HA4): Water [H20]:
Ethane [C2HB): Argon [Ar):

Propane [C3H8]): Carbon Monoxide [CO]):
|-Butane [IC4H10): Carbon Dioxide [CO2):

M-Butane [(nC4H10): Hydro Sulfide [H25]:

|I-Pentane [IC5H12): Helium [He]:

M-Pentane [nC5H12): Hydrogen [H2):

Hexane [C6GH14): Mitrogen [M2):

Heptane [C7H16]): Oxygen [02):

Octane [CBH18): Other:

Monane [CSHZ0]): i ] ’—_I
Decane (C10H22): I— Heating ¥alue Method:

Calculated Yalues. ..

Heating: | |Btu.ﬂ'cf j Specific Gravity:
Viscusil}l:l |me!Fl—sec ﬂ Specific Heat Ratio:

Calculate | Apply |

Clear | Open | Save | Print | Closze |

Data Items

Gas Composition - Specifies the individual components found in the gas mixture. The values are expressed
as mole percentages. The sum of all of the percentages must equal 100%. If a component does not exist in
the gas, leave its data field empty or set its value to zero (0).

Heating Value Method - Specifies the method used to calculate the heating value. The gas properties will
need to be recalculated if the method is changed.
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Calculated Values

Heating - Displays the calculated (gross) heating value associated with the entered composition.

Specific Gravity - Displays the calculated specific gravity value associated with the entered composition.
The value represents the ratio of the weight of the gas composition compared to dry air.

Specific Heat Ratio - Displays the calculated ratio of specific heat values associated with the entered
composition. The value represents the ratio of the constant pressure specific heat to the constant volume

specific heat.

Viscosity - Displays the calculated (absolute or dynamic) viscosity value associated with the entered
composition.

Command Buttons

Apply - The function of this button varies depending on the source that opened the screen. If the screen was
opened from the Analysis menu, applies the calculated gas properties values to all of the nodes in the current
model. If the screen was opened from the Default Data Values screen, applies the calculated values to the
default gas properties values only.

Calculate - Calculates the various gas property values from the entered composition.

Clear - Sets all of the data items to blank (null) values.

Close - Closes the screen and saves changes.

Open - Opens a previously saved Gas Properties file (.prp). When clicked, the File Selection screen is
displayed.

Print - Prints the data values and results. When clicked, the Print Settings screen is displayed.

Save - Saves the contents of the calculation screen. When clicked, the File Selection screen is displayed.
Once saved, the file may be opened and used with other models.

Notes & Considerations

® Some of the options in the Solution routine require that a single gas properties file be saved for the model.
This screen may be used to create the required file - click the Save command button and enter the model
name for the gas properties file name.
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® The gas properties values are calculated at the model’s currently set base conditions. To change the base
condition values, use the Other Settings data tab on the Solution Data screen.

® The combined sum of the mole percent values of all of the individual components must equal one hundred
(100.00). Use the Other data field to enter any remainder required to force a perfect total. The Other data
field can also be used to accommodate a component not available in the gas composition. The Other data
field has no influence on the calculated values, it is only used to allow for a perfect composition total.
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Go To Record Screen

associated with a specified Record Number. The Go To Record specification screen is accessed
by clicking the Go To Record icon from the associated report screen. The features associated with
the screen are described as follows.

The Go To Record routine is used by many of the report screens. It finds and displays the data % ‘

Go To Record...

Record Humber. ..

Cancel Continue._.

Data Items

Record Number - Specifies the number of the record to display at the top of the associated report.

Command Buttons

Cancel - Closes the screen without proceeding with the Go To Record routine.

Continue - Proceeds with the Go To Record routine.

Notes & Considerations

® When a value larger than the total record count is entered, the last record will be displayed.
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Graphic Settings Screen

The control variables for the GDI Display may be set using the Graphic Settings screen. The screen is
accessed by either selecting the Settings item from the Graphics menu or selecting the Graphic Settings item
from the Data Panel. The features associated with the screen are described as follows.

Graphic Settings...

Settings. ..
Item. .. Yalue._.. I:
Cuszstomer Symbol Dizplay Limit 0 Feet —
Customer Symbol Size 2 % 0Ff Display Width
Customer Symbol Style Circle - Solid
Feature Snap Hatio 3
Flow Arrow Display Limit 0 Feet
Flow Arrow Size 0 Feet -
Options...
Allow Data Entry During Hew Feature Entry ~
Always Display Flags
v| Automatically Pan & Zoom
v| Automatically Repaint GDI Image
Automatically Update Pipe Length
v Automatically Zoom On Find
v| Dizplay Axis lcon W

Feature Highlight Color: ] ¥ Use Default Highlight Color

Cancel | Save Az Delault Apply

Data Items

Options -

Allow Data Entry During New Feature Entry - When selected, the associated data may be entered
while adding a new feature.

Always Display Flags - When selected, the feature flags will always be displayed. Otherwise the
feature flags will display or be hidden depending on the zoom scale.
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Automatically Pan & Zoom - When selected, the pan and zoom functions will be automatically
executed by certain mouse events.

Automatically Repaint GDI Image - When selected, the GDI Image will be automatically repainted
(redrawn) after certain GDI Commands are executed. When not selected, the GDI Image will need
to be manually repainted using the Repaint GDI Image command.

Automatically Update Pipe Length - When selected, the length of a pipe feature will be
automatically updated when a command affecting its graphic length is used. When not selected, a
prompt will appear after a change that may affect a pipe’s length is performed, asking whether or
not to update the pipe’s length.

Automatically Zoom On Find - When selected, the GDI Display will be automatically zoomed so
that the flagged feature’s location is centered in the GDI Display when using one of the “Find”
commands. When not selected, the User will need to manually zoom to the flagged location.

Display Axis Icon - When selected, the axis icon will be displayed in the lower-left corner of the
GDI Display.

Display Flow Arrow Once Per Polyline Pipe - When selected, the flow arrows will only be
displayed once per polyline pipe feature. When not selected, the flow arrows will be placed on each
segment of a polyline pipe feature.

Display Grips - When selected, the grip symbols are displayed when a feature is highlighted
(selected) in the GDI Display. When the grips are displayed, they may be used to move the location
of the associated feature by clicking inside the grip symbol and moving it to a new location.

Display Intersection Flags - When selected, the flags resulting from the Flag Unbroken
Intersections command are displayed in the GDI Display.

Display Reference Grid - When selected, the GDI Reference Grid is displayed. When the reference
grid is displayed, the Snap Grid Intersections command may be used to force newly entered features
to snap to the grid intersection points.

Display Running Pipe Length - When selected, the length of a pipe feature, as it is being added,
will be displayed. The length will be displayed in the information panel to the right of the XY

coordinate values.

Display Solid Pipe Symbols - When selected, the pipe symbols will be filled (solid) with the current
pipe symbols color. When not selected, hollow symbols will be displayed.

Display Vertex Symbols - When selected, a symbol will be placed at each vertex location along a
polyline pipe feature or a polyline customer service line feature.
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Ignore Pipes Outside GDI Display - When selected, this item may help reduce the time required
to repaint the GDI Image.

Show Composite Service Size Change Symbol - When selected, a symbol or marker will be
displayed at the location of the pipe size change along a composite style service line. This option is
only available in the UKDM version of the GASWorkS software.

Suppress Flow Arrow Where Flow Is Less Than Convergence Tolerance - When selected, the
display of the flow arrows will be suppressed on pipe features where the flow rate value is less than
the Convergence Tolerance. When not selected, flow arrows will be placed on all pipe features
where the absolute flow value is greater than zero.

Use 3D Coordinates (X,Y,Z) - When selected, prompts for coordinate values will expect X, Y, and
Z values to be entered. When not selected, only X and Y values are required.

Vary Resolution On Zoom - When selected, drawing of features whose display size is very small
will be suppressed. Selecting this item may reduce the time required to redraw the GDI Image.

Feature Highlight Color - Specifies the color used to display a highlighted (selected) feature. To set a
Color, click in the associated box. The Color Palette will be displayed. Select the desired color, then click
the OK command button to assign the selected value.

Use Default Highlight Color - When selected, a color similar to the “opposite” of the selected features
current color will be used to highlight the feature. When unselected, the selected Feature Highlight Color
will be used.

Settings - See the following Notes & Considerations section for comments on the affect of Settings items.

Customer Symbol Display Limit - Specifies the display limit for the customer symbols.

Customer Symbol Size - Specifies the default size of the symbol used to display the customer
features. The size may be expressed as an absolute value in the Coordinates units (select In Model
Coordinate Units), or as a value relative to the diagonal distance across the GDI Display expressed
as a percentage (select % Of Display Width).

Customer Symbol Style - Specifies the default style of the symbol used to display the customer
features.

Feature Snap Ratio - Specifies the sensitivity of the Feature Snap command. The value is
expressed as a factor.

Flow Arrow Display Limit - Specifies the display limit for the flow arrow symbols.
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Flow Arrow Size - Specifies the size of the symbol used to display the pipe flow arrows. The size
may be expressed as an absolute value in the Coordinates units (select In Model Coordinate Units),
or as a value relative to the diagonal distance across the GDI Display expressed as a percentage
(select % Of Display Width).

Flow Arrow Style - Specifies the style of the symbol used to display the pipe flow arrows.

Grip Symbol Size - Specifies the size used to display the grip symbols. The size is expressed as a
value relative to the diagonal distance across the GDI Display expressed as a percentage (% Of
Display Width).

Node Symbol Display Limit - Specifies the display limit for the node symbols.

Node Symbol Size - Specifies the default size of the symbol used to display the nodes. The size may
be expressed as an absolute value in the Coordinates units (select In Model Coordinate Units), or
as a value relative to the diagonal distance across the GDI Display expressed as a percentage (select
% Of Display Width).

Node Symbol Style - Specifies the default style of the symbol used to display the node locations.

Pan/Scroll Change - Horizontal - Specifies the amount to move the GDI Image when panning
horizontally (right or left) using the Scrol/ icon. The value is expressed as a percentage of the GDI
Display width.

Pan/Scroll Change - Vertical - Specifies the amount to move the GDI Image when panning
vertically (up or down) using the Scroll icon. The value is expressed as a percentage of the GDI
Display width.

Pipe Line Style - Specifies the default line style used to display the pipe features.

Pipe Line Thickness - Specifies the default line thickness (width) used to display the pipe features.
The value is expressed in screen pixels.

Pipe Symbol Display Limit - Specifies the display limit for the pipe symbols.

Pipe Symbol Size - Specifies the size of the symbol used to display the non-pipe hydraulic features
(compressor, regulator, valve, and well). The size may be expressed as an absolute value in the
Coordinates units (select In Model Coordinate Units), or as a value relative to the diagonal distance
across the GDI Display expressed as a percentage (select % Of Display Width). Or, enter zero (0)
to indicate that the pipe symbol size will be determined by the distance between the From Node and
To Node.
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Reference Grid Color - Specifies the color used to display the GDI Reference Grid. To set a Color,
click in the associated cell. The Color Palette will be displayed. Select the desired color, then click
the OK command button to assign the selected value.

Reference Grid Spacing - Specifies the distance between lines in the reference grid.

Refresh Increment - Specifies how often the GDI Display should be updated when the GDI Image
is being repainted. The value is expressed as a percentage of the image contents. The smaller the
value the more often the GDI Display will be updated. The larger the value the less often the GDI
Display will be updated. If the value is set at 100, the GDI Display will not be updated until the GDI
Image is completely repainted. Adjusting the value may reduce the redraw time.

Supply Flag Size - Specifies the size of the flag symbol used to identify the supply nodes. The size
may be expressed as an absolute value in the Coordinates units (select In Model Coordinate Units),
or as a value relative to the diagonal distance across the GDI Display expressed as a percentage
(select % Of Display Width).

Zoom Ratio - Specifies the sensitivity of the Zoom In and Zoom Out commands. The value is
expressed as a factor.

Command Buttons

Apply - Closes the screen and applies changes.
Cancel - Closes the screen without saving changes.

Save As Default - Saves the current Graphic Settings as the default settings to be used when creating a new
model.

Notes & Considerations

® The Feature Snap Ratio is used to adjust the sensitivity of the Feature Snap command. The product of the
Feature Snap Ratio value and the Node Symbol Size value determines the size of the “snap target”. When
adding or changing certain features or measuring a distance, if the Feature Snap is turned “on”, the GDI will
attempt to find an existing node within the Snap Target value of the selected point.

® The Zoom Ratio is used to indicate the magnitude of change in the GDI Image size which occurs when
either of the Zoom In or Zoom Out commands are used. For example, if the Zoom Ratio is set at two (2), the
Zoom In command will increase the size of the GDI Image by two times. Conversely, if the Zoom Ratio is
set to two (2), the Zoom Out command will decrease the size of the GDI Image by two times.
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® Grips are small boxes display at various feature reference points when a graphic feature is selected. For
example the small boxes that appear at the pipe ends, or vertices, or text insertion point when a pipe is
selected. Grips may be used to graphically move data features displayed in the GDI by left clicking with in
the box representing the grip, then moving the mouse to the new location and left clicking the mouse again.

® When the Vary Resolution On Zoom graphic setting is selected, the features where the display size is less
than one screen pixel will not be displayed. Using this option will generally reduce the time required to
draw/redraw the GDI Image. When selected, the image may appear to be missing some features when
zoomed “out”. This occurs because display of features may be ignored at the particular zoom scale.

® Display Limit values are used to suppress the display of the associated feature, reducing “clutter” in the
image. When the diagonal distance across the screen is greater than the display limit, the associated feature
is not displayed. If the diagonal distance across the screen is less than the display limit, the associated feature
is displayed.
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Header Data Report

The Header Data Report is used to document the various solutions options and other data associated with
the model. The Header Data Report is accessed by selecting the Header Data item from the Report menu.
The features associated with the report are described as follows.

=l Header Data Report... EI =

EI ¥ View/E dit Model Notes |
Solution Data._. i)
Deszign Factor: 2 —
Convergence Tolerance,. Mcfh: 01
M aximum Iterations: 20
Divergence Limit: L
Atmospheric Pressure Method: AGA
Compreszihility Method: Mone
Diversity Method: Mone
Last Solved: === Data Was Changed Since 5olution
Largest Mode Error: 0.00 Mcfh At Node 30
Selected Solution Options. ..
Display Favonte Besults List Upon Completion =
Close

Displayed Items

Header Data Items - Displays the contents of the Header Data Report. To browse the display, adjust the
vertical scroll bar adjacent to the display area.

Icons

Maximize Screen Size - Increases the Header Data Report’s size to fill the GASWorkS display.

=] Print - Prints the contents of the Header Data Report. When clicked, the Print Settings screen is
[ | displayed.
] |
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i Quick Solve - Solves the model using the currently set solution options.
| ‘

Reset Screen Size - Sets the Header Data Report’s size to its “normal” dimensions and position.

Command Buttons

Close - Closes the Header Data Report.

View/Edit Model Notes - Displays the Model Notes screen.

Notes & Considerations

® In the report, items displayed with a “white” background may be entered or changed directly from the
Header Data Report. Items with a “colored” background cannot be changed.

® [f the GDI Window is open, the node with the largest flow error may be flagged by double-clicking on
either the Largest Node Error label or in the associated cell. A flag will be placed at the node’s location and
the display will be “zoomed” to that location.
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Mass Update Specifications Screen

Mass changes may be made to the model data using the Mass Update routine. This type of change is referred
to as a “mass update”. The Mass Update routine is controlled using the Mass Update Specifications screen.
The screen is accessed by selecting the Mass Update item from the Edit menu. The features associated with
the screen are described as follows.

Mass Update Specifications...
Yalue Setting...

Item Type._ ..

|Eustumer Model Data j
Set.. Equal To...

|Adiusl Load By Design Factor j j

Search Specification...
" Apply To All Records

&+ Apply Only To A Selection Set.._

Item Type._ ..
|Eustumer Model Data j
Where. .. Is... To...

|Adiusl By Design Factor ﬂ = j | ﬂ

Saved Search Specifications._.

Sawve Current Specification Delete Displayed Specification |

Update Bestore Close |

Data Items

Apply To All Records - Specifies that the Mass Update will be applied to all of the associated data records.

Apply Only To A Selection Set - Specifies that the Mass Update will only be applied to a User specified
set of records.

Equal To - Specifies the new value for the specified Sef item. The characteristics and contents of this item
will change depending on the selected Set item.
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Is - Specifies the search operator to be used during the Mass Update. The search operator specifies the
relation between the Where and To values.

Item Type - Specifies the type of data feature to be changed.

Saved Specifications - Displays previously saved mass update specifications. When a specification is
selected, the values on the screen will be replaced with the values associated with the selected specification.

Set - Specifies the data item to be updated.

To - Specifies the check value to be used during the matching record search. The characteristics and contents
of this item will change depending on the selected Where item.

Where - Specifies the data item to be updated.

Command Buttons

Close - Closes the screen.

Delete Displayed Specification - Deletes the currently selected specification in the Saved Specifications list.
Restore - Restores the data values which existed just prior to the executed update. The Restore command
button will only be enabled when the Allow Undo Of Data/Graphic Changes preference settings option is
selected.

Save Current Specification - Saves the currently displayed update specifications.

Update - Performs the Mass Update using the User specified settings and data values.

Notes & Considerations

® Ifthe Allow Undo Of Data/Graphic Changes preference settings option is selected, changes to the model
data may be “undone” by immediately clicking the Restore command button after the Mass Update was
performed.

® Sece the Query Features topic in the Miscellaneous section for the meanings of the search operators.
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Model Notes

Notes and reference information about an analysis or model may be kept using the Model Notes feature. The
Model Notes may be accessed by either selecting the Model Notes item from the Edit menu, by clicking the
View/Edit Model Notes command button from the Header Data Report, or from the Model Notes data tab on
the Solution Data screen. The features associated with the screen are described as follows.

Model Motes...

1272472019 - Model Projected From Plane Coordinatesz To
Longitude && Latitude.

Projection File: C:\Program Files\GASWorkS 10\support
\projections\NAD 1983 StatePlane Colorado Central FIPS
0502 [US5 Feet).prj

Projection: Lambert_Conformal_Conic

Print |

Cancel Close |

Data Items

Model Notes - Used to display and enter the Model Notes associated with the currently open model.

Command Buttons

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.

Print - Prints the contents of the notes. When clicked, the Print Settings screen is displayed.
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Notes & Considerations

® The Model Notes editor supports standard Windows cut and paste commands (Ctrl-C, Ctrl-X, and Ctri-V)
as well as the other standard editing commands controlled by the Enter, Backspace, Delete, and the Arrow
keys. The editor will automatically wrap the text if the line is longer than the available viewing space. To
cause a specific line break, press the Enter key at the end of the desired line. The Tab keys do not function
within the editor.

=
,3 B3PE LLC Engineering & Software Services
132 Revision - 004, Copyright 2021, All Rights Reserved.




GASWorkS~ 10.1 Data Screens

Table Of Contents

Model Selection Screen

The Model Selection screen is used to access the model data files. The Header file (.hdr) associated with a
model is used as the “key” file for accessing the model data. It is the only file type listed when using the
Model Selection screen. The Model Selection screen is displayed by selecting the various items in the File
menu. The features associated with the screen are described as follows.

New Maodel Name...

Model Hame: |[Z:\ngram Files [xB6]\GASWork5 10%VFiles\demo419_ILhdr

=
Drives: | = c: [TI10695800D] j

Directones: 5CA
5 Program Files [x86)
Y GASWorkS 10

_

Models: Name |Date -~
bwcxvbn_ hdr 37272021 11:49:01 AM
demo_hdr 37972021 121253 PM
demo419 |l hdr 37972021 12:28:45 PM
demo419 _xy hdr 172872021 2-41:25 PM
distribution demo_hdr 172872021 2:41:12 PM
gathering demo._hdr 172872021 2:41:14 PM
ghdf_hdr 37272021 12:06:59 PM
LMA_hdr 37272021 10:26:47 AM
projection demo_hdr 1/28/2021 2:41:16 PM
regulator demo_hdr 172872021 2:41:18 PH ‘ﬂ

Model Last Modified With GASWork5 Version: 10.0 Py i |

Statistics:

Hodes: 5 ltems
Modified: 3/9/2021 12:28:45 PM
Pipes: b ltems
Modified: 3/9/2021 12:28:45 PM
Customers: 32 ltems
Modified: 3/9/2021 12:28:45 PM
Hotes:
12/24/2019 - Model Projected From Plane Coordinates
To Longitude &k Latitude.
Projection File: C:\Program Files\A\GASWorkS v,
Cancel LContinue...
Displayed Items

Model Preview - Displays a preview of the selected model.
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Model Statistics - Displays the various information about the currently selected (highlighted) model. The
contents of the display will vary depending on the version of the selected model.

Data Items

Directories - Specifies the directory (folder) on the selected disk drive to use. When a directory has been
selected, any models contained in that directory will be displayed in the Files list.

Drives - Specifies the disk drive to use. When a drive is selected, the directories contained on that drive will
be displayed in the Directories list.

Model Name - Specifies the name of the model to be used. A list of the most previously used models may
be accessed from the drop-down list. The Model Name may be entered by various means. If the Model Name

is manually entered, include the path.

Models - Specifies the models found in the selected directory on the selected disk drive.

Command Buttons

Cancel - Closes the screen without saving changes, and without proceeding with the routine that invoked
the screen.

Continue - Accepts the displayed model name and proceeds with the associated routine.

Notes & Considerations

® Depending on the routine that invoked the Model Selection screen, the response to errors which may occur
while selecting a model will vary. If the routine requires a new model name and an existing model name is
selected, the screen will prompt whether the model should be overwritten - respond appropriately. If an
existing model is chosen to be “overwritten”, the model is not actually destroyed, it is sent to the Windows
Recycle Bin. If the routine requires the name of an existing model and the name of a non-existent model is
specified, the screen will respond with either a message that the model does not exist.

® Wild card characters may be entered in the Model Name data field to alter the contents of the Models
panel. Valid characters are “*” for multi-character replacement, and “?” for single character replacement.

® Drives, Directories, and Model Name values must correspond to the standard “DOS” format. That is, drive
letters must be followed by a colon *“;”, directories must be separated by a back slash “\”, and extensions must
be proceeded by a dot “.”.
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® When manually entering a value in the Mode! Name data field, include the drive, full path name, and model
name.

® The name of the currently open model is displayed at the top of the main GASWorkS screen.

® To save a model to a directory (folder) other than the “default” directory (folder), select the desired
location using the drive and directories, then enter the model name only in the model name data field.
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Node Data Report

The Node Data Report is accessed by selecting the Node Data item from the Report menu. The “report”
displays both entered and calculated data values. Entered data values may be changed directly in the report
by the User. The features associated with the report are described as follows.

Model Data Tab
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Data Items

Adjust Base Load By DF - Indicates whether the node’s base load value will be multiplied by the Design
Factor during the Solution routine. The original data value is not changed by this setting, the Base Load value
is only modified during the Solution routine.

Adjust External Load By DF - Indicates whether the node’s external load value will be multiplied by the
Design Factor during the Solution routine. The original data value is not changed by this setting, the External
Load value is only modified during the Solution routine.
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Base Load - Specifies the node’s base load value. If the Base Load value is “known” (Base Load Known set
to “Yes”), enter a value. If the Base Load value is “unknown”, set the Base Load Known item to “No”. If the
model has been recently solved and the load is “unknown”, the item will display the calculated load value
for the node. Initially, the field is populated with the default Node Base Load value. See the following Notes
& Considerations section for additional information on the Base and External Load values.

Base Load Known - Indicates whether the base load value is “known” (“Yes”) or “unknown” (“No”).
Base Load Status - Indicates whether the base load value is “on” or “off” during the Solution routine. If the
status is set to “off”, the Base Load value is assumed to be zero (0) during the Solution routine. The original
data value is not changed by this setting.

Calibration Type - Specifies the type of calibration style.

Calibration Value - Specifies the known value to be checked against. The value is expressed in either the
Pressure Units or Load Units, depending on the selected Calibration Type.

Elevation - Specifies the node’s height above sea level. Initially, the field is populated with the default Node
Elevation value.

External Load Status - Indicates whether the external load value is “on” or “off” during the Solution
routine. If the status is set to “off”, the External Load value is assumed to be zero (0) during the Solution
routine. The original data value is not changed by this setting.

Gas Properties Known - Indicates whether the gas properties are “known” (“Yes”) or “unknown” (“No”).
Heating Value - Specifies the heating value of the gas at the node’s location.

Load Units - Specifies the dimensional units for the various load values.

Name - Specifies the unique name or number for the associated node. The name may contain up to forty (40)
alphanumeric characters. The name is automatically assigned when a new node is added, however the User
can change the name to the desired value. The name must be unique to the model. A message will be
displayed if the name already exists.

Pressure - Specifies the node’s pressure value. If the Pressure value is “known” (Pressure Known set to
“Yes”), enter a value. If the Pressure value is “unknown”, set the Pressure Known item to “No”. Initially,
the field is populated with the default Node Pressure value. If the model has been recently solved and the
pressure is “unknown”, the item will contain the calculated Pressure value for the node.

Pressure Known - Indicates whether the pressure value is “known” (“Yes”) or “unknown” (“No”).
p

Pressure Units - Specifies the dimensional units to be used for the Pressure value.
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Specific Gravity - Specifies the specific gravity value of the gas at the node’s location. The Specific Gravity
represents the weight or density of the gas compared to dry air.

Specific Heat - Specifies the specific heat ratio of the gas at the node’s location. The specific heat ratio
represents the constant pressure specific heat divided by the constant volume specific heat of the gas mixture.

Temperature - Specifies the average flowing temperature of the gas at the node’s location. If the
Temperature value is “known” (Temperature Known set to “Yes”), enter a value. If the Temperature value
is “unknown”, set the Temperature Known item to “No”. Initially, the field is populated with the default
Node Temperature value. If the model has been recently solved, the Temperature value is unknown, and the
Calculate Temperature Values solution option was selected, the item will contain the calculated Temperature
value for the node.

Temperature Known - Indicates whether the temperature value is “known” (“Yes”) or “unknown” (“No”).
Viscosity - Specifies the dynamic viscosity of the gas as measured (calculated) at the node’s location.
X-Coordinate - Specifies the node’s east-west coordinate value (horizontal location in plan view).

Y-Coordinate - Specifies the node’s north-south coordinate value (vertical location in plan view).

Z-Coordinate - Specifies the node’s vertical coordinate value when using 3D Coordinates.

Calculated Values

Atmospheric Pressure - Displays the calculated atmospheric pressure value based on the node’s elevation.
Calibration Difference - Displays the difference between the known value and the value in the model.

Calibration Difference, % - Displays the difference, as a percentage, between the known value and the
value in the model.

Edit Date - Displays the date when the node data was last changed.

External Load - Displays the external load value times the Design Factor, if the Adjust Ext Load By DF item
is set to “Yes”.

External Load (Fixed) - Displays the portion of the external load which cannot be adjusted by the Design
Factor.

Flow Error - Displays the difference between the total flow in-to the node and the total flow out-of the node.
See the following Notes & Considerations section for additional information.
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Internal ID Number - Displays the node features unique (to GASWorkS) identification number. This value
is automatically assigned and cannot be changed by the User.

Total Load - Displays the total of the (adjusted) Base, External Load, and External Load (Fixed) values.
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Attribute Data Tab

If a node attribute file is attached to the model, the Attribute Data tab of the Node Data Report displays the
data contained in the attribute file. If a database is attached, this data tab will display the values associated
with the data fields contained in the associated attribute file (database) and will vary by file. If a “linked”
style database is attached, the values may be changed by the User. If a “non-linked” style database is
attached, the values are view-only and cannot be changed by the User. The displayed items (columns) will
vary depending on the content of the attached file.
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Displayed Items

Record Number - Refers to the position of the current node record in the node data file. An asterisk (“*”)
next to the Record Number denotes that changes have been made to the record since the last execution of the
Solve routine. This value is automatically assigned and cannot be changed by the User.

Data Items

Link ID Number - Specifies the identification number used to link the node records in the model to the
records in an attached attribute file. When a “linked” style attribute file is attached, the number is
automatically assigned and cannot be changed by the User. When a “non-linked” style attribute file is
attached, the number is the same as the nodename value assigned by the User. The number should represent
a value that is unique in the attribute file (database).
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Link To Database - Indicates whether the node should be linked to the attribute file (database). If “Yes” is
selected, the node will be linked to the database by matching the Link ID Number.

1 [ LS e

Add To Favorites - Adds the currently selected (highlighted) node record to the Favorite Results
list.

Edit Selection Set Values - Changes data values en masse for the current selection set of nodes.
When clicked, the Multiple Edit Specifications screen is displayed.

Find Node - Finds and flags the currently selected (highlighted) node record in the GDI Display.
This icon only works if the GDI Window is open before the Node Data Report is opened.

Find Record - Finds a node record in the current selection set by node Name. When clicked, the
Find Record specification screen is displayed.

Go To Record - Displays the node record associated with a specified Record Number at the top
of the current data tab. When clicked, the Go To Record specification screen is displayed.

Make Selection Set - Creates a selection set of nodes which meet a User specified selection
criteria. When clicked, the Query Specifications screen is displayed.

Maximize Screen Size - Increases the Node Data Report ’s size to fill the GASWorkS display.

Print - Prints the contents of the displayed data tab. When clicked, the Print Settings screen is
displayed.

Quick Solve - Solves the model using the currently set solution options.
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Reset Screen Size - Sets the Node Data Report ’s size to its “normal” dimensions and position.

Reset Selection Set - Resets (clears) the current selection set. When clicked, all of the reportable
node records will be displayed on the associated data tab.

Restore Columns - Restores the display of all of the columns (data items). When clicked, all of
the columns associated with the current data tab will be displayed.

Save To CSYV File - Saves the data associated with the current data tab to a comma separated
values file (.csv). When clicked, the file will be created and a message will be displayed stating
the location of the saved file.

Set Columns - Used to specify which columns (data items) are displayed in the Node Data
Report. When clicked, the Columns specification screen is displayed.

Sort Ascending - Sorts the records in ascending order (A to Z or lowest to highest value) based
on the node Name.

Sort Descending - Sorts the records in descending order (Z to A or highest to lowest value) based
on the node Name.

Undo - Restores the most recent data change.

Command Buttons

Close - Closes the Node Data Report.
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Notes & Considerations

® The Flow Error values displayed in the report, represents the difference between the total flows into and
out-of a node. For a “solved” or “balanced” model, the magnitude of these values will be no greater than the
Convergence Tolerance value in the Solution Data. For an “unsolved” or “unbalanced” model, these values
may be used to determine where the solution is having issues trying to solve. Larger Flow Error values are
associated with nodes where the model is having trouble solving. Check the model values and connectivity
near these locations for errors.

® The Favorites List in the GDI Data Panel may be used to display select values for select nodes allowing
quick access to results upon completion of the solution. Using the Favorites List can provide an alternative
to browsing the report for frequently viewed node records.

® The dimensional unit for the atmospheric pressure is automatically set to the same dimensional unit as the
base pressure dimensional unit (set on the Solution Data screen).

® The displayed base load represents the unadjusted base load. The displayed external load represents the
adjusted value. The displayed total load represents the sum of the adjusted base, adjusted external, and the
fixed External Load values.

® Normally the report will contain more information than will fit on a single page. If this condition occurs
when trying to print, a message will be displayed. When the message is displayed, respond appropriately.
To print a report that is too wide for the printer, either eliminate some of the undesired columns using the
Set Columns routine or by manually collapsing the undesired columns, set the printer to use Landscape
Orientation, or reduce the printer font size.

® The Report item in the Facility Settings controls which features are included in the Node Data Report.
Only nodes that are attached to pipes that are assigned Facility Types that are allowed to be reported, are
included in the Node Data Report. The Facility Settings may be viewed and changed using the Facility
Settings item found in the Edit menu, or the Report Options item from the Report menu.

® When a “.csv” file is created, it contains the data and calculated values for records in the current selection
set and only for the currently displayed columns. The file may be opened by any application which supports
the “.csv” file format.

® A cell with a “grey” background contains a fixed value. A cell with a “white” background contains a User
entered or selected value. A cell with a “yellow” background contains a calculated value. A cell with a
“cyan” background represents an unused or not applicable item. Only values in cells with a “white”
background may be changed by the User.

=
,3 B3PE LLC Engineering & Software Services
Revision - 004, Copyright 2021, All Rights Reserved. 143




GASWorkS~ 10.1 Data Screens

Table Of Contents

Path Settings Screen

The default directory (folder) locations for the various files associated with a GASWorkS model and the
support files are controlled using the Path Settings screen. The Path Settings screen is accessed by selecting
the Paths item from the Preferences submenu of the File menu. The features associated with the screen are
described as follows.

Path Settings...

Set Desired Location. .

Model Files: |E:"\F“mgram Files [x86\GASWorkS 10MFiles
Initialization Files: |E:‘uF“mgram Filez [xB6AGASWorkS 104 ni

Property Tables: [ Use Current Model Location
|E:\ngram Files [xB6AGASWorkS 10%Properties
Support Files: |E:\.ngram Filesz [(xB6AGAS W orkS 10\S5upport

Cancel Cloze

Data Items

Initialization Files - Specifies the default location for the associated initialization files.
Model Files - Specifies the default location for the associated model files.

Property Tables - Specifies the default location for the associated Property Tables.
Support Files - Specifies the default location for the associated GASWorkS support files.

Use Current Model Location - When selected, the current model location will be used for the Property
Tables.

Command Buttons

Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves changes.
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Notes & Considerations

® To change a path setting, double-click in the data field to display the Path Selection screen. Use the Drive
and Directories lists to change the current setting, then click the Continue command button to save the
selection.

® The Model Files path may be “overridden” when selecting a file using the Model Selection screen. All
other paths indicate locations used by GASWorksS to find the necessary support files. These directories can
only be changed using the Path Settings screen.

® The Initialization Files contain information about the screen location and previous data values and settings
for each screen.

® The Property Tables contain dimensional data and other property data for the various pipes and devices
used in the GASWorkS calculations.

® The Support Files contain information used by various routines including:

* Block and template definitions used by the DXF Export routine
* Coordinate projection files

* Default and example data lists

* Default and example database definitions

 Graphic images

* Default and example settings and model templates

® The Path Settings may be saved to a “default” file using the Save Current Settings item from the
Preferences submenu of the File menu. Once saved the file may be opened and used during other GASWorkS
sessions. This is useful if a particular system or client requires a certain group of setting values, the settings
may be saved and opened when needed in the future.

® Universal Naming Convention (UNC) names may be manually entered for any path location. Ensure that
the name is valid and entered correctly - for example, “\\network drive\c\model files”.
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Pipe Data Report

The Pipe Data Report is accessed by selecting the Pipe Data item from the Report menu. The “report”
displays both entered and calculated data values. Entered data values may be changed directly in the report
by the User. The features associated with the report are described as follows.

Model Data Tab
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Displayed Items

Edit Date - Displays the date when the pipe data was last changed.

Internal ID Number - Displays the pipe features unique (to GASWorkS) identification number. This value
is automatically assigned and cannot be changed by the User.

Data Items

Allow Sizing - Indicates whether the pipe size may be calculated during the Solution routine, when the
Calculate Pipe Sizes (Optimize) solution option is selected. This item is only enabled for Pipe Hydraulic
Types.
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Attached Fittings - Indicates the number of fittings that are currently attached to the associated record. Click
in the associated cell to display the Fitting Data screen. Make required changes, then click the Close
command button to attach the fittings. This item is only enabled for Pipe Hydraulic Types.

Control Style - Specifies whether the set pressure for a compressor type feature is to be applied to the
downstream (discharge) node or the upstream (suction) node. This item is only enabled for Compressor

Hydraulic Types.

D/R Units (Diameter/Roughness) - Specifies the diameter and roughness dimensional units to be used for
the associated pipe type features. This item is only enabled for Pipe Hydraulic Types.

Efficiency - Specifies the efficiency value. Initially, the efficiency is set to the default Pipe Efficiency value.
For pipe and fitting type features, this item refers to the Hydraulic Efficiency of the feature. For compressor
type features, this item refers to the Mechanical Efficiency of the compressor. This item is only enabled for
Compressor, Fitting, and Pipe Hydraulic Types.

Facility Type - Specifies the Facility Type of the associated record.

Flow Equation - Specifies the flow equation to use for when calculating pressure and flow values for the
associated record.

Hydraulic Type - Specifies the hydraulic element type for the record.

Length - Specifies the hydraulic length for the associated record. Initially the value is set to the pipe’s
“graphic” length. This item is only enabled for Pipe Hydraulic Types.

Length Units - Specifies the length dimensional units for the associated pipe type feature. This item is only
enabled for Pipe Hydraulic Types.

Number Of Wells - Specifies the number of wells represented by the associated record. This item is only
enabled for Well Hydraulic Types.

Pressure Units - Specifies the dimensional units of the pressure values.
Q Units (Flow) - Specifies the dimensional units of the flow rate values.

Set Pressure - Specifies the set pressure value for a compressor or regulator type feature. This item is only
enabled for Compressor and Regulator Hydraulic Types.

Set Pressure Units - Specifies the dimensional units to be used for the Set Pressure value. This item is only
enabled for Compressor and Regulator Hydraulic Types.
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Size/Type Code - Specifies the Size/Type Code. The meaning of this item will vary depending on the
selected Hydraulic Type. The various meanings are listed in the following table:

Hydraulic Type | Size/Type Definition

Compressor Represents a code for the compressor size and type. The content of the list
represents the Size/Type Codes found in the currently selected Compressor
Property Table.

Fitting Represents a code for the fitting size and type. The content of the list
represents the Size/Type Codes found in the currently selected Fitting
Property Table.

Pipe Represents either the Size/Type Code or the Inside Diameter value for a pipe
type feature. Either select the desired Size/Type Code, or enter the Inside
Diametervalue. The content of the list represents the Size/Type Codes found
in the currently selected Pipe Property Table.

Regulator Represents a code for the regulator size and type. The content of the list
represents the Size/Type Codes found in the currently selected Regulator
Property Table.

Valve Represents a code for the valve size and type. The content of the list
represents the Size/Type Codes found in the currently assigned Valve
Property Table.

Well Represents a code for a well record. The content of the list represents the
Size/Type Codes found in the currently assigned Well Property Table. If the
“Unique” item is selected, the required well parameters need to be manually
entered in the appropriate data fields.

Sizing Group - Specifies the Sizing Group to associate the current pipe type feature with. When using the
Pipe Sizing routine, only pipe sizes associated with the assigned group will be considered during the pipe
selection. This item is only enabled for Pipe Hydraulic Types when the Allow Sizing item is set to “Yes”.

Status - Indicates whether the Hydraulic Type is turned “on” or “off”.
Valve Opening - Specifies the opening position for a valve type feature. The value is expressed as a
percentage with 0 (zero) being completely closed and 100 being completely open. This item is only enabled

for Valve Hydraulic Types.

Well Equation Coefficient - Specifies the equation coefficient for a well type feature. This item is only
enabled for Well Hydraulic Types when the Size/Type Code is set to “Unique”.
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Well Equation Exponent - Specifies the equation exponent for a well type feature. This item is only enabled
for Well Hydraulic Types when the Size/Type Code is set to “Unique”.

Calculated Values

% (Percent) SMYS - Displays the ratio of the Hoop Stress value to the Specified Minimum Yield Strength
(SMYYS) value for pipe type features. The value is based on the SMYS value found in the Pipe Property
Table. The value is not displayed if the SMYS value is zero (0) or the Size/Type Code is not found in the
Pipe Property Table. This value is only displayed for Pipe Hydraulic Types.

Average Compressibility - Displays the average compressibility factor. The value is calculated using the
Average Pressure value and the Compressibility calculation method selected in the Solution Data.

Average Pressure - Displays the average pressure for the hydraulic type.
Customer Count - Displays the number of customers attached to the associated pipe feature.

Drop Per XXX - Displays the unit pressure drop along the pipe segment for pipe type features. This value
is calculated by dividing the overall pressure drop across the segment by the segment’s hydraulic length then
multiplying the result by the specified Pressure Drop Per Length. The Pressure Drop Per Length value may
be set on the Other data tab on the Report Options screen. This value is only displayed for Pipe Hydraulic
Types.

Equivalent Length - Displays the equivalent length value for attached fittings on pipe type features. This
value is only displayed for Pipe Hydraulic Types which have a fitting attached.

Flow Rate - Displays the calculated flow rate value. A positive value indicates that the flow direction is from
the From Node to the To Node, and a negative value indicates that the flow direction is from the To Node
to the From Node.

Hoop Stress - Displays the calculated hoop stress value for pipe type features. The value is based on the
larger of the From Node or To Node Pressure values, and the Outside Diameter and Wall Thickness values
found in the Pipe Property Table. This item is not displayed if the Size/Type Code is not found in the Pipe
Property Table. This value is only displayed for Pipe Hydraulic Types.

Inlet Pressure - Displays the inlet pressure value for the associated pipe features.

Inside Diameter - Displays the inside diameter value for pipe type features. If the Size/Type Code represents
a code, this value represents the /nside Diameter value extracted from the assigned Pipe Property Table.
Otherwise, this item represents the interpreted numeric value of the Size/Type Code value. This value is only

displayed for Pipe Hydraulic Types.

Outlet Pressure - Displays the outlet pressure value for the associated record.
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Pressure Drop - Displays the linear pressure drop across a pipe segment or device (the From Node Pressure
minus the To Node Pressure). Note - When elevation differences are present along the pipe segment, it is
possible for the downstream pressure to be larger than the upstream pressure. A positive value indicates that
the From Node pressure is larger than the To Node pressure, and a negative value indicates that the To Node
pressure is greater than the From Node pressure.

Reynolds Number - Displays the Reynolds Number for pipe type features. This value is only displayed for
Pipe Hydraulic Types.

Roughness - Displays the inside pipe wall roughness value for pipe type features. The value is either
extracted from the Pipe Property Table for the assigned Size/Type Code or entered by the User. This value
is only displayed for Pipe Hydraulic Types.

SMYS - Displays the specified minimum yield strength (SMYS) value for pipe type features. This value is
only displayed for Pipe Hydraulic Types.

Total Efficiency - Displays the total hydraulic efficiency value for pipe type features. This item is only
displayed for Pipe Hydraulic Types.

Velocity - Displays the maximum velocity of the gas flow in pipe type features. The value is calculated using
the lower of the segment’s end pressures, the volumetric flow rate, and the /nside Diameter value for the pipe
feature. This value is only displayed for Pipe Hydraulic Types.

Volume - Displays the volume of gas contained in pipe type features. The value is calculated using the
Average Pressure value, the inside diameter, and the hydraulic length of the pipe segment. This value is only
displayed for Pipe Hydraulic Types.
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Attribute Data Tab

If a pipe attribute file is attached to the model, the Attribute Data tab of the Pipe Data Report displays the
data contained in the attribute file. If a database is attached, this data tab will display the values associated
with the data fields contained in the associated attribute file (database) and will vary by file. If a “linked”
style database is attached, the values may be changed by the User. If a “non-linked” style database is
attached, the values are view-only and cannot be changed by the User. The displayed items (columns) will
vary depending on the content of the attached file.

=! Pipe Data Report... EI ] \EI
= [ E |2 =S EEE R RN a2
Model Data T
Record Internal ID  |Link ID Link To =
Humber S Hocs Elixle Humber Humber Database EiNesE B
1= TBS 10 1 1 Yes
2 10 15 2 2 Yes 2
I 15 20 3 3 Yes 1
4= 20 25 4 4 Yes 2
5 25 10 5 5 Yes 1
| ’
Close ‘
Displayed Items

From Node - Refers to the name of the beginning node of the associated pipe feature.

Internal ID Number - Displays the pipe features unique (to GASWorkS) identification number. This value
is automatically assigned and cannot be changed by the User.

Record Number - Refers to the position of the current pipe record in the pipe data file. An asterisk (“*”)
next to the Record Number denotes that changes have been made to the record since the last execution of the

Solve routine. This value is automatically assigned and cannot be changed by the User.

To Node - Refers to the name of the ending node of the associated pipe feature.
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Data Items

Link To Database - Indicates whether the pipe should be linked to the attribute file (database). If “Yes” is
selected, the pipe will be linked to the database by matching the Link ID Number.

Link ID Number - Displays the identification number used to link the pipe records in the model to the
records in an attached attribute file, or as an identifier for the pipe when no attribute file is attached. When
a “linked” style attribute file is attached, the number is automatically assigned and cannot be changed by the
User. When a “non-linked” style attribute file is attached, the number is assigned by the User. In this case,
the number should generally represent a value that is unique in the attribute file (database). When no attribute
file is attached, the number may be used to maintain any User desired alphanumeric value. The value may
be a combination of up to twenty (20) alphanumeric characters.

Add To Favorites - Adds the currently selected (highlighted) pipe record to the Favorite Results
list.

Delete Current Selection - Deletes the current selection set of pipe features.

Delete Pipe - Deletes the currently selected (highlighted) pipe record.

Edit Selection Set Values - Changes data values en masse for the current selection set of pipe
features. When clicked, the Multiple Edit Specifications screen is displayed.

Find Pipe - Finds and flags the currently selected (highlighted) pipe record in the GDI Display.
This icon only works if the GDI Window is open before the Pipe Data Report is opened.

Find Record - Finds a pipe record in the current selection set by either the From Node or To
Node Name. When clicked, the Find Record specification screen is displayed.

Go To Record - Displays the pipe record associated with a specific Record Number at the top of
the current data tab. When clicked, the Go To Record specification screen is displayed.

IRy VAR g g
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Make Selection Set - Creates a selection set of pipes which meet a User specified selection
criteria. When clicked, the Query Specifications screen is displayed.

Maximize Screen Size - Increases the Pipe Data Report’s size to fill the GASWorkS display.

Print - Prints the contents of the displayed data tab. When clicked, the Print Settings screen is
displayed.

Reset Screen Size - Sets the Pipe Data Report’s size to its “normal” dimensions and position.

Reset Selection Set - Resets (clears) the current selection set. When clicked, all of the reportable
pipe records will be displayed on the associated data tab.

Restore Columns - Restores the display of all of the columns (data items). When clicked, all of
the columns associated with the current data tab will be displayed.

Save To CSV File - Saves the data associated with the current data tab to a comma separated
values file (.csv). When clicked, the file will be created and a message will be displayed stating
the location of the saved file.

Save Current Selection - Saves the current selection set to a new model. The saved pipe records

will be used to create a new model.

Set Columns - Used to specify which columns (data items) are displayed in the Pipe Data Report.
When clicked, the Columns specification screen is displayed.

Sort Ascending - Sorts the records in ascending order (A to Z or lowest to highest value) based
on the From Node.

Sort Descending - Sorts the records in descending order (Z to A or highest to lowest value) based
on the From Node.
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q‘ Undo - Restores the most recent data change.

Command Buttons

Close - Closes the Pipe Data Report.

Notes & Considerations

® Normally the report will contain more information than will fit on a single page. If this condition occurs
when trying to print, a message will be displayed. When the message is displayed, respond appropriately.
To print a report that is too wide for the printer, either eliminate some of the undesired columns using the
Set Columns routine or by manually collapsing the undesired columns, set the printer to use Landscape
Orientation, or reduce the printer font size.

® The Report item in the Facility Settings controls which data features (records) are included in the Pipe
Data Report. Only pipes assigned to Facility Types that are allowed to be reported, are included in the Pipe
Data Report. The Facility Settings may be viewed and changed using the Facility Settings item found in the
Edit menu, or the Report Options item from the Report menu.

® [fan attribute file is attached, the contents of the file will be displayed on the A¢tribute tab of the Pipe Data
Report. Depending on the type of file attached, the attribute data values may or may not be allowed to be
edited.

® When a “.csv” file is created, it contains the data and calculated values for records in the current selection
set and only for the currently displayed columns. The file may be opened by any application which supports
the “.csv” file format.

® The Favorites List in the GDI Data Panel may be used to display select values for select nodes allowing
quick access to results upon completion of the solution. Using the Favorites List can provide an alternative
to browsing the report for frequently viewed node records.

® A cell with a “grey” background contains a fixed value. A cell with a “white” background contains a User
entered or selected value. A cell with a “yellow” background contains a calculated value. A cell with a
“cyan” background represents an unused or not applicable item. Only values in cells with a “white”
background may be changed by the User.
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Preference Settings Screen

Various GASWorkS program behaviors may be set using the Preference Settings screen. The Preference
Settings screen is accessed by selecting the Settings item from the Preferences submenu of the File menu.
The features associated with the screen are described as follows.

Preference Settings...

Options___

Allow Duplicate HNode Hames ~
Allow Extended Desktop Display

v| Allow Undo OF DatasGraphic Changes

v| Automatically Open GDI Window W

Automatic Save Increment: |15 Minutes

Cancel ‘ Cloze

Data Items

Automatic Save Increment - Specifies the time increment between “automatic saves”. This item is only
enabled when the Automatically Save At Timed Increments preference settings option is selected.

Options -

Allow Duplicate Node Names - When selected, duplicate node Names may be used. When not
selected, entry of a duplicate (already existing) Node Name is not allowed and will generate an error
message.

Allow Extended Desktop Display - When selected, GASWorkS will support extended desktop
displays (i.e. dual monitors). Unselect this option if issues occur when going from using a dual
monitor setup to a single monitor setup.

Allow Undo Of Data/Graphic Changes - When selected, graphic and data changes may be reversed
(undone) using either the Undo Last Change command, the Undo icon, or the Restore command
button on the Mass Update Specifications screen. When not selected, changes must be manually
restored.

Automatically Open GDI Window - When selected, the GDI Window will automatically be
opened each time a model is opened or GASWorksS is opened. When not selected, the GDI window
must be manually opened using the View/Edit item from the Graphics menu.
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Automatically Save At Timed Increments - When selected, the model data in memory will be
saved to the associated disk files at User specified time-increments. Enter a time value in Minutes
in the Automatic Save Increment data field. When not selected, the model data must be manually
saved.

Display Reminders - When selected, additional messages will be displayed during certain
commands and routines providing reminders to the User. When not selected, the display of most
reminder messages will be suppressed.

Display Tooltips - When selected, the tooltips will be displayed when the cursor is rested (hovered)
over an icon, menu item, command button, data field, drop-down list, etc. When not selected, the
display of tooltip messages will be suppressed.

Ignore Facility Settings On Mass Update - When selected, all data features will be included in the
Mass Update routine. When not selected, only items associated with Facility Types set to “Active”
will be included in the Mass Update routine.

Save Model Before Solving - When selected, the current model data will be saved to the associated
disk files before the Solution routine is executed. When not selected, the model data must be
manually saved.

Use Command Alias File - When selected, command alias values will be read from the “Command
Alias File”, and can then be used by typing them on the GDI Command Line. See the Command
Alias File topic in the Miscellaneous section for more information.

Use Last Record For Default Values - When selected, the data values associated with the last
record of the same feature type will be used as the default data for a newly added feature type. When
not selected, the data values in the Default Data Values will ne used as the default data for a newly
added feature.

Command Buttons

Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves changes.

Notes & Considerations

® When the Automatically Save At Timed Increments preference settings option is selected, the User will be
prompted to save the model at time increments as specified by the value of the Automatic Save Increment
data field.

,35
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® The Preference Settings may be saved using the Save Current Settings item from the Preferences submenu
of the File menu.
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Print Settings Screen - Long Form

GASWorkS uses two Print Settings screens - a “long” form and a “short” form. The “Long Form”

is displayed when the Print icon is clicked from one of the “grid” style report screens. The Print  |[ ]
Settings screen allows various printer settings to be set by the User. The features associated with —
the screen are described as follows.

Print Settings...

Page Layout._.

Top Margin: 1.00 in Left Margin: [1.00 in

Bottom Margin: |1.00 in Right Margin: [1.00 in

Font Settings. ..

Mame: |Aria| Size: (10 points

Other Settings...
¥ Print Grid Lines Mumber Of Copies: [1
[~ Collate Pages
[+ Print Page Humbers

[~ Landscape Orientation

Printer._ ..

| =]

Printer Setup |

Cancel Print |

Displayed Items

Name - Displays the name of the font to be used when printing. Double-click in the data field to open the
Font settings screen. Select the desired font, then click the OK command button.

Size - Displays the size of the font to be used when printing. Double-click in the data field to open the Font
settings screen. Select the desired size, then click the OK command button. The size is expressed in printer

points. One printer point is approximately equal to 1/72 of an inch.

Status Bar - Displays the status of the Print routine.
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Data Items

Bottom Margin - Specifies the distance from the bottom of the paper page to the bottom of the printed page.
Collate Pages - When selected, the pages are collated when multiple copies are printed.

Landscape Orientation - When selected, landscape orientation will be used when printing. When
unselected, the pages will be printed using portrait orientation.

Left Margin - Specifies the distance from the left side of the paper page to the left side of the printed page.
Number Of Copies - Specifies the number of copies to be printed. Enter a value greater than zero (0).

Print Grid Lines - When selected, grid lines will be printed between the rows and columns. Printing the row
and column grid lines enhances the readability of the report, but their inclusion also increases the print time.

Print Page Numbers - When selected, the page numbers will be printed.
Printer - Specifies the print device to use.

Right Margin - Specifies the distance from the right side of the paper page to the right side of the printed
page.

Top Margin - Specifies the distance from the top of the paper page to the top of the printed page.

Command Buttons

Cancel - Closes the screen without printing.
Print - Proceeds with the Print routine.
Printer Setup - Displays the Print Setup screen. The contents of the screen will vary depending on the

selected print device and the operating system being used.

Notes & Considerations

® The Printer Dimensional Units for the margin values are set on the Other data tab on the Report Options
screen.

® Report contents may be printed to a “PDF” format if a third-party PDF printer is installed. To print to a
PDF file, select the PDF printer name from the Printer list, then click the Print command button.
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Print Settings Screen - Short Form

GASWorkS uses two Print Settings screens - a “long” form and a “short” form. The “Short Form” =]
is displayed when either the Print icon or the Print command button is clicked from one of the |[— ]
various data screens or one of the non-grid style report screens. The Print Settings screen allows
various printer settings to be set by the User. The features associated with the screen are described
as follows.

Print Settings...

Page Layout. ..
Top Margin: 1 in Left Margin: |1 in
Bottom Margin: |1 in Right Margin: |1 in

Font Settings. _.
Mame: |Aria| Size: |10 points

Other Settings. ..

Mumber Of Copies: |1 ‘ Collate Pages: |

Landzcape Orientation: [
Printer___

=]

Printer Setup |

Cancel Print |

Displayed Items

Name - Displays the name of the font to be used when printing. Double-click in the data field to open the
Font settings screen. Select the desired font, then click the OK command button.

Size - Displays the size of the font to be used when printing. Double-click in the data field to open the Font

settings screen. Select the desired size, then click the OK command button. The size is expressed in printer
points. One printer point is approximately equal to 1/72 of an inch.

Data Items

Bottom Margin - Specifies the distance from the bottom of the paper page to the bottom of the printed page.
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Collate Pages - When selected, the pages are collated when multiple copies are printed.

Landscape Orientation - When selected, landscape orientation will be used when printing. When
unselected, the pages will be printed using portrait orientation.

Left Margin - Specifies the distance from the left side of the paper page to the left side of the printed page.
Number Of Copies - Specifies the number of copies to be printed. Enter a value greater than zero (0).
Printer - Specifies the printer to use.

Right Margin - Specifies the distance from the right side of the paper page to the right side of the printed
page.

Top Margin - Specifies the distance from the top of the paper page to the top of the printed page.

Command Buttons

Cancel - Closes the screen without proceeding with the Print routine.
Print - Proceeds with the Print routine.
Printer Setup - Displays the Print Setup screen. The contents of the screen will vary depending on the

selected printer and the configuration of the computer system.

Notes & Considerations

® The Printer Dimensional Units for the margin values are set by on the Other data tab on the Report
Options screen.

® The contents may be printed to a “PDF” format if a third-party PDF printer is installed. To print to a PDF
file, select the PDF printer name from the Printer list, then click the Print command button.

=
,5 B3PE LLC Engineering & Software Services
Revision - 004, Copyright 2021, All Rights Reserved. 161




GASWorkS~ 10.1 Data Screens

Table Of Contents

Project Specifications Screen

The Project Specifications screen allows predefined settings to be used when creating a new model avoiding
the need to set them individually. The Project Specifications screen is accessed by selecting the New Project
item from the File menu. The features associated with the screen are described as follows.

Project Specifications...

Model Hame...
C:%Program Files [xB6]A\GASWorkS 100Files\MewProject hdr

Select From Existing Models

Template Model: |Defaull j
Preference Settings: |Defaull j
Default Settings: |Defaull ﬂ
Facility Settings: |Defaull j
PipefMain Sizing Table: |pipe j

[~ Attach A Linked Customer Attribute File: |
[~ Attach A Linked Node Attribute File: |
[~ Attach A Linked Pipe Attribute File: |

Led Led L

Background Image Files. ..

Select From Existing DXF Files

Cancel Open Save LContinue.__ |

Displayed Items

Background Image Files - Displays a list of the attached background image files to attach to the new model.
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Data Items

Attach A Linked Customer Attribute File - When selected, a linked customer attribute file will be attached
to the new model. The adjacent drop-down list will be enabled which contains the available Attribute
Database Definitions.

Attach A Linked Node Attribute File - When selected, a linked node attribute file will be attached to the
new model. The adjacent drop-down list will be enabled which contains the available Attribute Database
Definitions.

Attach A Linked Pipe Attribute File - When selected, a linked pipe attribute file will be attached to the
new model. The adjacent drop-down list will be enabled which contains the available Attribute Database
Definitions.

Default Settings - Specifies the default settings file to be associated with the new model. Either select a
previously saved file, or select “Default” to use the settings associated with the most previously open model.

Facility Settings - Specifies the facility settings file to be associated with the new model. Either select a
previously saved file, or select “Default” to use the currently saved “default” file.

Model Name - Specifies or displays the name for the new model. Either enter a model name, or click the
Select From Existing Models command button to select an existing model Filename.

Pipe/Main Sizing Table - Specifies the Pipe Property Table that will be used when calculating pipe sizes
during the Solution routine.

Preference Settings - Specifies the preference settings file to be associated with the new model. Either select
a previously saved file, or select “Default” to use the currently saved “default” file.

Template Model - Specifies the name of an existing model file to use as a “template” for creating the new
model. The dropdown list contains model files saved in the current Model Files path and in the Settings
subdirectory (subfolder) of the Support directory (folder). Either select a name from the list, or select
“Default” to use the currently saved “default” file.

Command Buttons

Cancel - Closes the screen without creating a new model or saving changes.
Continue - Closes the screen and creates a new model based on the specified settings.

Open - Opens a previously saved Project Specifications file (.gpj). When clicked, the File Selection screen
is displayed.
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Save - Saves the contents of the currently displayed specifications. When clicked, the File Selection screen
is displayed. Once saved, the file may be opened and used with other models.

Select From Existing DXF Files - Displays the File Selection screen to allow selection of an existing DXF
image file to be used as a background image.

Select From Existing Models - Displays the Model Selection screen to allow selection of an existing Model
Name.

Notes & Considerations

® To attach a background image file, click the Select From Existing DXF Files command button.

® Only DXF style background image files may be attached using the Project Specifications screen. To attach
other file types of background images, use the Background Image Settings screen after the model has been
created and opened.

® When one of the Attach A Linked Attribute File items are selected, an appropriately linked attribute file
(database) file will need be attached to the model. See the Attribute Data section in this manual for more
information on working with linked attribute files.

® A Default Settings file may be created using the Default Data Values screen. See the Default Data Values
Screen topic in the Data Screens section for more information on creating and saving a file. If the “Default”
item is selected for the Default Settings item, the values associated with the most recently open model will
be used.

® A Facility Settings file may be created using the Facility Settings screen. See the Facility Settings Screen
topic in the Data Screens section for more information on creating and saving a file. If the “Default” item
is selected for the Facility Settings item, the values associated with the most recently open model will be
used.

® A Preference Settings file may be created using the Save Current Settings item from the Preferences
submenu of the File menu. If the “Default” item is selected for the Preference Settings item, the values
associated with the most recently open model will be used. The items associated with the Preference Settings
include, the Path Settings, Property Table assignments, and preference options.
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Property Table Selection Screen

The various Property Tables used by GASWorkS may be set using the Property Table Selection screen. The
Property Table Selection screen is accessed by selecting the Property Tables item from the Preferences
submenu of the File menu. The features associated with the screen are described as follows.

Property Table Selection...

Curmrent Property Table Path. ..
C:\Program Files [xB6]\GASWorkS 10APropertiesk

Change Path

Select Desired Property Tables. .

Pipe: |pipe j
Regulator: |legulatur ﬂ
Compressor: |-::Dmpressur ﬂ
Yalve: |valve ﬂ
well: well ~]
Fittings: |litting ﬂ

L

Pipe Sizing Group: |pipe_size_gruup

Cancel | Close ‘

Displayed Items

Current Property Table Path - Displays the current location (path) of the Property Table files. The path
may be changed by clicking the Change Path Setting command button or by double-clicking on the current
path label.

Data Items

Compressor - Specifies the current Compressor Property Table to be used for the compressor values.

Fittings - Specifies the current Fittings Property Table to be used for the fitting values.
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Pipe - Specifies the current Pipe Property Table to be used for the pipe values.

Pipe Sizing Group - Specifies the Pipe Sizing Group definitions to be used in the Pipe Property Table.
Regulator - Specifies the current Regulator Property Table to be used for the regulator values.

Valve - Specifies the current Valve Property Table to be used for the valve values.

Well - Specifies the current Well Property Table to be used for the well values.

Command Buttons

Cancel - Closes the screen without saving changes.

Change Path - Displays the Path Settings screen to allow the path (location) to be selected/set for each of
the Property Tables.

Close - Closes the screen and saves changes.

Notes & Considerations

® Only Property Tables contained in the current Property Table path (location) are displayed in the
associated drop-down lists.

® When moving a model from one machine to another, the Property Tables may not be valid on the new
machine, and may not contain the same information as the previous Property Tables. When moving a model
to another machine it is recommended that the model is first bundled using the Bundle A Model item from
the Bundle submenu of the File menu, selecting the Include Assigned Property Tables option. Move the
bundled file and unbundle it using the Unbundle A Model item from the Bundle submenu of the File menu -
this will allow both the model and the Property Tables to be moved together.
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Query Specifications Screen

and the various Flag Item routines allow the selection of data features based on a User specified
selection criteria. These selection sets are created using the Query Specifications screen. The
features associated with the screen are described as follows.

The Make Selection Set routine found in the various Data Reports, the Color-By-Query routine, @

Query Specifications..,
Find Records Where._ ..
Where_ ls._. To

Pipe Color ﬂ ﬂ |D efault ﬂ

Saved Specifications._ ..

Save Current 5pecification | Delete Dizplayed Specification |

Perform Query | Cloze ‘

Data Items

Is - Specifies the search operator to be used during the Query Selection. The search operator specifies the
relation between the Where and To values.

Saved Specifications - Specifies a previously saved Query Specification to use for the current specification.

To - Specifies the value to be used as the check value during the Query Selection. The characteristics of this
item will change depending on the selected Where item.

Where - Specifies which data item is to be used as the search item during the Query Selection.

Command Buttons

Close - Closes the screen.

Delete Displayed Specification - Deletes the currently displayed specification in the Saved Specifications
list.
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Perform Query - Performs the query selection.

Save Current Specification - Saves the currently displayed specification in the Find Records Where data
fields.

Notes & Considerations

® When creating a selection set in a report, the current selection set may be cleared by clicking
the Reset Selection Set icon.

® Sece the Query Features topic in the Miscellaneous section for the meanings of the search
operators.
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Quick Pipe Sizing Specification Screen

Sizing “tasks” may be combined into a sequence of tasks using the Quick Pipe Sizing Specification. The
specification if manipulated using the Quick Pipe Sizing Specification screen. The screen is accessed by
selecting the Quick Size Specification item from the Edit menu. The features of the screen are described as
follows.

Cuuick Pipe Sizing Specification...
] o =] =
=M S Y —E
Sequence |Facility Type |5izing M ethod Minimum Pr
1 UnS5pecified Flow-Pressure Drop Processing 10.00
4 | 3
Run Individual Steps | Run All Steps |
Cancel | Close |

Displayed Items

Sequence - Displays the order in which the Facility Types will be processed (sized). For example, if the
value of this item is “3”, the pipes associated with the associated Facility Type will be sized third in the Pipe
Sizing routine. Use the Move Sequence icon to change the order.

Data Items

Facility Type - Specifies the Facility Type for the associated sequence. The contents of the list represent the
Facility Types associated with the current model.

Minimum Pressure - Specifies the minimum pressure value for the associated sequence.

Pressure Units - Specifies the dimensional units to be used for the minimum pressure value.
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Sizing Method - Specifies the sizing/processing method for the associated sequence.

@ E W % @m0

Add Sequence - Adds a new sequence to the end of the specification.

Delete Sequence - Deletes the currently selected (highlighted) sequence.

Insert Sequence - Inserts a new sequence just before the currently selected (highlighted)
sequence.

Maximize Screen Size - Increases the Quick Pipe Sizing Specification screen’s size to fill the
GASWorkS display.

Move Sequence - Moves the currently selected (highlighted) sequence to a new location in the
specification. When clicked, a message will be displayed to select the new location. Click the OK
command button to clear the message, then select the desired location.

Open - Opens a previously saved Quick Pipe Sizing Specification file (.qwk). When clicked, the

File Selection screen is displayed.

Print - Prints the contents of the specification. When clicked, the Print Settings screen is
displayed.

Reset Screen Size - Sets the Quick Pipe Sizing Specification screen’s size to its “normal”
dimensions and position.

Save - Saves the contents of the currently displayed specification. When clicked, the File
Selection screen is displayed. Once saved, the file may be opened and used with other models.
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Command Buttons

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.

Run All Steps - Executes all of the sizing tasks listed in the specification in the order of their sequence
number.

Run Individual Steps - Executes only the currently selected (highlighted) sizing task.

Notes & Considerations

® The Quick Pipe Sizing Specification may be used to pre-define sizing specifications based on Facility
Type. If a particular set of sizing options, values, and settings are commonly used to size pipes associated
with a specific Facility Type, those values may be entered into the specification, saved, and used with the
Quick Size command to quickly solve and size the matching pipes in the current model. Multiple facilities
may be included in the specification, however the model does not need to contain all of the included Facility
Types. Different specifications may be created for different model/project types. The specification may be
particularly useful when sizing multiple pressure tier systems. For example, the first task/sequence might be
to size the low pressure portion of the system, then the medium pressure portion, then the high pressure
portion.
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The number of decimal places displayed by the various report, data screens, and GDI Window along with
other settings, may be set using the Report Options screen. The screen is accessed by selecting the Report
Options item from the Report menu. The features associated with the screen are described as follows.

Decimals Tab

Report Opticns..,

Decimals

Other

Mumber OF Decimals To Dizplay. ..

Item...

Setting...

Angle/Rotation ¥alues

Coordinate Yalues

Customer Load Yalues

Diameter ¥alues

Efficiency Yalues

Elevation ¥alues

Heat Content ¥alues

Length Yalues

MHode Load Yalues

Mode Pressure Yalues

Pipe Flow ¥alues

(LR T B LN B — B — B — R L B TE R Y Ry - I ] — |

Save Az Default

Cancel

Cloze |

Data Items

Number Of Decimals To Display - Specifies the number of decimal places to display for the associated data
Item (parameter) type.
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Other Tab

Report Options...

Decimals T DOther

D ata Report Options...
Sort All Reportz When Opened: + Never  Ascending { Descending

Pressure Drop Per: (100 |Feel ﬂ

Printing Options._.

Printer Dimensional Units: * Inches  Millimeters

Solution Log - Exceptions Report Options. ..

Indicate Which Options To Include In Exceptions Report.._.

Comprezzors With High Inlet Pressure ~
Large Pressure Hodes
Low Flow FPipes
Megative Prezzure Nodes
v Mode Errors Greater Than Convergence Tolerance
Regulators With Back Flow W

Save As Default |

Cancel Cloze |

Data Items

Indicate Which Options To Include In Exceptions Report - When selected, the associated option will be
included in the Exceptions Report.

Compressors With High Inlet Pressure - Compressors with inlet pressures greater than the set
pressure are reported.

Large Pressure Nodes - Nodes with unusually high pressure values are reported.
Low Flow Pipes - Pipes with flows less than the Convergence Tolerance are reported.
Negative Pressure Nodes - Nodes with pressure values less than zero (0) are reported.

Node Errors Greater Than Convergence Tolerance - Nodes with a flow error greater than the
Convergence Tolerance are reported.
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Regulators With Back Flow - Regulators with flow towards the outlet node (away from the inlet
node) are reported.

Regulators With Low Inlet Pressure - Regulators with inlet pressure values below their set
pressure are reported.

Regulators With Low Outlet Pressure - Regulators with outlet pressure values below their set
pressure are reported.

Zero Flow Pipes - Pipes with zero (no) flow are reported.
Zero Pressure Nodes - Nodes with zero (0) pressure value are reported.

Pressure Drop Per - Specifies the unit value to be used to calculate the Pressure Drop Per Unit Length
values.

Printer Dimensional Units - Specifies the dimensional units to apply to the print settings (used for the
margins).

Sort All Reports When Opened - Indicates whether the Customer Data, Node Data, or Pipe Data Report
are sorted when they are opened and how.

Command Buttons

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.
Save As Default - Saves the current report settings as the default report options to be used when creating

a new model.

Notes & Considerations

® The value of the Number Of Decimals To Display is used to indicate the number of digits displayed to the
right of the decimal identifier (point) when displaying the associated data value.

® The Pressure Drop Per Unit Length value is calculated by dividing the product of the linear pressure drop
and the length of the pipe segment by the Pressure Drop Per (Length) value.
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® The Exception Report Options only apply when the Include Exceptions In Solution Log option is selected
in the Solution Data options. The Exceptions Report may be used to troubleshoot a model that is not
converging or as a quick double-check for model validity.

2
,5 B3PE LLC Engineering & Software Services
Revision - 004, Copyright 2021, All Rights Reserved. 175




GASWorkS~ 10.1 Data Screens

Table Of Contents

Scale Factor Calculation Screen

When a “raster” format file type is used as a background image file and the Calculate Scale Factor command
button on the Background Image Settings screen is clicked, the Scale Factor Calculation screen is displayed.
The features associated with the screen are described as follows.

Scale Factor Calculation...

Image Reszolution: |1.Uﬂ |Pixels Per Inch [DPI] j
Image Scale: 1= |1.|]|] |Inch = Feet ﬂ
Scale Factor: |1.|]|]|]

Close ‘ Apply ‘

Data Items

Image Resolution - Specifies the resolution of the image contained in the selected background image file.
Generally, the resolution is expressed in the number of pixels (dots) per inch.

Image Scale - Specifies the scale of the image contained in the selected background image file.

Calculated Items

Scale Factor - Displays the calculated Scale Factor value based on the image resolution and scale values.

Command Buttons

Apply - Closes the screen and applies the calculated Scale Factor value to the background image file on the
Background Image Settings screen.

Close - Closes the screen without applying the calculated Scale Factor value.
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Notes & Considerations

® For bitmap or raster style images, the Scale Factor (Coordinate-To-Pixel Ratio) establishes the “scale” for
the image. Bitmap and raster style images are made up of small “dots” called pixels. The scale tells the GDI
how many Coordinates units are represented by one pixel in the file - the width of the pixel in the
Coordinates units. For example, the number of Feet-Per-Pixel. To determine this value, divide the original
drawing or map scale by the image resolution in dots per inch (dots per centimetre). For example, the
Coordinate-To-Pixel Ratio for a 1 Inch =2000 Feet map scanned at 400 dots-per-inch would be: 2000 + 400
=5 Feet-per-pixel.

® Bitmap and raster style images include files ending with the following extensions:

* .bmp

* Jpg

« .pdf - PDF format files are not actually raster type files, however they are handled as raster type
files in GASWorkS.

o tif
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Solution Data Screen

GASWorkS provides access to the various solution options and data values through the Solution

Data screen. To access the screen, either click the Solve icon from the lower-right corner of the %
GDI Window, select the Solve Single Model item from the Analysis menu, or use the Solve Model
command. The features of the screen are described as follows.

Solution Data Tab

Solution Data...

Solution Data T Pipe 5Sizing Control T Other Settings T Model Hotes

Solution Parameters. ..

Deszign Factor: 2 Calculate M aximum Iterations: |30
Convergence Tolerance: ||l1 |Hclh j Divergence Limit: 5

Solution Options. Calculation Methods.

Adjust Compressor Control Pressures Atmoszpheric Pressure:

Adjust Regulator Dutlet Pressures AGA

Calculate Gas Mixing

Calculate Temperature Yalues Compressibility: |"‘|":""’E=
v| Display Favorite Results List Upon Completion

Flag Large Error Node Upon Completion

Ignore Elevation Differences

Include Exceptions In Solution Log

M| Hezet Unknown Node Prezsures To Zero

Update Color Coding

Lol Led Lo

Diversity: | Hone

Cancel ‘ Cloze Solve

Data Items

Atmospheric Pressure - Specifies the atmospheric pressure method used to calculate the atmospheric
pressure value for the associated node elevation. The atmospheric pressure is used to convert gauge pressure
values to absolute pressure values as needed in the calculations. A description of the available methods may
be found in the Atmospheric Pressure Methods topic in the Appendix section.
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Compressibility - Specifies the compressibility method to be used in the solution. The Compressibility
Factor is used to compensate for the deviation of gas behavior from the ideal gas law. Generally, this
deviation may be ignored for systems operating at pressures less than 200 Psig. A description and discussion
of the available methods may be found in the Compressibility Methods topic in the Appendix section.

Convergence Tolerance - Specifies the maximum acceptable node error for the solution. See the following
Notes & Considerations section for suggestions on an appropriate Convergence Tolerance.

Design Factor - Specifies a multiplication factor to be applied to the node loads during the solution. The
value is expressed as a decimal. See the following Notes & Considerations section for additional details.

Divergence Limit - Specifies the value of the maximum number of consecutive diverging or same value
iterations allowed during the solution. If the number is exceeded, the solution will be terminated. See the
following Notes & Considerations section for additional details.

Diversity - Specifies the diversity method to be used to calculate the IGE Diversity calculations during the
solution. When a method is selected, this will cause the load associated with “non-diversified” customers
to be applied to the downstream node of the supplying main, regardless of the node application setting. More
information may be found in the Diversified Customer Loads topic in the Appendix section.

Maximum Iterations - Specifies the maximum permissible number of iterations the solution can make
before ending. See the following Notes & Considerations section for additional details.

Solution Options -

Adjust Compressor Control Pressures - When selected, the compressor control pressures will be
adjusted after/between solution attempts.

Adjust Regulator Outlet Pressures - When selected, the regulator outlet pressures will be adjusted
after/between solution attempts..

Calculate Gas Mixing - When selected, the gas property values will be calculated based on the
mixed flow rates.

Calculate Temperature Values - When selected, the average temperature will be calculated for
each node where the Temperature Known item is set to “No”.

Display Favorite Results List Upon Completion - When selected, the Favorite Results List in the
Data Panel will be displayed upon completion of the Solution routine.

Flag Large Error Node Upon Completion - When selected, a flag symbol will be placed at the
location of the node with the largest error. The flag will be placed after the solution routine is
finished.
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Ignore Elevation Differences - When selected, the node elevation differences will be ignored when
calculating the node “hydrostatic” pressure values, however the correct atmospheric pressure values
will be used in the Absolute Pressure calculation.

Include Exceptions In Solution Log- When selected, a check for unusual conditions will be
performed when the data is being saved after the solution. Any issues that are found, are referred to
as “exceptions” and are included in the Solution Log. The exceptions included in the check are
controlled by the Report Options screen.

Reset Unknown Node Pressures To Zero - When selected, the “unknown” pressure values will be
set to zero (0) before solving the model. This option is advised when using the Calculate Pipe Sizes
(Optimize) option or diversity options.

Update Color Coding - When selected, the color-by-range color coding will be updated upon
completion of the solution. The current range and color criteria is used to update the GDI Image.
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Pipe Sizing Control Tab

See the following Notes & Considerations section or the Pipe Sizing (Optimization) Features topic in the
Miscellaneous section for additional information on the Pipe Sizing routine and the affect of the various data
items and options on the sizing process.

Solution Data...

Solution Data T Pipe Sizing Control T Other Settings T Model Hotes
Limit/Check Values.__.
Condition Nodes: | j Condition Pressure: ’7 Psi
System Preszsures: |1 1} |Psi j
Pregsure Yalues Are: % Minimums " M aximums

M aximum Yelocity: 40 Feet/zec
Other Settings...

Paszs Limit: 50 Humber Of Paszes

Path Processing: |F|DW'PT333U'E Drop Processing ﬂ Optimize By: f+ Size " Cost
Facility Type: |AII Facility Types j Reset Diameters To Minimum Size |v
Pipe Sizing Table: |pipe j

Solve & Calculate Pipe Sizes ‘

Cancel Cloze Solve |

Data Items

Condition Nodes - Specifies up to ten “condition” node names. If no condition nodes are identified, only
the overall system pressure will be used.

Condition Pressure - Specifies the required pressure value for the associated condition node location.
Facility Type - Specifies the Facility Type to include in the Pipe Sizing routine.

Maximum Velocity - Specifies the maximum allowable velocity value.

Optimize By - Indicates whether the pipe size or pipe cost will be used as the selection basis during the Pipe

Sizing routine. When the Size option is selected, smaller pipe sizes will be used before larger pipe sizes.
When the Cost option is selected, lower cost pipes will be used before higher cost pipes.

=
,5 B3PE LLC Engineering & Software Services
Revision - 004, Copyright 2021, All Rights Reserved. 181




GASWorkS~ 10.1 Data Screens

Table Of Contents

Pass Limit - Specifies the number of “passes” or attempts that the Pipe Sizing routine is allowed to execute.
If the limit is reached before the routine is complete, the routine will be stopped and the current pipe sizes
will be saved. To restart the Pipe Sizing routine after the Pass Limit has been reached, re-solve the model
remembering to unselect the Reset Diameters To Minimum Size option.

Path Processing - Specifies the type of path processing method that will be used during the Pipe Sizing
routine. During the Pipe Sizing routine, the lowest pressure node is found (when Pressure Values Are
“Minimums” is selected). Then a path is determined along the pipes feeding into the low pressure node, back
to the source of supply. The size of the pipes along this path are increased. The Path Processing item
specifies how the path is created and how the pipes are selected for a size increase.

Pipe Sizing Table - Specifies the Pipe Property Table to be used when calculating pipe sizes by the Pipe
Sizing routine.

Pressure Values Are - Indicates whether the check (Condition and System) pressure values represent
maximum or minimum values.

Reset Diameters To Minimum Size - When selected, the size for all of the pipes where the Allow Sizing
option is set to “Yes” will be set to the minimum value before starting the Pipe Sizing routine.

System Pressures - Specifies the value of the overall system pressure requirement.
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Other Settings Tab

Solution Data...

Solution Data T Pipe Sizing Control T Other Settings T Model Hotes

Basis Of Yolume Measurement...

Base Pressure: [14.73 | Psi -] Base Temperature: |60 Fahrenheit

Advanced Solution Parameters...

Row Reduction Limit: 0 Pressure Drop Path Factor: |1 =
Beszet
Lower Dampening Factor: |0 Length Path Factor: |1

Heat Exchange Parameters. ..

Calculation Method: |Nune j Include Joule-Thomson Effect For Pipes: |

Cancel Cloze Solve

Data Items

Ambient Temperature - Specifies the temperature at the outside of the “influence zone”. This item is only
displayed when the Convection & Conduction or Overall Transfer Coefficient Calculation Methods are
selected.

Base Pressure - Specifies the pressure basis for the volume measurement.

Base Temperature - Specifies the temperature basis for the volume measurement.

Calculation Method - Specifies the method to be used to calculate the heat exchange between the flowing
gas and the surrounding environment. The available methods are described in the following Nofes &
Considerations section.

Diameter Path Factor - Specifies the diameter factor (exponent) to use when an applicable Path Processing

method is used during the Pipe Sizing routine. This item will only be enabled when the Flow Processing
Only Path Processing method is selected.
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Environment Conductivity - Specifies the thermal conductivity of the environment within the influence
zone. This item is only displayed when the Convection & Conduction Calculation Method is selected.

Include Joule-Thomson Effect For Pipes - When selected, the Joule-Thomson effect (cooling due to
pressure drop) will be estimated for each pipe segment.

Influence Factor - Specifies the influence zone size of the environment. The pipe outside diameter is
multiplied by the specified factor to determine the thickness of the influence zone thickness of the
environment surrounding the pipe. This item is only displayed when the Convection & Conduction
Calculation Method is selected.

Insulation Conductivity - Specifies the thermal conductivity of the insulating material. If no insulation is
present, enter a value of zero (0). This item is only displayed when the Convection & Conduction Calculation
Method is selected.

Insulation Thickness - Specifies the thickness of any insulation applied to the exterior of the pipe. If no
insulation is present, enter a value of zero (0). This item is only displayed when the Convection &
Conduction Calculation Method is selected.

Length Path Factor - Specifies the length factor (exponent) to use when an applicable Path Processing
method is used during the Pipe Sizing routine. This item will only be enabled when the Flow-Pressure Drop
Processing, Flow Processing Only, or the Sum Of Pressure Loss Path Processing methods are selected.

Lower Dampening Factor - Specifies the lower dampening factor for the solution. The influence of the
lower dampening factor is described in the following Notes & Considerations section.

Pipe Conductivity - Specifies the thermal conductivity of the pipe material. This item is only displayed
when the Convection & Conduction Calculation Method is selected.

Pressure Drop Path Factor - Specifies the pressure drop factor (exponent) to use when an applicable Path
Processing method is used during the Pipe Sizing routine. This item will only be enabled when the Flow-
Pressure Drop Processing or the Sum Of Pressure Loss Path Processing methods are selected.

Row Reduction Limit - Specifies the row reduction limit for the solution. The influence of the row
reduction limit is described in the following Notes & Considerations section.

Transfer Coefficient - Specifies the value of the overall heat transfer coefficient. This itemis only displayed
when the Overall Transfer Coefficient Calculation Method is selected.

Wall Temperature - Specifies the temperature of the pipe wall. This item is only displayed when the
Convection Only Calculation Method is selected.
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Model Notes Tab
Solution Data...
Solution Data T Pipe 5izing Control T Other Settings T Model Notes

Motes._ .

1272472019 - Model Projected From Plane Coordinates To Longitude &% Latitude.

Projection File: C:\Program Files\GASWorkS 10\supportiprojectionsi\NAD 1983 5tatePlane Colorado
Central FIPS 0502 [US Feet].pr

Projection: Lambert_Conformal_Conic

Cancel Cloze Solve

Data Items

Notes - Displays the Model Notes.

Command Buttons

Calculate - Allows calculation of the Design Factor. When selected the Design Factor Calculation screen
is displayed. Enter the desired values, click the Calculate command button, then click the Apply command
button to apply the Calculated Design Factor. This item is displayed on the Solution Data tab.

Cancel - Closes the screen without proceeding with the Solution routine and without saving changes.

Close - Closes the screen and saves changes, without executing the Solution routine.

Reset - Resets the default Advanced Solution Parameter values. This command button is displayed on the
Reset data tab.

Solve - Saves the settings and executes the Solution routine.
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Solve & Calculate Pipe Sizes - Executes the Solution routine and calculates the pipe sizes. The command
button serves the same function as selecting the Calculate Pipe Sizes (Optimize) solution option, then
clicking the Solve command button. This command button is displayed on the Pipe Sizing Control data tab.

Notes & Considerations

® The Design Factor is used to adjust the node loads in the model. Depending on the individual node
settings, the “known” node loads are multiplied by the Design Factor to calculate the load values to be used
in the analysis. The Design Factor is expressed as a decimal. For example, to enter a Design Factor
representing fifty percent, type 0.5. The Design Factor is only applied to nodes where the Adjust Base Load
node option is set to “Yes”. The Design Factor is not applied to the External Load values, unless the Adjust
External Load node option and the Adjust Load customer option are set to “Yes”.

® The Maximum Iteration value limits the number of times that the Solution routine will attempt to reach
a solution within the specified Convergence Tolerance. The number of iterations required to reach a solution
varies with each model, and with the value of the Convergence Tolerance. If a solution is not reached within
the specified number of iterations, a message will be displayed stating that the solution has not been
completed. The solution may be rerun and the maximum number of iterations increased as required.
However, generally if a model is not able to solve in less than thirty iterations, the model likely contains data
errors that are preventing the solution from being achieved. Run the Data Check routine, and /or check the
model configuration around the node or nodes with the highest flow error values.

® The Convergence Tolerance represents the maximum allowable imbalance of the solution results. If a
solution is attained for a Convergence Tolerance of 0.01 Mcfh, it may be said that the solution results are
within +/- 0.01 Mcfh of the exact solution for that particular model. The value of the Convergence Tolerance
is generally determined based on the magnitude of the total expected system flows. The acceptable
Convergence Tolerance for a particular model depends on the intended use of the results. For very “tight”
results use a Convergence Tolerance of about one hundredth of one percent (one-ten-thousandth) of the total
expected system flow. For example, if the total system flow is expected to be of the magnitude of 100 Mcth
the Convergence Tolerance might be 0.01 Mcfh. For less accurate results, use a Convergence Tolerance of
about one percent of the total expected system flow. See the Convergence Problems topic in the
Miscellaneous section for suggestions on handling various convergence problems and solution errors.

® The Divergence Limit identifies the number of consecutive diverging or equivalent error iterations that
will be allowed before the Solution routine is terminated. During the Solution routine, node errors normally
continue to decrease as the solution progresses. Sometimes when solving a model, the node errors might
increase for a few iterations, then begin to decrease again. However, when trying to solve a model containing
a data or configuration error, or when a model is “running-out-of-gas”, the node errors may continue to
increase or stay the same, never allowing the solution to reach a state of balance. The Divergence Limit
causes the Solution routine to be automatically terminated when this occurs.

® The base pressure and base temperature are used to establish the basis for a “standard” volume (for
example, a standard cubic foot or cubic metre) of gas as used by the current model.
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® The Row Reduction Limit is used to modify the calculated adjustment for large node errors. The
modification will be applied to errors greater than the Row Reduction Limit multiplied by the Convergence
Tolerance. The Row Reduction Limit generally does not influence the quality of the solution. However, it
can prevent a solution from being reached if improperly chosen. Enter a large number (for example 10000)
to disable the Row Reduction Limit. Generally, the factor should be entered as zero (0).

® The Lower Dampening Factor is used to stop adjustment of certain node pressures. Often several nodes
in the model are balanced, while only a few nodes require further adjustment. The nodes where the pressure
adjustment value is less than the current pressure value multiplied by the Lower Dampening Factor will not
be adjusted any further. The Lower Dampening Factor can influence the quality of the solution. However,
if the factor is properly chosen, it can decrease the number of iterations required to reach a solution, with
only a negligible influence upon the overall quality of the solution. Generally, the Lower Dampening Factor
should be set to zero (0).

® The Heat Exchange Parameters Calculation Methods are described as follows:

Convection & Conduction - This method is useful when considering a buried pipe that may or may
not have insulating material applied to it. Convection between the gas stream and the pipe wall,
conduction through the pipe wall, insulation, and soil (environment) are considered. An
environmental influence zone may be specified using the Influence Factor. If no insulation is present
the insulation thickness may be set to zero (0).

Convection Only - This method only considers convection heat transfer between the gas stream and
the pipe wall. This method would be useful when the pipe is exposed to the atmosphere, submerged
in a liquid, or buried in soil with a high transfer rate - locations where the surrounding environment
can act as a large heat sink and can essentially maintain a constant wall temperature on the pipe.

Overall Transfer Coefficient - This method is useful when the value of the overall heat transfer
coefficient is known or may be estimated. The heat transfer is based on the specified coefficient.

® During the Pipe Sizing routine, certain pressure requirements are checked to determine if the pipes are
properly sized. These pressure requirements may be set in two manners. A pressure may be specified at a
particular location in the system (referred to as a condition node), and an overall pressure may be set for the
entire model. See the Pipe Sizing (Optimization) Features topic in the Miscellaneous section for additional
information on using the Pipe Sizing routine and the affect of the various data items and options have on the
sizing process.

® To enter or revise the Model Notes, type them directly into the edit box. The Model Notes may consist of
a description of the model and analysis. Special characters may be used. See the Mode! Notes topic in the
Data Screens section for additional details.

® If the Adjust Regulator Outlet Pressures option is selected, the outlet pressure of any included regulator
will be checked against the entered set pressure value and the following actions taken.
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* [f the pressure is set as unknown for the outlet node, and the calculated pressure for the outlet node
is higher than the set pressure, the regulator will be “turned off”, and the solution routine will be
repeated.

* [f the pressure is set as unknown for the outlet node, and the calculated pressure for the inlet node
is lower than the set pressure plus the associated minimum differential pressure, the outlet pressure
is calculated based on the associated valve factor and minimum differential pressure values, and
solution routine will be repeated.

» [f the pressure is set as unknown for the outlet node, and the calculated pressure for the inlet node
is greater than the set pressure plus the associated minimum differential, the outlet pressure of the
regulator will be calculated based on the associated droop value, and the solution routine will be
repeated.

» If the pressure is set as known for the outlet node no action is taken.
* In the above actions, when the outlet pressure is calculated, the solution routine will be repeated

until the change in the outlet pressure between subsequent solutions in less than a preset tolerance
or the number of iterations exceeds the Maximum Iteration value.

® [fthe Adjust Compressor Control Pressures option is selected, the pressure of the “control” node of any
included compressor will be checked against the entered set pressure value and the following actions taken.

,35

» If the control node is downstream (outlet) and the pressure is set as unknown for the outlet node,
and the calculated pressure for the outlet node is higher than the set pressure, the compressor will
be “turned off”, and the solution routine will be repeated.

» If the control node is downstream (outlet) and the pressure is set as unknown for the outlet node,
and the calculated pressure for the inlet node is higher than the set pressure, the compressor will be
“bypassed”, and the solution routine will be repeated.

» If the control node is upstream (inlet) and the pressure is set as unknown for the inlet node, and the
calculated pressure for the outlet node is lower than the set pressure, the compressor will be “turn
off”, and the solution routine will be repeated, however an unsolvable condition may be created.

» I[f the control node is upstream (inlet) and the pressure is set as unknown for the inlet node, and the
calculated pressure for the inlet node is lower than the set pressure, the compressor will be “turn
off”, and the solution routine will be repeated, however an unsolvable condition may be created.

* If the pressure is set as known for the control node no action is taken.

* In the above actions, when the pressure is calculated, the solution routine will be repeated until the

change in the calculated pressure between subsequent solutions in less than a preset tolerance or the
number of iterations exceeds the Maximum Iteration value.
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Solution Log

During the solution of a model, GASWorkS will display the Solution Log. The Solution Log allows control
of the solution and viewing of the solution’s progress. The Solution Log is displayed when a solution of the
model is executed. The features associated with the screen are described as follows.

Solution Leg...

Model: C-\Program Files [xB6A\GASWorkS 10%Files\demod19_II...
Prepanng Data For Solution. _.
Performing First Iteration._.
Iteration 1: Max Ermror = 6.532 Mcfh - 4 Nodes Unbalanced
Iteration 2: Max Error = 2_.428 Mcfh - 4 Modes Unbalanced
Iteration 3: Max Error = 1.041 Mcfh - 4 Nodes Unbalanced
Iteration 4: Max Error = 0.480 Mcfh - 2 Hodes Unbalanced
Iteration 5. Max Error = 0.230 Mcfh - 2 Hodes Unbalanced
Iteration 6: Max Error = 0.113 Mcfh - 1 Modes Unbalanced
Iteration ¥: Max Error = 0.000 Mcfh
Average lteration Time = 0.00 Seconds
Saring Results__.
Solution Complete.

|Eapacil_l,l: 1000 Modes  Licenszed To: B3PE - LMA

Cloze

Displayed Items

GASWorkS Information - Displays the node capacity and the name of the entity that the GASWorkS
software is licensed to.

Solution Log - Displays the Solution Log. To browse the display, adjust the vertical scroll bar adjacent to
the display area.
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Command Buttons

Cancel - Terminates the Solution routine. However, depending on the current solution activities, the process
may not terminate immediately. This button is disabled after the solution is complete.

Close - Closes the Solution Log. This button is disabled during the Solution routine.

Notes & Considerations

® [f'the Include Exceptions In Solution Log solution option is selected prior to the execution of the Solution
routine, any exceptions found while saving the solution results will be reported at the end of the Solution
Log. If there are more exceptions than may be contained in the Solution Log, the reported exceptions will
be truncated. An end of section message will be reported at the end of the exceptions section.

® The contents of the Solution Log may be printed by selecting the Solution Log item from the Report menu.
® [f exceptions are listed, and the GDI is open, close the Solution Log, then open the screen again using the

Solution Log item from the Report menu. Then click on an exception item to flag and zoom to the location
of the associated feature in the model.
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Solution Log Report

During the solution, a log of the solution activities will be created. The log is maintained in a report known
as the Solution Log Report. The Solution Log Report may be viewed or printed by selecting the Solution Log
item from the Report menu. The features associated with the report are described as follows.

=l Solution Log Report - C:\Program Files (x86)\GASWorkS 10\Files\demo419 JI.... | = | =

=] ,E] bl
—} TXT
Model: C:A\Program Files [x86)A\GASWorkS 10VFileshdemod19 11, -

Prepanng Data For Solution. ..

Performing First Iteration. ..

Iteration 1: Max Ermor = 6.532 Mcth - 4 Hodes Unbalanced
Iteration 2: Max Ermmor = 2.428 Mcih - 4 Hodes Unbalanced
Iteration 3: Max Error = 1.041 Mcth - 4 Hodes Unbalanced
Iteration 4: Max Ermror = 0.480 Mcth - 2 Hodes Unbalanced
Iteration 5: Max Ermror = 0.230 Mcth - 2 Hodes Unbalanced
Iteration 6: Max Ermor = 0.113 Mcth - 1 Hodes Unbalanced 1
Iteration 7: Max Error = 0.000 Mcth

Average Iteration Time = 0.00 Seconds

Saving Results. ..

Solution Complete.

Closze

Displayed Items

Solution Log Report - Displays the Solution Log Report. To browse the display, adjust the vertical scroll
bar adjacent to the display area.

Copy To Clipboard - Copies the contents of the Solution Log Report to the Windows Clipboard.
Once copied, the contents may be pasted into another application.

Maximize Screen Size - Increases the Solution Log Report’s size to fill the GASWorksS display.
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=] Print - Prints the contents of the Solution Log Report. When clicked, the Print Settings screen
[~ }| is displayed.

Reset Screen Size - Sets the Solution Log Report’s size to its “normal” dimensions and position.

[ Save To Text File - Saves the data of the Solution Log Report contents to a text file (.txt). When
TYT clicked, the File Selection screen is displayed.

Command Buttons

Close - Closes the Solution Log Report.

Notes & Considerations

® [f'the Include Exceptions In Solution Log solution option is selected prior to the execution of the solution,
any exceptions found while saving the solution results will be reported at the end of the Solution Log. If there
are more exceptions than may be contained in the log, the reported exceptions will be truncated. An end of
section message will be reported at the end of the exceptions section.

® [f exceptions are reported, and the GDI is open, click on an item in the report to flag and zoom to the
associated feature. When selected the item will be displayed in “red” text until the report is closed.

=
,3 B3PE LLC Engineering & Software Services
192 Revision - 004, Copyright 2021, All Rights Reserved.




GASWorkS~ 10.1 Data Screens

Table Of Contents

Sort Specification Screen

The Sort routine provides a variety of sorting options for reordering the pipes and nodes in the model data
files. The sort features are controlled through the Sort Specification screen. The screen is accessed by
selecting the Sort Model item from the Miscellaneous submenu of the Utilities menu. The features associated
with the screen are described as follows.

Sort Specification...

Data Items

Method - Specifies how to sort the pipes and nodes in the model data files.

Command Buttons

Close - Closes the screen.

Sort - Sorts the node and pipes in the model data by the selected method.

Notes & Considerations

® To save the sorted model order, save the model.
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System Summary Report

The System Summary Report includes several specialized report sections that may be selected by the User.
These sections may include a summary of the regulator and compressor data, customer, node, and pipe data,
supply nodes, system components, and other items. The User may indicate which sections to include in the
report using the System Summary Options screen. The report is accessed by selecting the System Summary
item from the Report menu. The features associated with the report are described as follows.

=l System Summary Report - C:\Program Files (x86)\GASWorkS 10\Files\demod... E' =

=] ,E] b
— TXT
[Unless Otherwise Moted All Summaries Are OF Reportable Facility Types Only] i‘

Compresszor Data...

Model Contains Mo Compressors.

Customer Summary. _.

Total Customer Count: 32
Total Customer Unit Count: 32

Total Turned "0Off" Customers: 0
Total Customers Assigned To "From' Hode: 0

Total Customerz Assigned To "'To' Node: 0
Total Customers Assigned To "Both® Nodes: 32 ﬂ

Cloze

Displayed Items

System Summary Report - Displays the System Summary Report. To browse the display, adjust the vertical
scroll bar adjacent to the display area.

Icons

Clipboard. Once copied, the contents may be pasted into another application.

r@‘ Copy To Clipboard - Copies the contents of the System Summary Report to the Windows
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Maximize Screen Size - Increases the System Summary Report’s size to fill the GASWorkS
display.
=] Print - Prints the contents of the System Summary Report. When clicked, the Print Settings
[~ }| screen is displayed.
1
Reset Screen Size - Sets the System Summary Report’s size to its “normal” dimensions and
position.
[ Save To Text File - Saves the data of the System Summary Report contents to a text file (.txt).
THT When clicked, the File Selection screen is displayed.

Command Buttons

Close - Closes the System Summary Report.

Notes & Considerations

® The System Summary Options Screen topic in the Data Screen section provides additional information
about the System Summary Report contents.

® The dimensional units of certain displayed items are automatically set. The units for these items are
summarized in the following table:

Displayed Value Section Dimensional Units
Cost Pipe Summary None
Differential Pressure Regulator Data Set to the Diff P Units of the associated record

in the Regulator Property Table.

Fuel Usage Rate Compressor Data | Set to the Fuel Units of the associated record in
the Compressor Property Table.

Length Pipe Summary Set to the Length Units of the first reportable
pipe in the model.

=
,3 B3PE LLC Engineering & Software Services
Revision - 004, Copyright 2021, All Rights Reserved. 195




GASWorkS~ 10.1

Data Screens

® The Estimated Valve Coefficient

Table Of Contents
Displayed Value Section Dimensional Units
Minimum Differential Regulator Data Set to the Diff P Units of the associated record
Pressure in the Regulator Property Table.
Power Requirement Compressor Data | Set to the Power Units of the associated record

in the Compressor Property Table.

Total Flow In-To The
System

System Summary

Set to the Load Units of the first reportable

node in the model.

Total Flow Out-Of The
System

System Summary

Set to the Load Units of the first reportable

node in the model.

parameter:

calculated in the Regulator Data section represents the following

Equation Estimated Valve Coefficient
American C Factor - Regulator Constant
American AFV Cv - Valve Capacity Factor
Grove 900
ISA-75.01
Mokveld
Rockwell Fv Factor - Regulator Constant
Fisher Cg (Regulating) - Gas Sizing Coefficient
Mooney
Pietro Fiorentini
Universal
Equimeter K Factor - Regulator Constant
Itron
Grove 80 Cp - Wide Open Valve Factor
Table Not Calculated

B3PE LLC
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System Summary Options Screen

The System Summary Report includes several specialized report options. The User may indicate which
sections to include in the System Summary Report. The System Summary Options screen is accessed by
selecting the System Summary item from the Report menu. The features associated with the screen are
described as follows.

System Summary Options...

Select Items To Include. ..

Compressor Summary -
Cusztomer Summary

Fitting Summary

Graphics Summary

Node Summary

Pipe Summary W

Cancel Continue. _.

Data Items

Compressor Summary - When selected, the compressor data will be included in the System Summary
Report. The compressor section reports various data and results about the compressors found in the system.

Customer Summary - When selected, certain customer data will be included in the System Summary
Report. The customer section reports various data about the customer features found in the system.

Node Summary - When selected, certain node data will be included in the System Summary Report. The
node section reports various data about the nodes found in the system.

Pipe Summary - When selected, certain pipe data will be included in the System Summary Report. The pipe
section reports pipe footage, diameter values, and other data values grouped by diameter value.

Regulator Summary - When selected, the regulator data and results will be included in the System
Summary Report. The regulator section reports various data about the regulators found in the system.

Supply Nodes Summary - When selected, a summary of the supply nodes will be included in the System
Summary Report. The supply nodes section lists each node with a positive load value, along with its load and
pressure values.
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System Summary - When selected, a summary of certain system values will be included in the System
Summary Report. The system summary section reports the number of nodes, pipes, known and unknown

Data Screens
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values, and total flow in-to and out-of the system.

Command Buttons

Cancel - Closes the screen without creating the System Summary Report.

Continue - Displays the System Summary Report.

Notes & Considerations

® The System Summary Report provides a summary of the various data items contained in the model. The
report can include various User specified items. The available options are described in the following table:

Option

Features

Compressor Summary

* Calculates the compression ratio; the estimated outlet temperature;
the estimated power requirement; the estimated fuel usage; the total
power; and the total fuel.

* Displays the From Node and To Node; the compressor type; the
flow rate; the flow mode; the inlet temperature; the rated power; and
the fuel usage rate.

Customer Summary

Displays the total customer count; the total customer unit count; the
number of turned “off” customers; the “From Node”, “To Node”, and
“Both Nodes” assignments; the total unadjusted load in-to and out-of
the system; the number of branch customers, header customers, and
polyline customers; the number of customers with unassigned service
line coordinates; and the number of deleted customers.

Node Summary

Displays the total node count; the connection node count; the control
fitting node count; and the valve node count.

Pipe Summary

Displays the Size/Type Code; the inside diameter; the pipe count; the
length; the cost; the total pipe count; the total length; and the total
cost.

=
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Option Features

Regulator Summary * Calculates the estimated valve coefficient; the differential pressure;
the outlet temperature; and the coefficient ratio.

* Displays the From Node and To Node; the regulator type; the flow
rate; the flow mode; the inlet pressure; the outlet pressure; the
differential pressure; the minimum differential pressure; the inlet
temperature; the outlet temperature; the estimated valve coefficient;
the published valve coefficient; and the coefficient ratio.

Supply Nodes Summary | ¢ Lists all of the nodes with a positive load value.

* Calculates the percentage of the total flow rate, and the total of all
flow rates.

* Displays the node name; the flow rate; and the pressure.

System Summary * Displays the total customer, node, and pipe count.

* Displays the number and total of “known” and “unknown” loads,
pressures, temperatures, and gas properties.

* Displays the number of turned “off” nodes, and the number of nodes
connected only to turned “off” pipes (effectively rendering the nodes
as turned “off”).

* Calculates the base and external total flow (load) in-to and out-of
the system.

* Displays the element summary and the facility summary.

* Displays miscellaneous model and non-model data summary.
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This section provides instructions for using the GASWorkS Graphic Data Interface (GDI) window. A
substantial number of the GASWorksS features and commands are accessed through the GDI Window. Each
of these features along with the associated data screens are described in this section.

The GDI provides graphical access to the model data. The GDI Window may be used to create a graphical
representation of the model which may be used to view, edit, and manipulate the GASWorkS model data.
The GDI is not intended to be a “CAD” system, however it does provide some CAD type features. For more
sophisticated graphic needs we recommend using a true drafting/design, mapping, or GIS application. Data
from these applications may then be shared with GASWorkS using one of the many Import routines.

The Help Guide provides a collection of examples and how-to tips for performing a variety of tasks using
the GDI. The remainder of the section describes the various features associated with the GDI.

GDI Window Description

The GDI features are accessed through the Graphic Data Interface (GDI) window. The features associated
with the GDI Window and its layout are described in the following sections.

] Graphic Data Interface... = @ [

{3) | From Node Location: | EilCa
™ ™M v N e E 1 R 7 7 ™ 7 T | [Settings & Actions._. -
i <

[] Settings. .
Set Data Panel Width

|| Background Image Settings

gy ; r! | i ]l Color Display Settings
rond Street Garage)

PN | ' LV - Graphic Settings

Facility Settings

Text Display Settings
— |11 Action:
1 Cancel Current GDI Comman: d

elect One.

AEIE]

Undo Last Change
Add An Action...

=
@
X}

| M =
| &
H
£ .
Type Or Select A GDI Comman: d...
Add 2-Point Pipe Py

Add Arc Pipe
Add Branch Customer

Add Compressor

Add Customer

Add Customer - Auto Assign Main

Add Custemer - Duplicate

Add Customer - Unassigned ~ 0

Alphabetic Grouped

Aoul=a=Y % ]T(“[Lnn]:-1n4,maaa1 Y [Lat) = 38.851741 | Zoom Level = 17 -—
RN ) =[]

£ [pueg

With the exception of the GDI Command Line, the features associated with the GDI may only be accessed
by use of the mouse. If your computer system is not equipped with a mouse or compatible pointing device,
you will not be able to use the GDI.
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The GDI contains several functional areas. The left side of the GDI contains a group of icons
representing the GDI Toolbars (Item A). A “fly-out” toolbar will be displayed when the mouse
cursor is passed over each of the toolbar icons. The various GDI Window Icons are grouped together
by functionality on the specific GDI Toolbars. For example, icons for changing the scale and
position of the displayed GDI Image are grouped on the View Controls Toolbar. Many of the GDI
Commands are accessed through the GDI Icons displayed on the GDI Toolbars. While others can
only be accessed through the GDI Command List or by typing an abbreviation on the GDI Command
Line. The meaning and function of each of the GDI Commands and GDI Icons are described later
in this section.

The central portion of the screen contains the GDI Display. The GDI Display is the portion of the
screen where the model image is displayed and manipulated. The appearance of the image in the
display may be modified by panning (moving right or left or up or down) and by zooming (enlarging
or reducing) the image. Additionally, the color, size, and style of its features displayed in the GDI
Display may be manipulated by the User.

GDI Display

Directly above the GDI Display is the GDI Prompt Line. It is used to enter information needed by the various
GDI Commands and to prompt the User for a required action. When a value is required, an entry field will
be displayed for the GDI Prompt Line. Data is entered by typing in the provided entry field, then pressing
the Enter key. When a selection is required, a drop-down list will be displayed for the GDI Prompt Line.
Select the desired item from the GDI Prompt List.

From Node Location: ] |

GDI Prompt Line
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Directly below the GDI Display is the Information Panel and the GDI Command Line. The Information Panel
displays the coordinates for the current mouse position in the Information Panel. The coordinate values
represent the current (scaled) position of the cursor. The Information Panel may also display the status of
certain commands, such as whether the display of the customer symbols are “on” or “off”’. GDI Commands
may be executed by typing their identifying abbreviation or alias on the GDI Command Line.

B X [Lon) = -104.817698 ¥ [Lat] = 38.852359 | Zoom Level =17
- GDI Information Line (Top) / GDI Command Line (Bottom)
-]
=|| Along the right side of the GDI Display there are several “display tabs” - GDI Panels (/fem B). Each

GDI Panel can contain a different view of the model. Select the associated Panel tab to change to the

desired view. Different graphic settings may be set for each GDI Panel, however the Facility Settings
—4[ are common for all of the GDI Panels.

The area to the right of the GDI Display is known as the Data Panel. It serves several functions
$|| allowing access to various settings and actions, the favorite results list, displaying data values and
Z|| results, and allowing data values to be edited for selected features.

|Settings & Actions._. ﬂ
= [-] Settings....
Set Data Panel Width
Background Image Settings
g Color Display Settings
w Facility Settings
Graphic S5ettings
Text Dizplay Settings
Item [-] Actions - Select One. ..
B Cancel Current GDI Command
Undo Lazt Change
Add An Action. .
Data Panel
]
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The area to the right of the GDI and below the Data Panel may be used to display either the GDI Command
List or the Tool Palette. Only one of the two may be displayed at the same time. Both of these items are
described later in this section.

Type Or Select A GDI Command. .

Add 2-Point Pipe A
Add Arc Pipe

Add Branch Customer

Add Compreszzor

Add Customer

Add Customer - Auto Azzign Main

Add Customer - Duplicate

Add Customer - Unaszigned b

Alphabetic l Grouped
GDI Command List (Displayed) / Tool Palette

GDI Window Icons

Cancel - Cancels the currently executed GDI Command, or stops the display of the model image
@ from being repainted. The icon is located in the upper-left corner of the GDI.

GDI Command List - Toggles the display of the GDI Command List. When clicked, the GDI
Command List is displayed in the lower-right corner of the GDI. Depending on the last tab used,
either the Alphabetic list will be displayed or the Grouped list will be displayed. When the icon
1s clicked a second time, the GDI Command List will be “hidden”. The icon is located in the
upper-right corner of the GDL

GeoMap - Enables the GeoMap functions. Executing this command will display a message asking
whether to continue with the GeoMap functions. When turned “on”, the GeoMap functions allow
the use of geographic map services to help in building or maintaining a model.

Feature Snap - Turns the Feature Snap “on” or “off” depending on the current status. The
Feature Snap routine attempts to force (snap) new coordinate selections to the location of an
existing feature location. When the Feature Snap is turned “on”and a coordinate entry prompt is
displayed, a circle/target will be displayed about the center of the mouse crosshairs (Snap Target).
The radius of the target will be the same as the Snap Target. When a new feature location is selected,
GASWorkS will search for an existing feature within the Snap Target of the selected location. If a feature
falls within the circle, its coordinates will be used for the prompted entry value. If no feature is found within
the Snap Target, the selected location will be used. The Snap Target is set to the product of the Feature Snap
Ratio value times the default Node Symbol Size value. To change either of these values, use the Graphic
Settings screen. The icon is located in the lower-left corner of the GDI.

> &
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Quick Solve - Executes the Quick Solve routine using the currently set solution options. The icon
is located in the lower-right corner of the GDI. The Solution Data screen will not be displayed,
however the solution results will be updated upon completion.

Scroll - Moves the model image up or down or right or left. The process of moving the image is
referred to as “panning” or “scrolling”. The amount that the image moves when the Scroll icon
is clicked, is determined by the value of the Pan/Scroll Change values found on the Graphic
Settings screen. To pan the GDI Image a certain direction, click the arrow symbol corresponding
to that direction on the Scroll icon. The icon is located in the lower-left corner of the GDI.

S

Solve - Displays the state of the model and when clicked, the Solution Data screen is displayed.
The icon indicates whether the model is balanced (blue balance scale) or unbalanced (red
unbalance scale). When a change is made to the model data, the model is considered to be
“unbalanced”. The icon is located in the lower-right corner of the GDIL.

Tool Palette - Toggles the display of the Tool Palette. When clicked, the Tool Palette is displayed
in the lower-right corner of the GDI. The Tool Palette displays a limited number of User selected
GDI Commands. When the icon is clicked a second time, the Tool Palette will be “hidden”. The
icon is located in the upper-right corner of the GDIL.

Zoom To Fit - Redisplays the entire model image so that it fits within the GDI Display. The icon
is located in the lower-left corner of the GDI.

Zoom In - Enlarges (zooms in) the model image. The icon is located in the lower-left corner of
the GDL

Zoom Out - Reduces (zooms out) the model image. The icon is located in the lower-left corner
of the GDI.

L EE B E

The GDI supports X-Y coordinate values ranging between negative and position 1 Billion, longitude between
-180 and 180 degrees in longitude, and -90 and 90 degrees in latitude. The Shift Model Coordinates command
may be used to shift, scale, and rotate a model’s coordinate values if they fall outside the allowable range.
The Coordinates units are set on the Default Data Values screen. When a new pipe is added, its Length value
is calculated based on the graphical length between its From Node, To Node, and vertex coordinates. The
User may override the calculated value by manually entering the desired Length value. Node Names are
automatically assigned during new pipe entry. The User may override the assigned node Name by manually
typing the desired value. The Node Increment (difference between new node Names) is controlled by the
value of the Node Increment item found on the Miscellaneous data tab on the Default Data Values screen.
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Depending on the zoom scale, certain features may or may not be displayed. The display of data text values
is controlled by a User specified setting on the Text Display Settings screen. The display of features like the
flow arrows, pipe symbols, supply flag, and User Graphic Symbols are controlled by a User specified setting
on the Graphic Settings screen. Symbol sizes may be specified in one of two methods - absolute or relative.
With the absolute method, the symbol size is expressed in terms of the Coordinates units. As the model
image is enlarged or reduced, the display of the symbols are resized accordingly. With the relative method,
a factor, expressed as a percentage, is used to specify the symbol size. The factor is applied to the diagonal
distance across the GDI Display. The result is that the symbol size is always displayed at the same size
regardless of the zoom scale. When an absolute size is used and the image is zoomed to a scale where the
symbols would appear very small, they are not displayed. As the magnification of the GDI Image is
increased, the symbols will eventually appear. When an absolute or relative size is used, the associated
“display limit” determines whether the feature will be displayed at a particular zoom scale.

GDI Toolbars

Customer Commands - Contains icons for commands used for manipulating the customer
features.

Data Edit Commands - Contains icons for commands used for viewing and editing the data
values for the pipe and node features.

Display Controls - Contains icons for commands used for controlling the display of the data text,
feature colors, symbols, and the background image.

GDI Window Controls - Contains icons for commands used for controlling the GDIL.

GeoMap Functions - Contains icons for commands used for controlling the GeoMap Functions.

Graphic Construction Commands - Contains icons for commands used for adding and deleting
pipe features.

Graphic Edit Commands - Contains icons for commands used for editing the pipe, vertex, and
node features.

> |7 1@ O A |[m |2
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Undo/Redo Commands - Contains icons for commands used for undoing (restoring) and redoing
(restoring an undo) data changes.

User Graphic Commands - Contains icons for commands used for manipulating User Graphic
Symbol, Line, and Image features.

2] 2]

A User Text Commands - Contains icons for commands used for manipulating User Text features.

Utility Commands - Contains icons for commands used for performing various utility commands
such as plotting and tracing.

View Controls - Contains icons for commands used for zooming and panning the model image.

L =

GDI Commands & Icon Descriptions

The GDI Commands may be executed in three manners - by selecting the GDI Command from the GDI
Command List, by clicking on a GDI Icon from the various GDI Toolbars or the Tool Palette, or by typing
the associated abbreviation or alias on the GDI Command Line. The methods are described in the following
sections.

All of the GDI Commands may be accessed from the GDI Command List. 